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1.1

1.1.1

1.1.2

1.1.3

Introduction

Introduction

This document describes the use of AUTOSAR features in ASCET V6.2.

Safety Advice

Please adhere to the Product Liability Disclaimer (ETAS Safety Advice) and to the following
safety instructions to avoid injury to yourself and others as well as damage to the device.

Correct Use

ETAS GmbH cannot be made liable for damage which is caused by incorrect use and not
adhering to the safety instructions.

Labeling of Safety Instructions

The safety instructions contained in this manual are shown with the standard danger symbol
shown below:

A

The following safety instructions are used. They provide extremely important information.
Read this information carefully.

WARNING!

Indicates a possible medium-risk danger which could lead to serious or
even fatal injuries if not avoided.

CAUTION!

f E Indicates a low-risk danger which could result in minor or less serious

injury or damage if not avoided.

NOTICE
Indicates behavior which could result in damage to property.

Demands on the Technical State of the Product

The following special requirements are made to ensure safe operation:

= Take all information on environmental conditions into consideration before setup and
operation (see the documentation of your computer, hardware, etc.).
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1.3

1.3.1

1.3.2

Introduction

WARNING!

Wrongly initialized NVRAM variables can lead to unpredictable
behavior of a vehicle or a test bench, and thus to safety-critical
situations.

ASCET projects that use the NVRAM possibilities of AUTOSAR expect a
user-defined initialization that checks whether all NV variables are valid for
the current project, both individually and in combination with other NV
variables. If this is not the case, all NV variables have to be initialized with
their (reasonable) default values.

Due to the NVRAM saving concept, this is absolutely necessary when
projects are used in environments where any harm to people and
equipment can happen when unsuitable initialization values are used (e.g.
in-vehicle-use or at test benches).

Further safety advice is given in the ASCET V6.2 safety manual (ASCET Safety
Manual .pdf) available on your installation disk, in the ETASManuals\ASCET V6.2
folder on your computer or in the download center of the ETAS web site.

System Information

The ASCET product family consists of a number of products that provide interfaces to
simulation processors, third-party software packages and for remote access to ASCET. See
the "ASCET Getting Started" manual for more details.

The following products are required to use the AUTOSAR features of the current ASCET
version:

= ASCET-MD
= ASCET-SE

= RTA-RTE (not part of the ASCET product family, see
http://www.etas.com/en/products/rta rte.php for further information)

User Information

User Profile

This manual addresses qualified personnel working in the fields of automobile control unit
development and calibration. Specialized knowledge in the areas of measurement and
control unit technology is required, as well as knowledge of ASCET and (at least) basic
knowledge of AUTOSAR.

Any user who is not familiar with ASCET should read the "ASCET Getting Started" manual
before reading the AUTOSAR User's Guide.

Any user who is not familiar with AUTOSAR should learn the relevant concepts before using
the AUTOSAR features of ASCET.

Document Structure

The ASCET AUTOSAR User’s Guide contains the following chapters:
= "Introduction" (this chapter)
This chapter contains general information, user and system information.
= "AUTOSAR Overview"
This chapter contains a brief introduction to AUTOSAR.
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= "Developing Software Components in ASCET"

This chapter describes how to configure ASCET for developing AUTOSAR software
components, approaches for creating software components, and working with the RTE
Generator.

= "Data Types"

This chapter introduces data types used in AUTOSAR, and explains how to use them
in ASCET.

= "Interfaces"
This chapter introduces the AUTOSAR interfaces supported by ASCET.
= "Software Component Types"

This chapter introduces software component types and ports, and explains how to use
them in ASCET.

= "Internal Behavior"

This chapter first outlines the basic framework for EVENTS and runnable entities
before showing how to configure the RTE to achieve different types of runnable
entity/interface interaction.

= "Modes"

This chapter explains how to define application modes that can be used by software
components to control the execution of runnable entities.

= "Implementing Software Components"

This chapter explains how to model software components in ASCET so that the
objects required by the RTE are declared and how to use the RTE API generated by
the RTE generator.

= "ETAS Contact Addresses"

How to use this Manual

The user’s guide is available electronically and can be viewed on the screen at any time.
Using the index, full-text search, and hypertext links, you can find references fast and
conveniently (see ASCET V6.2 AUTOSAR UG.pdf).

The database AUTOSAR UG Tutorial is provided with the ASCET installation. The
examples depicted in this document are modeled in the solutions folder. The
corresponding ASCET-generated code can be found on the Windows file system, in the
subdirectory generated code Solutions contained in the database.

Documentation Conventions

Instructions are phrased in a task-oriented format as shown in the following example:
To reach a goal:

= Execute operation 1.

Explanations are given below an operation.
= Execute operation 2.
= Execute operation 3.

In this manual, an actionis a sequence of operations that need to be executed in order to
reach a certain goal. The title of an action usually expresses the result of the operations,
such as "To create a new component" or "To rename an item". The action descriptions often
include screenshots of the corresponding ASCET window or dialog window related to the
action.

Typographic Conventions

The following typographical conventions are used in this document:

ASCET V6.2 AUTOSAR User’s Guide 15



ETAS Introduction

OCI_CANTxMessage msg0 = Code snippets are presented on a gray background and in
the Courier font.

Meaning and usage of each command are explained by
means of comments. The comments are enclosed by the
usual syntax for comments.

Select File - -Open. Menu options are shown in blue boldface.

Click OK. Buttons are shown in blue boldface.

Press <ENTER>. Keyboard commands are shown in angled brackets and
SMALL CAPS.

The "Open File" dialog window Names of program windows, dialog windows, fields, etc.

is displayed. are shown in quotation marks.

Select the file setup.exe Text in drop-down lists on the screen, program code, as
well as path- and file names are shown in the Courier
font.

A distribution is always a one-  General emphasis and new terms are set in /talics.
dimensional table of sample
points.

The OSEK group (see Links to internet documents are set in blue underlined font.
http://www.osekvdx.org) has
developed certain standards.

Important notes for the users are presented as follows:

Note

Important note for the users...

1.3.4 Related Documents

More detailed information on the AUTOSAR features of ASCET is given in the ASCET online
help, sections "Software Component Editor" and "AUTOSAR Interfaces".

The following related documents are installed with the respective software:
= ASCET Getting Started manual (ASCET V6.2 Getting Started.pdf)
= ASCET-SE User's Guide (ASCET-SE V6.2 Users Guide.pdf)

= RTA-RTE User's Guide and other RTA-RTE documentation (available via the Windows
Start menu, ETAS program group, RTA-RTE <x.y> - Documents >
<document>)

These documents are also available in the Download Center of the ETAS website.

1.4 Definitions and Abbreviations

ASCET
Development tool for control unit software
ASCET-MD
ASCET Modeling and Design
AUTOSAR
Automotive Open System Architecture; see http://www.autosar.org/
ARXML
EXtensive Markup Language (XML) used to describe AUTOSAR configurations.
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BSW

Basic software; provides communications, I/0, and other functionality that all
software components are likely to require.

CPU
Central processing unit
ECU
Embedded Control Unit
ERCOS®
ETAS real-time operating system, OSEK-compliant
(01
Operating system
OSEK

Working group "open systems for electronics in automobiles" (German: Arbeitskreis
Offene Systeme fiir die Elektronik im Kraftfahrzeug)

RE

Runnable entity; a piece of code in an SWC that is triggered by the RTE at runtime. It
corresponds largely to the processes known in ASCET.

RTA-OSEK

ETAS real-time operating system; implements the AUTOSAR-OS V1.0 (SC-1) and
OSEK/VDX OS V2.2.3 standards and is fully MISRA compliant.

RTA-OS

ETAS real-time operating system; implements the AUTOSAR R3.0 OS and OSEK/VDX
0OS V2.2.3 standards and is fully MISRA compliant.

RTA-RTE
AUTOSAR runtime environment by ETAS
RTE

AUTOSAR runtime environment; provides the interface between software
components, basic software, and operating systems.

SWC

AUTOSAR software component; the smallest non-dividable software unit in
AUTOSAR.

UuID

Universally Unique Identifier
VFB

Virtual Function Bus
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2 AUTOSAR Overview

Today, special effort is needed when integrating software components from different
suppliers in a vehicle project comprising networks, electronic control units (ECUs), and
dissimilar software architectures. While clearly limiting the reusability of automotive
embedded software in different projects, this effort also calls for extra work in order to
provide the required fully functional, tested, and qualified software.

By standardizing, inter alia, basic system functions and functional interfaces, the AUTOSAR
partnership aims to simplify the joint development of software for automotive electronics,
reduce its costs and time-to-market, enhance its quality, and provides mechanisms required
for the design of safety relevant systems.

To reach these goals, AUTOSAR defines an architecture for automotive embedded software.
It provides for the easy reuse, exchange, scaling, and integration of those ECU-independent
software components that implement the functions of the respective application.

The next sections briefly describe the AUTOSAR process for the development of application
software components. For more detailed information the reader can refer to the AUTOSAR
documents at the AUTOSAR website: http://www.autosar.org/.

2.1 AUTOSAR Basic Approach

Application software is the name given in AUTOSAR to vehicle functions. Each application is
decomposed into one or more software components (SWCs), which are designed to be both
CPU- and location-neutral. An AUTOSAR application software component can be mapped to
any available ECU during system configuration.

The abstraction of the SWC environment is called the virtual function bus (VFB). In each real
AUTOSAR ECU, the VFB is mapped by a specific, ECU-dependent implementation of the
platform software. The AUTOSAR platform software is split into two major areas of
functionality: the runtime environment (RTE) and the basic software (BSW).

The BSW provides communications, I/O, and other functionality that all software
components are likely to require, e.g., diagnostics and error reporting, or non-volatile
memory management.

Application SWCs have no direct access to the BSW. This means that components cannot,
for example, directly access operating system or communication services. The runtime
environment provides the interface between software components, BSW modules, and
operating systems (OS). Concerning the interconnection of SWCs, the RTE acts like a
telephone switchboard. This is similarly true of components that reside either on single ECUs
or networked ECUs interconnected by vehicle buses.

In AUTOSAR, the OS calls the runnable entities of the SWCs through the RTE. RTE and OS
are the key modules of the basic software with respect to controlling application software
execution.

ETAS has been supplying the auto industry with automotive operating systems for more
than a decade: ERCOS™ and RTA-OSEK. The RTA-RTE AUTOSAR Runtime Environment and
RTA-OS AUTOSAR Operating System extend the RTA product portfolio with support for the
key AUTOSAR software modules. Based on their AUTOSAR interfaces, basic software
modules from third-party suppliers can be seamlessly integrated with RTA-RTE and RTA-
OSEK.
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Figure 1: AUTOSAR software component (SWC) communications are represented by a
virtual function bus (VFB) implemented through the use of the runtime environment (RTE)
and basic software.

What is an AUTOSAR Authoring Tool?

An AUTOSAR authoring tool is a software tool which supports interpreting, processing and
creating of AUTOSAR descriptions, namely

= Software Component descriptions for

— the operations and data elements that the software component provides and
requires

— the requirements which the software component has on the infrastructure
— the resources needed by the software component (memory, CPU-time, etc.)
— information regarding the specific implementation of the software component
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= System constraint descriptions for all system information and the information that
must be agreed between different ECUs.

= ECU descriptions for the resources and configuration of the single ECUs.

AUTOSAR SWCs are generic application-level components that are designed to be
independent of both CPU and location in the vehicle network. An SWC can be mapped to
any available ECU during system configuration, subject to constraints imposed by the system
designer. An AUTOSAR software component is therefore the atomic unit of distribution in an
AUTOSAR system; it must be mapped completely onto one ECU.

Before an SWC can be created, its component type (SWC type) must be defined. The SWC
type identifies fixed characteristics of an SWC, i.e. port names, how ports are typed by
interfaces, how the SWC behaves, etc. The SWC type is named, and the name must be
unique within the system. Thus, an SWC consists of

= a complete formal SWC description that indicates how the infrastructure of the
component must be configured,

= an SWC implementation that contains the functionality (in the form of C code).

To allow an SWC to be used, it needs to be instantiated at configuration time. The
distinction between type and instance is analogous to types and variables in conventional
programming languages. You define an application-wide unique type name (SWC type), and
declare one uniquely named variable of that type (one or more SWC instance).

In the VFB model, software components interact through ports which are typed by
interfaces. The interface controls what can be communicated, as well as the semantics of
communication. The port provides the SWC access to the interface. The combination of port
and port interface is named AUTOSAR interface.

A runnable entity is a piece of code in an SWC that is triggered by the RTE (see section 2.3,
What is a Runtime Environment?, on page 20) at runtime.

A software component comprises one or more runnable entities the RTE can access at
runtime. Runnable entities are triggered, among others, by the following events:

= 7iming events represent some periodic scheduling event, e.g. a periodic timer tick.
The runnable entity provides the entry point for regular execution.

= Events triggered by the reception of data at an Rport (DataReceive events).

AUTOSAR runnable entities can be sorted in several categories. ASCET supports runnable
entities of category 1.

In order to be executed, runnable entities must be assigned to the tasks of an AUTOSAR
operating system.

AUTOSAR elements reference each other in a standardized XML file format, the so-called
ARXML format. The ARXML format can slightly differ depending on the AUTOSAR release
version. AUTOSAR authoring tools are required to be able to interpret, create or modify
ARXML descriptions.

Note

The ARXML examples provided in this user guide are generated using the AUTOSAR
release version 3.1.2.

2.3 What is a Runtime Environment?

The VFB provides the abstraction that allows components to be reusable. The runtime
environment (RTE) provides the mechanisms required to make the VFB abstraction work at
runtime. The RTE is, therefore, in the simplest case, an implementation of the VFB.
However, the RTE must provide the necessary interfacing and infrastructure to allow
software components to

1. be implemented without reference to an ECU (the VFB model); and
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2. be integrated with the ECU and the wider vehicle network once this is known (the
Systems Integration model) without changing the application software itself.

More specifically, the RTE must
» Provide a communication infrastructure for software components.

This includes both communication between software components on the same ECU
(intra-ECU) and communication between software components on different ECUs
(inter-ECU).

» Arrange for real-time scheduling of software components.

This typically means that the runnable entities of the SWCs are mapped, according to
time constraints specified at design time, onto tasks provided by an operating system.

Application software components have no direct access to the basic software below the
abstraction implemented by the RTE. This means that components cannot, for example,
directly access operating system or communication services. So, the RTE must present an
abstraction over such services. It is essential that this abstraction remains unchanged,
irrespective of the software components’ location. All interaction between software
components therefore happens through standardized RTE interface calls.

In addition, the RTE is used for the specific realization of a previously specified architecture
consisting of SWCs on one or more ECUs. To make the RTE implementation efficient, the
RTE implementation required for the architecture is determined at build time for each ECU.
The standardized RTE interfaces are automatically implemented by an RTE generation tool
that makes sure that the interface behaves in the correct way for the specified component
interaction and the specified component allocation.

For example, if two software components reside on the same ECU, they can use internal
ECU communication, but if one is moved to a different ECU, communication now needs to
occur across the vehicle network.

From the application software component perspective, the generated RTE therefore
encapsulates the differences in the basic software of the various ECUs by:

» Presenting a consistent interface to the software components so they can be reused—
they can be designed and written once but used multiple times.

= Binding that interface onto the underlying AUTOSAR basic software implemented in
the VFB design abstraction.

2.4 What is a Behavior Modeling Tool?

An AUTOSAR Behavior Modeling Tool is a software tool which allows defining and
implementing the functional behavior of AUTOSAR-compliant vehicle functions using a
behavior modeling language.

A behavior modeling language is a notation primarily used to capture a functional behavior
specification or design of a function or system. Usually, a functional behavior modeling
language has a graphical notation and is regarded to be executable, i.e. its semantics is
sufficiently precise to execute functional behavior models by means of a simulation engine.
Furthermore, the precision in its semantics then allows the transformation of the functional
model into a source code in a programming language like C.

When ASCET is used as a behavioral modeling tool, the internal behavior of the application
software components is specified by means of the block diagram editor. The internal
behavior can consist of variables, parameters, class instances and modules. AUTOSAR
runnable entities can be seamlessly implemented by means of sequences of methods calls
and processes.

Existing ASCET models can be easily adapted to AUTOSAR because many AUTOSAR
concepts can be mapped to interface specifications in ASCET in a similar form. On the
whole, it suffices to rework the interface of the respective application to make an existing
software module AUTOSAR-compliant. In terms of time, the expenditure of reworking an
existing application is relatively minor.
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Configuring ASCET

This section briefly describes how to configure ASCET for developing AUTOSAR software
components. For a more detailed description on how to work with ASCET, please refer to the
"ASCET Getting Started" manual and the ASCET online help.

Configuring the Creation of AUTOSAR Components

ASCET offers the possibility to configure user profiles. In the context of AUTOSAR, ASCET
provides a configuration option for the creation of AUTOSAR components.

To enable the creation of AUTOSAR components:

= In the ASCET component manager, select Tools - Options.
The "Options" dialog window opens.

= In the "Modeling" node, make sure that the Enable Creation of
AUTOSAR components option is activated.

= C(lick OK.
Options EI@
File Wiew
Modeling
= mOph’Dns & [[use Project Options Template
[ Appearance & Project Options Template| %6DATA s buildSettings. xml =
— = [E3 Build
— & [E3 Debug Mode & Block Library SeDATA%Y blockLibrary, xml
—E Environment
| ® Experiment & []Use view Configuration

—m [ External Tools
—[ Hardware
— B Integration
—ME Interfaces

& View Configuration 2eDATA G Wwiews.xml =l

.; Enable Creation nf&U‘I’OSAR Components

[ : Defaultyi=sms—-t-x ; - = -
Madeling |Enab|r: the Creation of AUTOSAR Compenents in Compenent Managr:r|
& Default 1D Interpolation ILinear -
.;. Default 2D Interpolation [Linear v]

| | system Defaults

me

Use Project Options Template:

Use a XML-Template File for Project Options

Praoiact Ontinne Temnlata:

oK ] [ Cancel

Figure 2: Enable creation of AUTOSAR components

Code Generation Settings for AUTOSAR

A project is the main unit in ASCET representing a complete software system. Formulas,
implementation types etc. are defined within the context of a project.
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To create a project:

= In the component manager, select Insert - Project or click on
the Insert Project button to add a new project.

= Name the project ARProject.
= Select Edit ©> Open Component or double-click the project.
The project editor opens.
To set the code generation settings for AUTOSAR:

= In the project editor, select File - Properties or click on the
Project Properties button.

The "Project Properties" dialog window opens.
= In the "Build" node, select the options:
— Target: ANSTI-C

Note

In ASCET V6.2, the ANSI-C target is the only target that can
be used for AUTOSAR code generation.

— Operating System: RTE-AUTOSAR x.y.z

Project Properties EI@
File View
Build

. . o
=] Project Properties % Target ’ANSI_C vl
ASAM-ZMC ['EE Code Generator * lDbject Based Controller Implementatic vl
= Build
Target Settings Edit Code Generation Settings
O5 Configuration e cCompier = | Microsoft Visual C+-+ 2008 -
Code Generation =
Code Storage Edit Compiler Settings
{f= Operating System * |RTE-AUTOSAR 3.1.2 -
GEMERIC-0SEK
Edit OS Configuration RTE-AUTOSAR 2.1.4
RTE-AUTOSAR 3.0.2

RTE-AUTOSAR. 3.0.4 =
RTE-ALTOSAR. 3,1.0

% |:| Generate Dependen
RTE-AUTOSAR 3.1.4 h.‘
% HB&I‘ Stmclme Ed F‘.TE-\AUTDSAR 3. 1. 5
RTE-AUTOSAR. 4.0,2 -

RTE-AUTOSAR. 4.0.3
System Defaults

Target: (=i

Target to be used for Code Generation

Cnde Genarator

Figure 3: Project settings for AUTOSAR projects
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ASCET V6.2 supports the AUTOSAR releases 2.1.4, 3.0.2, 3.0.4, 3.1.0, 3.1.2, 3.1.4, 3.1.5,

4.0.2 and 4.0.3.

In the "Code Generation" node, select the MISRA compliant
casting strategy from the Casting combo box.

Other casting strategies are not recommended.
Select the casting "MISRA compliant”.

Project Properties

File View

[=] Project Properties
ASAM-2MC
= Build
Target Settings
05 Configuration
Code Generation
Code Storage

E=N B =)

Code Generation

[-E Protected against division by zero

[-ﬁ Protected Division against Signed Overflow

% Frotected Vector Indices

[-E [7] Generate Define Directives for Enum Values

@ Add Comment with Implementation Information for each Assignment Statemen
[-E Add Comment with Specification Source for each Statement

[-E Add Comment with Generation Information for each Component
% Force Parenthesis for Binary Logical Operators

[-E Add parenthesis for readability

[-ﬁ [ Allow References without Init Value

% Prefix for Component Mames

Kz Casting [MisRA compliant ]
ASCET legacy {deprecated
MISRA compliant @
Arithmetic services k-

Casting: Target Optimized -

Select the casting strategy to use at code generation time:
ASCET legacy (deprecated): casting supported in ASCET 6.0 =,
and previous releases. This strategy will be removed in a future

ralraca of AQCET A wsarninn will ha Aanmaratad if thic ctratame ie

[ OK l [ Cancel

Figure 4: MISRA compliant casting for AUTOSAR projects

To define a memory sections definition file:

When generating code in an AUTOSAR project, ASCET loads the memory sections from an
XML configuration file. This file is defined in the project properties, "OS Configuration" node;

see Figure 5.
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Go to the "OS Configuration" node of the "Project Properties"
dialog window.

In the "Memory Sections Configuration File" field, enter path and
name of the XML file that contains your memory sections
definition.
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-

Project Properties EI@

File View
05 Configuration

=] Project Properties EE 05 Template File
ASAM-2MC ¥z [#]Enable 05 Configuration
B Build -
Code Generation % Indude Paths S{P_05_ROCT)\inc; ${P_0S_ROOT)\external \AUTC
05 Canfiguration [Kz Library Paths §(p_05_ROOT)Yib
Target Settings
Code Storage % Libraries
EE Configuration Tool Cptions --samples:memmap
(¥ oL Fike
(B Interpolation Aliss Mapping o4 TARGETROOT % \common jnterpolation | ALTOS

(¥ AUTOSAR XML Configuration File  %TARGET % \arxml400ptions, xml
EE Memary Sections Configuration File ¥eTARGET %:\memorySections_AUTOSAR 4. xml

Edit Operating System Tool Settings

System Defaults

m s

0S Template File:

0S5 Template File used for external generation of OS related file

Fnahlae NS Confinuration:

[ OK ] [ Cancel

Figure 5: OS Configuration settings for an AUTOSAR R4.0.* project

ASCET provides two sample files, memorySections Autosar.xml (AUTOSAR R3.1.5 or
lower) and memorySections Autosar4.xml (AUTOSAR R4.0.*). The suitable
memorySelecions *.xml file for the selected RTE-AUTOSAR * operating system (see
section 3.1.2, Code Generation Settings for AUTOSAR, on page 22) is preselected.

Settings for the AUTOSAR XML Output

The "Project Properties" window offers a possibility to configure the AUTOSAR XML output,
i.e. to set package names or short names, to specify output files, etc.

To configure the AUTOSAR XML (ARXML) output:

= In the "Project Properties" dialog window, go to the "OS
Configuration" node.

= In the "AUTOSAR XML Configuration File" field, enter or select
the configuration file.
By default, each AUTOSAR Rx.y version uses a separate
configuration file. It is recommended that you do not change this
behavior because different AUTOSAR versions allow different
ARXML settings.

= Click on the Edit button to open the "ARXML Configuration
Settings" dialog window.

This window provides a set of options to configure the AUTOSAR
XML generation. The options are grouped in several categories;
see Table 1.
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Category

Content

Package Templates

Each package template allows the specification of an ARXML
package name following the scheme:
/<Root-Package>/<Sub-Package>/.../<Short-
Name>

Specific template parameters can be used.

Short Name Templates

Each short name template allows the specification of an
ARXML short name.

Specific template parameters can be used.

Filename Templates

Each filename template allows the specification of a filename
where the associated package will be generated into.

Specific template parameters can be used.

Miscellaneous

Each miscellaneous option represents an additional option -
which might be a template - somehow relevant for the
ARXML generation.

Table 1: Categories for the configuration of generated ARXML code. The content of the
categories depends on the selected AUTOSAR version.

Adjust the options in the different categories according to your
needs.

The descriptions in the "ARXML Configuration Settings" dialog
window contain detailed information on each option.

Click OK to confirm the settings and close the "ARXML
Configuration Settings" dialog window.

Note

The changes in the "ARXML Configuration Settings" window are

kept even if you leave the "Project Properties” window with

3.1.4 Code Generation

Cancel.

An AUTOSAR project shall contain an AUTOSAR software component and requires the
project settings described in the previous section. When generating code for the project,
ASCET creates the AUTOSAR XML description files (* . arxm1 files) and the corresponding

C code. The generated C code uses the AUTOSAR API macros which are implemented in the

RTE.

To create an AUTOSAR software component:

In the component manager, select Insert > AUTOSAR >
Software Component.

Name the software component Swc.

To insert an AUTOSAR software component in a project:

ASCET V6.2 AUTOSAR User’s Guide

Open the project ARProject in the project editor.
In the project editor, select Insert > Component.
The "Select Item..." window opens.

In the "1 Database” or "1 Workspace” field of the "Select Item..."
window, select the component Swc.
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1 Select kem...

1 Database (Filter: Component, SoftwareComponent, Enumeration, Record, Generic)
= [@ AUTOSAR_UG_ Tutorial -
= E[jExercises

L= {7 chapter_3_AUTOSARProject
— -

2 Comment b

m

Figure 6: Select item swc in the project ARProject

= (Click OK to close the "Select Item..." window and insert swc into
the project.

The "Properties for Complex Element" window opens. You can
enter a name and a comment for the swc instance.

= (Click OK to use the default name and comment.
To generate code in a project:

= In the project editor, first select Build & Touch = Recursive,
then select File > Export ©> Generated code - Recursive.

Note

Beginning with ASCET V6.2, it is no longer necessary to select
Build > Generate Code after Build > Touch > Recursive.

The "Path to export Items" window opens. The ASCET code
generation directory, Cgen, is preselected.

Note

The cGen directory in the ASCET installation is a temporary
directory that contains intermediate results from the code
generator. It is not recommended to store code in this directory.

= Select a destination folder to export the generated code.

You may use, e.g., a subdirectory of the current ASCET database
C:\ETASData\ASCET6.2\Database\
AUTOSAR UG Tutorial.

For the ARProject containing the empty AUTOSAR software
component swc, the following files are generated.
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| | autosar_types.anam| || asdfiles.mk

|| Swe.anml || _asd_build_result_generatexml
|| Swe_types.anaml || Makelog.bd

|| ARProject.c || Makelog_fileout.tet

| Swe.c || Makelog_generate.bd

|%| ecco.db | | ARProject.c.pl

|| Makefile || ARProject.h.pl

|| ARProject.h | |Sweepl

|| asd_dyn_osinface.h | |5wc.h.pl

| |function_declarations.h | |temp.tgt
| globalH.h ] bat.bat

Sw.h &' autosar.xsd
= (=]

variable_declarations.h
| === | -

Figure 7: ASCET generated code for the project ARProject (*.arxml, *.c and *.h files).

Approaches for Creating Software Components

The development of AUTOSAR software components in ASCET can be done using two
approaches: the top-down approach and the bottom-up approach.

In the top-down approach, the software architecture is described in an authoring tool. In
this case, ASCET is used as a behavior modeling tool for the implementation of the software
components.

In the bottom-up approach, ASCET is not only used as a behavior modeling tool, but as an
authoring tool for the description of the AUTOSAR software components as well.

Top-Down Approach

In the top-down approach, the creation of an AUTOSAR software component is done in two
steps:
1. In the first step, the interface of the component is defined. The interface is specified
in an authoring tool and exchanged via ARXML. The ARXML files are then given to a
component API generator which transforms the interface description into a header
file. As a rule, the component API generator is the contract phase part of an RTE
generator (see section 3.3.1, Contract Phase, on page 31).

2. In a second step, the ARXML files are imported in ASCET and the application software
component developer provides the internal behavior in terms of C files respecting and
using the interfaces as defined in the header file. Now the *.h and the * . c files of
the software components are defined and can be compiled.

In the top-down approach, a key feature is the ARXML importer, which is described in the
next subsections.

The ARXML Importer

The ARXML description of a software component can be imported into ASCET with the
"AUTOSAR to ASCET Importer'. This tool transforms the ARXML file(s) containing all
necessary information to describe a software component (i.e. AUTOSAR types, interfaces,
software component type) into the proprietary ASCET XML format, the AMD format.
Afterwards, ASCET imports the AMD files into the currently open database or workspace.
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The AUTOSAR to ASCET Importer is started from the component manager, with the Tools
- AUTOSAR to ASCET Converter menu option. See the AUTOSAR to ASCET Importer
User’s Guide for details.

In addition, ARXML file(s) can be imported using the standard import menu option.
To import an ARXML in ASCET

= In the component manager, select File > Import.
The "Select Import File" dialog opens.
= Select the ARXML file(s) to be imported and click OK.

ASCET imports the selected files in the currently open database
or workspace.

Using the Attribute UUID in the ARXML Import

UUIDs (Universally Unique Identifiers) are optional fields in the ARXML specification, and
most authoring tools support them. ASCET also supports UUIDs in the AMD format, and this
enables ASCET to be easily integrated in AUTOSAR toolchains. At present, the ASCET-
generated ARXML provides a UUID for those elements that were imported with this
attribute; otherwise, the attribute is empty.

UUIDs are mainly used for the identification of existing elements in the ASCET database or
workspace when importing ARXML files. The use of the UUID attribute needs to be explicitly
enabled.

To use UUIDs for identification:

= In the component manager, select Tools = Options.
The ASCET options dialog window opens.

= Go to the "Interfaces\Import" node.

= Enable the option "Use UUIDs for Identification".

= Click OK to close the ASCET options window and accept the
setting.

The Use UUIDs for Identification option is also available in
the "Select Import File" window, see Figure 8.
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Impart File
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2. Default Import Path HDATAS Export
]

;. Default Impart Format ASCET Export files (.exp)

;. [] 1gnore 'Disallow Import’
;. [ Discard Existing Implementations

- List Imported Components After Import
EXP Format

;. [ | keep Folder Path of Components
AMDYAXL Format
& [¥]Keep Hierarchy

[ | tmport Referenced Ttems

§:
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I
m
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(s
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o

§>

Use UUIDs for Identification *

§:

[C|Repair M2M Statemaphinee —_— :
Use UUIDs to identify components on import.

§>

; Decryption Key

Figure 8: Using UUIDs to identify components on import

Bottom-Up Approach

For application software components, ASCET can be used as authoring tool and behavior
modeling tool. In the bottom-up approach, the AUTOSAR modeling elements supported in
ASCET V6.2, i.e. Mode Group, Interface!, Software Component, are created and maintained
in the ASCET database/workspace.

Working with the RTE Generator

The separation of the development and integration phases in AUTOSAR is reflected in a two-
phase software component development process:

1. Software Component Development: the specification, design and implementation of
software components; then

2. Software Component Deployment: the allocation of components to ECUs and the
integration of components with the basic software on the ECU.

! Sender-receiver, Client-server, Calprm (AUTOSAR R3.1.5 or earlier)/Parameter (AUTOSAR
R4.0.*), NVData (AUTOSAR R4.0.*)

ASCET V6.2 AUTOSAR User’s Guide 30



ETAS Developing Software Components in ASCET

The two phases of operation allow for initial software component configurations to be made
and integrated onto the VFB (through some auxiliary design and development process) and
then the RTE interface to be generated so that the software components can be
implemented before the prototypes are defined and their particular allocations onto an ECU
are known.

The phased development process means that some time can pass between the development
of a component type and the allocation of its component prototypes to an ECU. Indeed, a
component may be developed once and re-used multiple times over many generations of
vehicles. Furthermore, the component may be supplied to an integrator in binary form only,
but must be integrated to an ECU with other components that have not yet been written.

The RTE generator supports the phased process by allowing the interface to the RTE to be
generated in advance of full knowledge of component prototype/ECU allocation. Given a
software component description, the RTE generator has sufficient information to generate
the interface definition files necessary for engineers to start developing software
components. The interface defines the contract between the RTE and the component — what
that component must provide if future integration work is to happen easily. This is known as
contract phase.

When the system is integrated, and the mapping of software components to ECUs is known,
the RTE itself can be generated. However, we now know how many instances of a software
component exist, where runnable entities are executing, which communication is local to an
ECU and which must be routed across the network, etc. The RTE generator can use this
information to re-generate the interface definition files to include optimizations based on this
additional context. This is known as RTE phase.

The following sections discuss the Contract and RTE phases in more detail.

3.3.1 Contract Phase

In the contract phase, the RTE generator produces header files to be used in the
components under implementation. The header files define the contract between the
component and the system as a whole and are suitable for both binary-code and source-
code components. When running in the contract phase, the RTE generator only needs
access to the software component description file(s). It is not necessary to have any
information about system deployment.

The definitions in the ARXML file are used to define the APIs, and therefore only valid
runnable entities can be declared without an error occurring when the component is
compiled.

3.3.2 RTE Phase

Prior to using an RTE generator in RTE phase, a significant amount of system engineering is
needed. The AUTOSAR development process assumes that there are a number of inputs to
the system engineering process:

= Software component descriptions that define the software components, their ports,
internal behavior and implementation characteristic and the interfaces provided and
required by the ports assuming their connection to the Virtual Function Bus. These are
the same descriptions as used in contract phase.

» ECU resource descriptions that define the ECU hardware characteristics (e.g.
communication ports)

= A System constraint description that defines aspects of the system (e.g.
communication protocols)

To build an AUTOSAR system (i.e. a set of software components mapped to ECUs that
communicate over a network) it is necessary to define:

» ECU configuration descriptions that define which software components are mapped to
which ECUs, the resources available on the ECU etc.
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= A System configuration description that defines things like the network topology, how
inter-ECU communication is mapped to the physical network etc.

= An ECU Configuration that defines the mapping between elements; for example the
mapping of runnable entities to AUTOSAR Operating System tasks and the mapping of
AUTOSAR signals to AUTOSAR COM signals.

Once you have configured your AUTOSAR system with an allocation of component
prototypes to ECU instances, the RTE generator is used in RTE Generation phase to create
the following items:

1. the implementation of the RTE itself

2. optimized component header files that exploit mapping knowledge provided by your
configuration

3. operating system tasks that package your runnable entities

4. (optional) an operating system configuration file for the RTE generated objects and
required behavior

5. (optional) a communication stack configuration file for inter-ECU communication
configuration

In the RTE phase, the RTE generates optimized application header files suitable for
compiling source code components and, optionally, XML configuration files for the
communication stack and operating system. When running the RTE phase, the RTE
generator needs access to all system deployment information.

The RTE is generated as one or more C modules. Each module must be compiled according
to the dependency information output by the RTE. The module Rte. c contains the core
generated RTE.
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Data Types (AUTOSAR R3.1.5 or Lower)

The communication over interfaces is typed so, before an interface can be defined, it is
necessary to define the types of data that can be used.

ASCET supports both primitive types and complex types, i.e. those composed from values of
primitive types.

Definitions of AUTOSAR primitive and complex data types are created by ASCET based on
data implementation information. The ASCET data implementation is then mapped by the
AUTOSAR RTE into BSW types.

BSW Types

For AUTOSAR R3.1.5 or lower, the AUTOSAR RTE supports the following BSW data types:
= sint8 — 8 bit signed integer.
» uint8 — 8-bit unsigned integer.
» sintl6 — 16-bit signed integer.
» uintl6 — 16-bit unsigned integer.
» sint32 — 32-bit signed integer.
» uint32 — 32-bit unsigned integer.
= float32 — single precision floating point.
» float64 — double precision floating point.
» uint8_least — at least 8-bit unsigned integer.
» uintl6_least — at least 16-bit unsigned integer.
= uint32_least — at least 32-bit unsigned integer.
= sint8_least — at least 7-bit signed integer (plus sign bit).
» sintl6_least — at least 15-bit signed integer (plus sign bit).
» sint32_least — at least 31-bit signed integer (plus sign bit).
= boolean — for use with TRUE/FALSE.

The BSW types, plus definitions for TRUE and FALSE, are defined in the RTA-RTE
installation, in the AUTOSAR header file Platform Types.h.

Primitive Data Types

The ASCET type system consists of model types and implementation types. Model types are
abstract generic types which can be realized in one or more implementation types.

The basic model types for scalar elements are:
= Logic
= Signed Discrete
» Unsigned Discrete
= Continuous
All scalar elements in ASCET are implemented using one of the following data types:
= sint8
» sintl6
= sint32
»= uint8
» uintl6
= uint32
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Additionally, the model type "cont" can be implemented as
= real64
* real32

and the model type "log" as
= bool

To configure the default implementation of model types:

= In the component manager, select Tools = Options.
The "Options" dialog window opens.

= Open the "Modeling\Implementation\default Implementation
Types" node.

= Configure the default implementation types, for instance, as
shown below.

—F Experiment

optons =
File VYiew
Default Implementation Types
Default Data Types

= mOptions

M Appearance & Default cont Data Type = [snt3z -

— & EA Buid .

—& EA Debug Mode @ Default log Data Type * [bool vl

—E Environmert & Default sdisc Data Type lsintS "l

Default udisc Data Type luintB

—MH mExternalTools -
—[E Hardware
—[ Integration
— & Interfaces
'—E Modeling

Default Block Layout

ETAS Modeling Internal

= Implementation

nlementation Types

mf »

Default cont Data Type:

Defines the default implementation type for newly created cont
elements

Minimum Implementation Types

oK l ’ Cancel

Figure 9: Default implementation of model types

= C(lick OK.

The implementation of a model element can always be individually configured. In what
follows, we illustrate how to implement a variable sdisc as an 8 bit signed integer.

To implement a model type sdisc as a sint8:

= In the component manager, select the project ARProject and
select Edit > Open Component.

The project editor opens.
= In the project editor, double-click the software component swc.
The software component editor opens.

Use the Signed Discrete Variable button to create an sdisc
variable.

The dialog "Properties for Scalar Element: sdisc" opens.

= Name the signed discrete variable sdisc and close the
properties editor with OK.
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= In the "Outline" tab, right-click the sdisc element and select
Implementation from the context menu.

The "Implementation for: sdisc" window opens.
= In the "Master” field, activate Implementation.
= In the "Implementation” field, select sint8.
= Close the "Implementation for: sdisc" window with OK.

r- o

%& Implementation for: sdisc  Project: ARProjectAMSI-C @

Value | AUTOSAR | Additional Information

s Implementation Type

Implementation
Transformation
Formula [ Rescalable
Conversion fphys) = phys
Quantization Calculated | 1.0 Qu. Exp. | 1
Master
) o B
) Model @) Implementation
Model Implementation
Type sdisc Type [sint‘a -
Min -128 Min -123
Max 127 Max 127
[ Zere not incuded
=
Implementation Interval Adaptation
Limit Assignmentz
Lirnit to maximum bit length [Automatir_ v]
Memory Location of Instance [Default v]
Memory Location of Reference Default
Memory Location of Search Result Default
Cache Locking Automatic -
Consistency
Source Conflict
4 | 1] [ 3
Auto Correction Ok ] [ Cancel

Figure 10: Implementation of the signed discrete element sdisc as sint8

When generating code for an AUTOSAR project, ASCET creates the file

autosar types.arxml, so that the primitive data types can be referenced within ARXML
elements such as interfaces. A primitive type is declared using a meta-type tag to define the
type's properties and then sub-tags to refine range and set the type name:
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<LE-PRCELEE>
<SHGRT—HEHEbAUTDSAR_ﬁypEE(ISHGRT—HEHEb
<DESCH</DESC>
<ELEMENTS>

<INTEGER-TYFE>
<SHORT-NAME>SInt8</SHORT-NAME:
<LOWER-LIMIT>-128</LOWER-LIMIT>
<UPPER-LIMIT>127«/UPPER-LIMIT>
</INTEGER-TYPE>

</ELEMENTS>
< /LR-PRCKAGE>

Listing 1: ARXML code — primitive data type (AUTOSAR R3.1.2)

The short-name of a data type must be a valid C identifier.

The types file autosar types.arxml is an input for the RTE generator. The type
definition for the user-defined primitive type is then included in the generated file

Rte Type.h. The implementation of the primitive types created by RTE references the
BSW data types is defined for a particular micro-controller target by the AUTOSAR header
file Platform Types.h.

4.3 Primitive Data Types With Semantics

An additional data type in ASCET is Enumerations.

An enumeration in ASCET corresponds to an integer type with semantics. The semantic is
given by a compu-method with category "Text Table". A compu-method is a conversion
formula from bit-pattern to a physical value and vice versa.

To create an enumeration

= In the component manager, select Insert > Enumeration or
click on the Enumeration button.

= Name the enumeration Enumeration.
= Select the enumeration and switch to the "Contents” pane.

= For the value 0, select Enumeration = Rename and set the
label red.

= Select Enumeration > Add Enumeration > Append or press
the <INSERT> key to create a new enumerator with the value 1.
Set the label to yellow.

= Create another enumerator with value 2 and label green.
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Figure 11: Example of an enumeration in ASCET

The definition of the data type and the compu-method in configuration language can be
found in the AUTOSAR package ASCET types. The package ASCET types contains
software component specific types and is stored in the types file of the software component,
i.e. the generated file Swc_Types.arxml.

=]

<AR-PLACFLGE>

{5HGRT—HEMEthCET_prESCISHGRT—HEHEb
«DESC»</DESC>
<ELEMENTS>
<INTEGER-TYPE>
<SHCORT-NAME>Emmmeration</SHORT-HAME>
<DESC></DESC>
<!l——
enumeration &guot;Enumeration&guot;
——
<SW-DATA-DEF-FROPS>
<COMPU-METHOD-REF DEST="COMPU-METHOD">
fASCET_types/enmmerations/Enumeration</CCHMFU-METHCD-REF>
</ SW-DLTL-DEF-PROES>
<LOWER-LIMIT>0«/LOWER-LIMIT>
<UPPER-LIMIT>2«/UPPER-LIMIT>
</ INTEGER-TYFE>

< /ELEMENTS>
< 5UB-PACFAGES>

</ 5UB-PRCEAGES>

< /BR-PACKRAGE>

Listing 2: ARXML code — enumeration data type (AUTOSAR R3.1.2)

The description of the compu-method is attached below:
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]  <LRE-PLCELEE>

<5HGRT—HEHEbASCET_typES<HSHGRT—HEHE}

<DESC»</DESC>

e <ELEMENTS>

= <SIE-FPLCEAGES™

E <LE-PRCELGEE>
“SHORT-NAME=enumerations</SHORT-MAME>
<DESC></DESC>

= <ELEMENT 5>

E <CCHMPU-METHCD>
<SHORT-HAME>Enumeration</SHORT-IAME »

“CLATEGORY>TEXTTABLE< /CLATEGORY >
= <CCHMPU-THTERNAL-TC-FHYS>
<CCHMEUO-SCRALES™

= <CCHMEUO-SCRALE>
<LOWER-LIMIT>D</LOWER-LIMIT>
<JFFER-LIMIT>0</UJFFER-LIMIT>
= <CCHMPUO-CONST >

<VI>red</VI>
= < /COMPU-COMEST>
= </ COMPU-SCLLE>
= <CCHMPUO-SCALE>
<LOWER-LIMIT>1</LOWER-LIMIT>
<UJFPER-LIMIT>1</JFFER-LIMIT>
=l <COMPUO-CONST >

<VTryellows/ VI
I </ COMPU-COMST>
= « /COMPU-5CLLE>
=l <COMPUO-SCRALE>
<LOWER-LIMIT>2</LOWER-LIMIT:>
<UFPER-LIMIT>2< /JFFER-LIMIT>
= <CCMPO-CONST>

“VIzgreens/VI>
5 </ COMPU-COMST>
I « /COMPU-5CLLE>
= </ COMPU-SCLRLES>
I </ COMPU-INTERNAL-TO-FHYS>
I < fCOMPU-METHOD>
I «/ELEMENTS>
= < /LE-FLCHLGE>

r </ 5UB-PRCELGES>
r < /ABR-PRCKAGE>

Listing 3: ARXML code — compu-method for an enumeration (AUTOSAR R3.1.2)
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The AUTOSAR standard defines "status" and "error" values returned by RTE API functions.

The following values are defined in the std ReturnType type:

Error Code

Available in AUTOSAR Release

R4.0.*

R3.*

R2.*

RTE_E_COM_STOPPED

X

X

RTE_E_COMMS_ERROR

RTE_E_INVALID

RTE_E_LIMIT

RTE_E_LOST_DATA

RTE_E_MAXAGE_EXCEEDED

RTE_E_NO_DATA

RTE_E_OK

RTE_E_TIMEOUT

RTE_E_TRANSMIT_ACK

X | X | X | X[ X|X|X]|X

X | X | X | X[ X|X|X]|X

X | X | X | X | X|[X]|X]|X]|X

Table 2: AUTOSAR error codes

ASCET provides the std ReturnType type as a built-in enumeration. The error codes are

reserved words in ASCET and cannot be used in other enumerations.

Furthermore, E_OK is also reserved in ASCET, which denotes that a server runnable returns
no application error. The user shall specify — or import — the possible values of the
application error in a standard enumeration.

4.4 Complex Types

44.1 Record Types

Record types allow new complex types to be created. A record type creates a data structure
consisting of one or more named members.

To create a record in ASCET:
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In the component manager, select Insert = Record or click on

the Record button.

Name the record Record.
Select Edit > Open Component or double-click the record.
The record editor opens.

Use the Unsigned Discrete Variable button to create a udisc

variable.

The dialog "Properties for Scalar Element: udisc" opens.
Name the unsigned discrete variable 2.
Use the Logic Variable button to create a 10g variable named

B.
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Figure 12: Record with elements 2 and B

To create an implementation of a record:
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In the record editor, switch from the "Elements" tab to the
"Implementation” tab.

In the "Implementation" tab, double-click the element ».
The "Implementation for: A" window opens.

In the "Master" field, activate Implementation.
In the "Implementation" field, select uint1e6.
Right-click in the "Max" field and select Default Value from the

context menu.

Close the "Implementation for: A" window with OK.
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& Implementation for: A Project: Record_DEFAULTPC
Value | Additional Information
Ise Implementation Type
Implementation
Transformation
Formula [ Rescalable
Conversion flphys) = phys
Quantization Calculated | 1.0 Qu. Exp. | 1
Master
() Model '(; Implementation N
Model Implementation
Type udisc Type [uintlﬁ - ]
Min 0 Min i)
Max 63335 Max ©5535
[T Zera not included
Implementation Interval Adaptation ~
|:| Limit Assignments
[ Limit to maximum bit length Automatic
Memory Location of Instance Default
Memary Location of Reference Default
Memory Location of Search Result Default
Cache Locking Automatic
Consistency
Source Conflict
4| ] [ 3
Auto Correction oK ] [ Cancel

Figure 13: Implementation of the unsigned discrete element A as uint16

= For the logic variable B, select the implementation type bool.

The "Implementation” tab of the record editor looks like the
figure below.
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Figure 14: Implementation Impl of Record with elements A and B

An implementation of a record in ASCET corresponds to a record type in AUTOSAR. The
record type in configuration language can be found in the AUTOSAR package

ASCET types. The package ASCET types contains software component specific types
and is stored in the types file of the software component, i.e. the generated file
Swc_Types.arxml. The members of the record type Record Impl are described below:

<AR-PRCEKAGE>
<SHORT-NRME=ASCET type s« /SHORT-NAME>
<DESC»</DESC>
<ELEMENTS>

<RECORD-TYPFE>
<SHCORT-NEME>Record Impl</SHORT-NEME>
<ELEMENTS>
<RECORD-ELEMENT >
«SHORT-NAME»A</SHORT-NAME:
<TYFE-TREF DEST="INTEGER-TYPE">/AUTOSAR types/UIntl6é</TYPE-TREF>
</RECORD-ELEMENT >
<RECORD-ELEMENT>
< SHORT-NAME>B</SHORT-NAME:-
<TYPE-TREF DEST="BOOLEAN-TYPE">/AUTOSAR types/Boolean</TYPE-TREF>
</RECORD-ELEMENT >
< /ELEMENT S>>
«/RECORD-TYPE>
</ELEMENTS>

</RR-PRCHRGE>

Listing 4: ARXML code - record type (AUTOSAR R3.1.2)

The RTE generator will generate a C structure type for each defined <RECORD-TYPE>. The
structure definition is included in the generated file Rte Type.h.

To create a new implementation of a record:

= In the record editor, select Edit > Component 2>
Implementation.

The "Implementation Editor for: Record" window opens.

= Select Implementation = Add and name it, for instance,
Impl32.

= Set an implementation uint32 for A.
= Set an implementation boo1l for B.
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Figure 15: Record type Record Impl32

4.4.2 Array Types

Array types, like record types, allow new complex types to be created. An array type creates
a sequence of values mapped to an index position.

To create an array

= In the component manager, select the project ARProject and
select Edit > Open Component.

The project editor opens.
= In the project editor, double-click the software component Swc.
The software component editor opens.
= Use the Array button to create an array.
The properties editor for the array opens.

= Name the variable array, set the X dimension to 16, and select
the basic type unsigned discrete.

= Close the properties editor with OK.

= In the "Outline" tab of the SWC editor, right-click array and select
Implementation from the context menu.

The "Implementation for: array" dialog window opens.
= In the "Master" field, activate Implementation.
= In the "Implementation" field, select uints.
= Close the "Implementation for: array" window with OK.

An implementation of an array in ASCET corresponds to an array type in AUTOSAR. The
array type in configuration language can be found in the AUTOSAR package ASCET types.
The package ASCET types contains software component specific types and is stored in the
types file of the software component, i.e. the generated file Swc Types.arxml. Array

types used, e.g., as interface elements are declared as follows in the configuration
language:
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<RR-FRCHLGEX>
<SHORT-MRMEASCET types</SHORT-LRMED
<DESC></DESC>

«<ELEMENTS>

<BRRAY-TYPE:>
«5SHORT-NAME>ASCET Array UInt8 16</5HORT-HNAME>
<DESC»></DESC:
<1——
array of 16 sguot;UInt8&quot; wvalues
-
<ELEMENT >
<SHORT-NAME >elementWame< / SHORT -HAME >
<IYFE-TREF DEST="INTEGER-TYPE">/AUTOSAR types/UInt8</TYPE-TREF>
<MLE-NUMBER-CF-ELEMENT5»16</ MLX -NUHMEER-CF-ELEMENT 52>
< /ELEMENT >

< /ELEMENT 5z~

</LR-PLCELGE>
Listing 5: ARXML code — array type (AUTOSAR R3.1.2)

The RTE generator will generate a C array type for each defined <ARRAY-TYPE>. Array
types must be therefore declared according to the same semantics as the C array. The array
type definition is included in the generated file Rte Type.h.

Note

The implementation of arrays in application software components shall be consistent with
their declaration in the generated RTE. It is first specified how to declare an array typed
element at C code level in AUTOSAR R3.1.2. For more information, refer to the
AUTOSAR_SWS_RTE.pdf manual of your AUTOSAR release, chapter 5.2.6.5, for more
information.

The C code generation of arrays in ASCET is configurable in the file codegen.ini by
means of the option ARArrayBaseTypePassing.
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5 Data Types (AUTOSAR R4.0.*)

The types metamodel for AUTOSAR R4.0.* is a complete overhaul that replaces the former
system. AUTOSAR R4.0.* defines three layers of data type abstraction as illustrated in Figure
16.

Application Types

Implementation Types

Base Types

Figure 16: AUTOSAR R4.0.* abstraction levels for describing data types

5.1 Application Data Types

Application data types are defined in physical terms. This allows application authors to
create software components without deciding the C data type too early in the lifecycle.

Application data types contain the necessary information to support measurement and
calibration tools.

Application data types also support automatic conversion of values from one unit to another.

The <SHORT-NAME> of an application data type used within the scope of a software
component type (SWCT), so it is possible to have multiple application data types with the
same name when integrating several SWCTs on a single ECU (but not within a single
SWCT).

The <SHORT-NAME> of an application data type is not used in generated code, in particular
the RTE APIs are defined in terms of the mapped implementation data types.

To support more complex data types, an application data type can be composed of other
application data types. This form of recursive definition permits records and arrays to be
defined.

When the RTE is generated, used application data types must be mapped to implementation
types; see 5.3, Type Mappings, on page 45 for details.

5.2 Implementation Data Types

Implementation data types represent C types in the generated code. The <SHORT-NAME> of
an implementation data type defines the symbol used in C to access the type, e.g., in APIs
and in user code.

In general an implementation data type results in a typedef in the generated C code,
written to the file Rte Type.h. See the RTA-RTE user's guide for information on the
exceptions.

RTA-RTE always uses implementation data types in generated APIs. If the corresponding
<Variable-Data-Prototype> is defined by reference to an application data type, then
the mapped implementation data type is used in the API signature.

5.3 Type Mappings

An SWC-specific data type mapping is used to map application types (cf. section 5.1) onto
the implementing implementation types (cf. section 5.2).

Mode type mappings are used to map mode declaration groups onto implementation types.
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Note

RTA-RTE requires a data type mapping for each application type and a mode type
mapping for each used mode declaration group in order to be able to generate the RTE.

In ASCET, these mappings are provided in the Swc_mappings.arxml file.
The data type mapping for a SWC is held within a <DATA-TYPE-MAPPING-SET> element:

<AE-FACFAGE
«SHORT-NAMEXASCET Mappings</SHORT-NAMEX
<AE-PRACFAGES>
<ARE-PRACELGE>
<SHORT-HAME-DataMappings</SHORT -HAME>
<ELEMENT S
<DATA-TYPE-MRFPPING-SET>
<SHORT-HAME>Tmpl-</SHORT -HNAME:-
<DATA-TYPE-HMRFS>
< DRTRA-TYFE-MHRF=

</DATA-TYPE-MAFP™

«/DATRE-TYPE-MRFS>
<MODE-REQUEST-TYPE-MAFES>
<MCDE-REQUEST-TYPE-MAP:

</ MODE-REQUEST-TYFE-MAF >
< /MODE-REQUEST-TYPE-MAFPS>
</ DATRE-TYPE-MAFPPING-5ET>

Listing 6: ARXML code - mapping application data types and mode type to implementation
data types (AUTOSAR R4.0.2)

A data type mapping contains one or more data type maps. Each map references a single
application data type and a single implementation data type; see Listing 8, Listing 12, Listing
15 or Listing 21 for ARXML examples.

For more information on data type and mode mapping, refer to the RTA-RTE user's guide.

Platform Types

AUTOSAR specifies a set of platform types for use in C code. These are implementation data
types whose purpose is to provide a set of types with the same semantics across different
target hardware. RTA-RTE uses platform types when it needs to create types for internal
variables.

Unlike most implementation data types, the platform types are also defined in C language in
the file PlatformTypes.h.

Beginning with R4.0.2, AUTOSAR also specifies the correct definitions and package name of
the platform types.

The platform types defined in AUTOSAR Specification of Platform Types and in the standard
header file Platform Types.h are:
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» sint8 — 8-bit signed integer

= uint8 — 8-bit unsigned integer

» sintl6 — 16-bit signed integer

* uintl6 — 16-bit unsigned integer

= sint32 — 32-bit signed integer

» uint32 — 32-bit unsigned integer

= float32 — single precision floating point

= float64 — double precision floating point

» uint8_least — at least 8-bit unsigned integer

» uintl6_least — at least 16-bit unsigned integer

» uint32_least — at least 32-bit unsigned integer

= sint8_least — at least 7-bit signed integer (plus sign bit)

» sintl6_least — at least 15-bit signed integer (plus sign bit)
= sint32_least — at least 31-bit signed integer (plus sign bit)
= boolean — for use with TRUE/FALSE.

Base Types

Finally, base types describe the hardware-specific aspects of the data type, e.g., size and
encoding. They form the basis on which the implementation data types are built. A base
type can be referenced by several implementation data types (see 5.2, Implementation Data
Types, on page 45).

A base type’s <SHORT-NAME> never appears in the generated code; it is only used as a
reference target within the model. Only implementation data types are present in the
generated code.

Examples

This section shows examples for application data types, implementation data types, platform
types, and base types. The models used in chapter 4, Data Types (AUTOSAR R3.1.5 or
Lower), on page 33, are used here, too.

Primitive Data Type

When generating code for an AUTOSAR R4.0.* project, ASCET creates the files
Swc_appltypes.arxml and Swc_impltypes.arxml, and copies the files
AUTOSAR MOD PlatformTypes.arxml and

AUTOSAR MOD PlatformBaseTypes TC1796.arxml to the code generation directory.

The following primitive application data type is defined in Swc_appltypes.arxml for the
variable sdisc with sint8 implementation from section 4.2, Primitive Data Types, on page
33:
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<LE-PLCEAGE>
<SHORT-HNEME>ASCET Types</SHORT-HNAME>
<LE-PLCELGES>
<RR-FRCFEAGE>
<SHORT-HREME=ApplicationDataTypes<,/SHORT-HAME:
<ELEMENTS>

<BRPFPLICATICHN-FRIMITIVE-DATA-TYFE>
<SHORT-NAME>SInt8</SHORT-HNAME>
<CLTEGORY>VALUE</CLTEGORY >
<SW-DATL-DEF-PROFS>
<SW-DARTA-DEF-PROFS-VARIRNIS>
<SW-DATA-DEF-PROPS-CONDITICHAL>
<SW-CRLIBRATION-ACCESS>READ-ONLY</SW-CLALIBRATION-ACCESS>
<DATR-CONSTE-REF DEST="DATA-CONSTR">
/ASCET DataConstrs/Physical/de SInt8</DARTA-CONSTR-REF>
</ SW-DATL-DEF-FROPS-CONDITIONAL>
</5W-DATA-DEF-PROPS-VARILNTS>
</ EW-DLTR-DEF-FROES>
</LPPLICATICN-PRIMITIVE-DATA-TYPE>

</ELEMENTS>
< /AR-PRCFAGE>
</RR-FRCHELGES>
< /BR-PRCHRCE>

Listing 7: ARXML code — primitive application data type sint8 (AUTOSAR R4.0.2)

In the file Swe_mappings.arxml, the application data type is mapped to an
implementation data type:

<RR-PLCHLGE>
<SHORT-NEME>ASCET Mappings</SHCORT-NEZME>
<AR-PRCELGES>
<AR-PRCEALGE>
<SHORT-NAME>DataMappings</SHORT-NAME>
<ELEMENTS>
<DRTR-TYPE-MARPFING-SET>
<SHORT-NAME>Impl<,/SHORT-NRME>
<DRTA-TYPE-MAFS>

<DARTA-TYFE-MLP>
<BPPLICATICHN-DATA-TYFE-REF DEST="APPLICATION-PRIMITIVE-DATA-TYFE">
/ASCET Types/ApplicationDataTypes/SInt8</RFPLICATION-DATA-TYPE-REF>,
<IMPLEMENTATICH-DATA-TYPE-REF DEST="IMPLEMENTATION-DATA-TYPE">
fAUTOSAR PlatformTypes/ImplementationDataTypes/sint8
</IMPLEMENTATION-DATL-TYFE-REF>

</DATE-TYPE-MAP>

</DRTR-TYPE-MARPS>
<MCDE-REQUEST-TYPE-MAPS>

</MODE-REQUEST-TYPE-MAES>
<,/DATR-TYPE-MAPPING-SET>
</ELEMENTS>
</BRR-PACKAGE>
</BRR-PACKAGES>
< /BR-PRCFRCGE>

Listing 8: ARXML code — mapping of s1nt8 application data type and implementation data
type (AUTOSAR R4.0.2)
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The referenced implementation data type is a platform type, i.e. it does not appear in the
Swc_impltypes.arxml file. In the AUTOSAR MOD PlatformTypes.arxml file, the

referenced

<LE-FRCFRE

implementation data type looks as follows:

E>

<SHORT-NEME-AUTOSAR PlatformTypes</SHORI-NHRME>

<AR-PRCFAGES>

<RR-FRCFAGE>

<SHO!

RT-NAME>ImplementationDataTypes<,/SHORT-MNAME>

<LONG-NAME>

<L-4 L="EN":>AUTOSAR Platform types</L-4>
</ LONG-NAME >
<ELEMENTS>

Il’/K”ZEILIF:EI~IE§-I'Z'I—',TIC-}I—]::II-'.':I-';—'Z"EL’]E‘E> ﬁHH\\
<SHORT-NAME>sint8</SHORT-NAME:>

< LONG-NLME >
«L-4 L="EN"»=zigned integer 8bit</L-4>
</ LONG-HAME >
<CRTEGORY>VALUE</CATEGORY>
<INTRCODUCTICH>
<TRACE>
<SHORT-MAME>PLATFORMO16</SHORT-MAME >
<CRTEGORY>SPECIFICATION ITEM</CATEGCRY>
<P
<L-1 L="EN">This standard AUTOSAR type shall be 8 bit signed</L-1%|
</ B>
</TRACE>
</ INTRODUCTICH>
<SW-DATR-DEF-FROFPS>
<SW-DATE-DEF-PROPS-VARIANTS>
<SW-DATL-DEF-PROPS-CONDITICHAL>
<BRSE-TYPE-REF DEST="SW-BASE-TYFE">
SAUTOSAR PlatformTypes/SwBaseTypes/sint8</SLSE-TYPE-REF>
</ S5W-DATLE-DEF-PROPS-CONDITIONAL>
</SW-DATR-DEF-PROPS-VARIANTS>

</IMPLEMENTATICON-DATA-TYPE>

\\hthfSW—DRTA—DEF—FROF5> ;J///

</EL

EMENT 5>

«</RR-PRCFAGE>

</BR-PRCKRAGES>
</LRR-PRCERGE>

Listing 9: ARXML code - platform data type sint8 (AUTOSAR R4.0.2)

The referenced base type is provided in the
AUTOSAR MOD PlatformBaseTypes TC1796.arxml file:
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<AR-FACEKAGE>
<SHCORT-NAME>AUTOSAR PlatformTypes</SHORT-HEME:-
<RRE-FRCERGES>

<AR-PACERAGE:>
<SHORT-NAME >SwBaseTypes<,/SHORT-NAME>
< LOHNG-HAME >
<L-4 L="EN">AUTOSAR Base Types for AUTOSAR Platform types for TC1l796</L-4>
</ LONG-NAME >
<ELEMENT S

<SW-BASE-TYFE:>
<SHORT-MAME>sint8«</SHORT-MNAME>
<LONG-HAME >
<L-4 L="EN">=zigned integer 8bit</L-4>
</ LONGE-HLME >
<CRTEGORY>FIXED LENGTH</CRTEGORY>
<INTRODUOCTION:>
<TRRCE:>
<SHORT-HAME>PLATFORMO1 6« / SHORT-HAME >
<CLRTEGORY>SPECIFICATION ITEM</CLTEGORY>
<B>
<L-1 L="EN">This standard AUTOSAR type shall be 8 bit signed</L-1
</B>
</TRLCE>
</INTRODUCTION>
<BRSE-TYPE-SIZE»B</BASE-TYPE-SIZE>
<BASE-TYPE-ENCODING>2C<,/BASE-TYPE-ENCODING>

\\HE£EW—ERSE—:YFE} _F,f/j

< /ELEMENTS>

</BR-PRCEAGE>

</LR-FRCHELGES>
</RR-FRCHERGE>

Listing 10: ARXML code — base type sint8 (AUTOSAR R4.0.2)

5.6.2 Enumeration Type (Primitive Data Type with Semantics)

The following application data type is defined in Swc_appltypes.arxml for the
enumeration Enumeration from section 4.3, Primitive Data Types With Semantics, on page
36:
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<BR-FRCEALGE>
<SHORT-NAME>ASCET Types</SHORT-NAME>
<BR-FRACHAGES>
<AR-PRCEAGE>
<SHORT-MNAME»ApplicationDataTypes</SHORT-NAME>
<ELEMENTS>

<RARPPLICATICH-PRIMITIVE-DATR-TYFE>
<SHORT-MAME>Enumeration</SHORT-NLME >
<CLTEGORY>VALUE</CLATEGORY>
<5W-DATRA-DEF-PROFES>
<SW-DATR-DEF-PROPS-VRRIRNTS>
<SW-DATL-DEF-PROFS-CONDITICHNAL.>
<SW-CRLIBRATION-LACCESS>READ-ONLY<,/SW-CRALIEBRATION-LCCESS>
<COMPU-METHCD-REF DEST="COMPU-METHOD" >
FASCET CompuMethods/Enumerations/Enumeration</CCMPU-HMETHOD-REF>
<DRTA-CONSTR-REF DEST="DATA-CONSTR">
fASCET DataConstrs/Physical/dc mlto6</DATA-CONSTR-REF>
</ SW-DLTL-DEF-FROFS-CONDITIONAL>
</5W-DLTE-DEF-PFROPS-VARILNTS>
</ SW-DATL-DEF-FROFS>
</BRPPLICLATION-PRIMITIVE-DATL-TYPE>

</ELEMENTS>
</LR-PLCHLGE>
</BRR-PLCFRGES>
</BR-PRCERGE>

Listing 11: ARXML code — application data type Enumeration (AUTOSAR R4.0.2)

In the file swe_mappings.arxml, the application data type is mapped to an
implementation data type:

<RRE-FRCELGE>
<SHORT-HRME>ASCET Mappings</SHORT-NAME>
<RRE-FPLRCHRGES>
<RRE-FRCEAGE>
<S5HORT-NAME>DataMappings</SHORT-NAME>
<ELEMENTS>
<DATA-TYPE-MAFFING-SET>
<SHORT-NAME>TImpl</SHORT-HAME:
<DATRA-TYFE-MLES>

<DATA-TYPE-MAP>
<RPPLICRTICH-DATL-TYPE-REF LDEZT=
"APPLICATION-PRIMITIVE-DATA-TYPE" >
JASCET Types/ApplicationDataTypes/Enumeration
</BPPLICATION-DATL-TYFE-REF>
<IMPLEMENTATICHM-DATR-TYPE-REF DEST="IMPLEMEMNTATION-DATA-TYFE">
/ASCET_Types/ImplementationDataTypes/Enumeration
</ IMPLEMENTATICHN-DATL-TYFE-REF>

</DARTL-TYFE-MAP>

</DATR-TYPE-MRPS>
<MCDE-REQUEST-TYPE-MAFPS></MCDE-REQUEST-TYFE-MLPS:
«</DATR-TYPE-MAPPING-SET>
</ELEMENT S
«/LR-PRCEALGE>
< /BR-PACKAGES>
< /LR-PRCKAGE>

Listing 12: ARXML code — mapping of Enumeration application data type and
implementation data type (AUTOSAR R4.0.2)
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The referenced implementation data type is not a platform type, i.e. it appears in the
Swc_impltypes.arxml file.

<RE-FPRCFRGE>
<SHORT-NRME-ASCET Types</SHORT-NRME:
<RR-PRCHAGES>
<AR-PLCEAGE
<SHORT-NZME>TmplementationDataTypes</SHORT-NAME-

<ELEMENT 5>

AME>Enumeration</SHORT-NAME:
EY>TYPE REFERENCE</CRTEGORY>
<SW-DATA-DEF-FROFS>
<SW-DATA-DEF-FROFS-VARIRNTS>
<SW-DATA-DEF-FROFPS-CCHDITICHAL>

<COHMPU-HMETHCD-REF LDEST="COMPU-METHOD" >
JASCET CompuMethods/Enumerations/Enmmeration</CCMPU-METHOD-REF>
<IMPLEMENTATICHN-DATA-TYPE-EEF DEST="IMPLEMENTATION-DATA-TYPE">

JAUTOSAR PlatformTypes/ImplementationDataTypes/sints
</ IMPLEMENTATICN-DATA-TYPE-REF>

</BW-DATL-DEF-FROFS-VRRIANTS>
</BW-DATL-DEF-FROFS>

</ IMPLEMENTATION-DATA-TYFE>

Listing 13: ARXML code — implementation data type Enumeration (AUTOSAR R4.0.2)

The implementation data type references the sint8 platform type; see Listing 9 on page
49.

The sint8 platform type references the sint8 base type; see Listing 10 on page 50.

5.6.3 Record Type (Complex Types)

The following application data type is defined in Swc appltypes.arxml for the record
Record from section 4.4.1, Record Types, on page 39:
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<RR-PRCHAGE>
<SHORT-NAME-ASCET Types</SHORT-NAME>
<RE-FRCELGES>
<RR-FRCEAGE>
<SHCORT-NAME>ApplicationDataTypes</SHCORT-NEME:>
<ELEMENTS>

<APPLICATICH-RECCRD-DATA-TYFE>
<SHGRT—HRHE>Record_lmpl<f5HORT—HRHE}
<CATEGORY>STRUCTURE</CATEGORY >
< SW-DATL-DEF-PROES>
<EW-DRTA-DEF-PROFPS-VARIANTS>
<SW-DATA-DEF-PROPS-CONDITICHNAL>
<SW-CRLIBRATICHN-ACCESS>READ-ONLY</SW-CLLIBRATICN-ACCESS>
</ 5W-DRTL-DEF-FROPS-CONDITIONAL>
</ SW-DATA-DEF-FROPS-VARILNTS>
</ 5W-DRTL-DEF-FROPS>
<ELEMENTS>
<BPPLICATICH-RECCORD-ELEMENT >
<SHORT-NAME »A< /SHORT -NAME>
<CLTEGORY>VALUE</CATEGORY>
<TYPE-TREF DEST="APPLICATION-PREIMITIVE-DATA-TYFE">
JASCET_Types/ApplicationDataTypes,/UIntl6</TYFE-TREF>
</LPPLICATICH-RECCRD-ELEMENT >
<AFPLICATICHN-RECCRD-ELEMENT >
<SHORT-NEME>B</SHORT -NAME:
<CLTEGORY>VALUE</CATEGCRY>
<TYPE-TREF DEST="APPLICATION-PRIMITIVE-DATA-TYFE">
JASCET Types/ApplicationDataTypes/Boolean</TYFE-TREF>
</LPPLICATION-RECCRD-ELEMENT>
</ELEMENTS>
</LPPLICATICH-RECCORD-DATA-TYPE:>

«/ELEMENTS>
< /RR-FLCERCGE>
«/BR-PRCERCGES>
</BR-PRCKAGE>

Listing 14: ARXML code — application data type Record Impl (AUTOSAR R4.0.2)

In the file Swe_mappings.arxml, the application data type Record Impl is mapped to
an implementation data type:
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<BRE-PACKRGE>
<SHORI-NRMErASCET Mappings<,/SHORT-NRME>
<RBR-PRCKRGES>
<RE-PRACEAGE>
<SHCORT-MRME:>DataMappings</SHCORT-MAME>
<ELEMENTS>
<DATA-TYFE-MAPFING-SET>
<SHORT-NEAME>Tmpl</SHORT-NAME>
<DRTL-TYPE-MOFS>

<DATA-TYPE-MLE>
<APPLICATICHN-DATA-TYPFE-REF DEST="APPLICATION-RECORD-DATA-TYPE">
JASCET Types/ApplicationDataTypes/Record Impl
</BRPPLICATION-DATA-TYPE-REF>
<IMPLEMENTATICHN-DATA-TYPE-REF LDEST="IMPLEMENTATION-DATA-TYFE" >
/ASCET Types/ImplementationDataTypes/Record Impl
</ IMPLEMENTATION-DATL-TYPE-REF>
</DLTL-TYPE-HMLE>
</DLTL-TYPE-MLES>
<MODE-REQUEST-TYPE-MLPS>< /MODE-REQUEST-TYPE-MLES>
</DLTA-TYPE-MARPFING-3ET>
</ELEMENTS>
< /LR-PRCELGE>
< /BRE-PLCELGES>
< /BR-FRCELGE>

Listing 15: ARXML code — mapping of Record Impl application data type and
implementation data type (AUTOSAR R4.0.2)

The referenced implementation data type is not a platform type, i.e. it appears in the
Swc_impltypes.arxml file.
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<BLR-PLCEAGE>
«<SHORT-HAME>ASCET Types<,/SHORT-NAME>
<BR-PRCEAGES>
<BR-PRCEAGE>
<SHORT-MEME>ImplementationDataTypes</SHORT-NAME:>
<ELEMENTS>

<IMPLEMENTATICN-DATL-TYPE>
<5HGRT—HEHE}REGord_;mpl</SHGR:—ﬂEHE}
<CRTEGORY>»STRUCTURE<,/CLATEGORY>
<«SUB-ELEMENTS>
<IMPLEMENTATICN-DATA-TYPE-ELEMENT >
<SHORT-NAME>»A<,/SHORT-NAME>
<CRTEEORY}TYPE_REFERENCE</CETEEGRY>
<SW-DATL-DEF-FRCPS>
<SW-DATR-DEF-PRCPS-VARIRNTS>
<SW-DATR-DEF-PRCPS-CONDITICHAL>
<IMPLEMENTATICN-DATA-TYPE-REF DEST="IMPLEMENTATION-DATA-TYPE"
>/AUTOSAR PlatformTypes/ImplementationDataTypes/nintls
</ IMPLEMENTATION-DRTL-TYPE-REF>
</ SW-DATL-DEF-PROPS-CONDITIONAL>
</ 5W-DLTL-DEF-FROPS-VRRILNTS>
</S8W-DATL-DEF-FROES>
</IMPLEMENTATION-DATA-TYPE-ELEMENT >
<IMPLEMENTATICN-DATA-TYPFE-ELEMENT>
<SHORT-NAME>B«/SHORT-NAME:
(CETEEORY}TYPE_BEFERENCE(/CETEEORY}
«<SW-DATL-DEF-FRCES>
<SW-DATE-DEF-FROPS-VARIERNTS>
<SW-DATL-DEF-FROFS5-CONDITICHAL>
<IMPLEMENTIATICH-DATA-TYPFE-REF DEST="IMPFLEMENTATION-DATA-TYFPE"
>/AUTOSAR PlatformTypes/ImplementationDataTypes/boolean
</ IMPLEMENTATICHN-DATA-TYFE-REF>
</ SW-DATA-DEF-PROPS-CONDITIONLL >
</ S5W-DATA-DEF-FROPS-VARILNTIS>
</ SW-DATR-DEF-PROPS>
</ IMPLEMENTATION-DRTA-TYPE-ELEMENT >
</3UB-ELEMENTS>
</IMPLEMENTATION-DATA-TYPE>
</ELEMENTS>
</BR-PRCHERAGE>
</LR-PLCHLEES>
</LR-PLCHELEE>

Listing 16: ARXML code — implementation data type Record Impl (AUTOSAR R4.0.2)

The implementation data type Record impl references two platform types, one for each
record element. In the AUTOSAR MOD PlatformTypes.arxml file, the referenced
implementation data types look as follows:
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<IMPLEMENTATICH-DATA-TYPE>
<5HORT-NAME>boolean<,/SHORT-NAME>
<LCNG-NAME >
<L-4 L="EN">Boolean</L-4>
</ LONG-NRME>
<CRTEGORY>VALUE</CATEGCRY>
<INTRODUCT ICH>
<TRACE>
<SHORT-NAME>PLATFORMO26+</ SHORT-MNAME >
<CATEGORY>CONSTRAINT</CATEGORY>
<P
<L-1 L="EN">Thisz standard AUTOSAR type shall only bhe used together with the definitions
TRUE and FALSE. See <XREF><REFERRABLE-REF DEST="TRACEABLE-TEXT" BASE="SWS PlatformTypes"
>PLATFORMD27</REFERRLBLE-REF></XREF> for implementation and usage.</L-1>
</ B>
</TRLCE>
<TRACE>
<SHORT-NAMEPLATFORMO60<,/ SHORT -NAME >
<CATEGCRY>SPECIFICATION ITEM</CLTEGORY>
<B>
<L-1 L="EN">The boolean type shall always be mapped to a platform specific type where
pointers can be applied to to enabkle a passing of parameters via API. There are
specific BIT types of some HW platforms which are very efficient bunt where no pointers
can point to.</L-1>
</ B>
<P
<L-1 L="EN">There are specific BIT types of some HW platforms which are wvery efficient
but where no pointers can point to.</L-1>
</ B
</TRACE>
</INTRODUCTICH>
<5W-DATL-DEF-PROPS>
<SW-DATA-DEF-PROPS-VARIANTS>
<SW-DATA-DEF-PROPS-CONDITICNAL>
<!—=— CompuMethod for TRUE and FALSE -->
<BRSE-TYPE-REF DEST="SW-BASE-TYPE">/AUTOSAR PlatformTypes/SwBaseTypes/boolean
</BASE-TYPE-REF>
<CCMPU-METHCD-REF DEST="COMPU-METHOD">/AUTOSAR PlatformTypes/Compulethods/boolean
</COMPU-METHOD-REF>
</ 3W-DATA-DEF-PROPS-CONDITIONAL>
</ 5W-DATL-DEF-PROPS-VLARIANTS>
<,/5W-DATA-DEF-PROP5>
</IMPLEMENTATICN-DATA-TYPE>

Listing 17: ARXML code — platform data type Boolean (AUTOSAR R4.0.2)
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<IMPLEMENTATICHN-DATA-TYFE>
<SHORT-NAME>nintl16</SHCORT -NAME:
<LONG-HAME >
£L-4 L="EN">un=igned integer 1ébit</L-4>
< /LONG-NAME >
<CRATEGORY>VALUE</CATEGORY >
<INTRODUCTICH>
<TRACE>
<SHORT-NAME>PLATFORMO14<,/SHORT-NAME >
<CATEGCRY>SPECIFICATION ITEM</CRTEGCRY>
<F>
<L-1 L="EN">This standard AUTOSAR type shall bhe of 16 bit unsigned.</L-1>
</Bx>
</TRRACE>
</INTRODUCTION>
<5SW-DATR-DEF-FRCPS>
<SW-DATL-DEF-PROPS-VARILNTS>
<SW-DATL-DEF-FROPS-CONDITIONLAL
“BRSE-TYPE-REF DEST="SW-BASE-TYPE">/AUTOSAR PlatformTypes/SwBaseTypes/unintlé
</BASE-TYPE-REF>
</ SW-DATA-DEF-PROPS-CONDITICHAL>
</ S3W-DARTA-DEF-PROPS-VARIARNT S
</SW-DRTR-DEF-PRCPS>
</IMPLEMENTATICH-DATA-TYPE>

Listing 18: ARXML code — platform data type uint16 (AUTOSAR R4.0.2)

The base types boolean and uint16, referenced in Listing 17 and Listing 18, are provided
in the AUTOSAR MOD PlatformBaseTypes TC1796.arxml file:
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<SW-BRSE-TYPE>
<SHORT-NAME>hoolean</SHORT-NAME>
<LONG-NAME>
<«L-4 L="EN">Boolean<,/L-4>
</ LONG-HAME >
<CRTEGORY>FIXED LENGTH</CRIEGORY>
<INTRCDUCTICH>
<TRRCE>
<SHORT-NAME>PLATFORMOG0</ SHORT-NAME >
<CLTEGORY>SPECIFICATION ITEM</CARTEGORY>
<B>
«<L—-1 L="EN">The boolean type shall always be mapped to a platform specific type
where pointers can be applied to to enabkle a passing of parameters via API. There
are specific BIT types of some HW platforms which are very efficient bmt where

no pointers can point to.</L-1>
</P>
</TRRCE>
<TRLCE>
<SHORT-NAME>PLATFORMO26< /SHORT -NAME >
<P
<L-1 L="EN">This standard AUTOSAR type shall only ke used together with the
definitions TRUE and FALSE. See FLATFORMO27 for implementation and usage.</L-1>
</B>
</TRACE>
</ INTRODUCTICN>
<BRSE-TYPE-SIZE>»8</BASE-TYPE-SIZE>
<BAEE-TYPE-ENCODING>BOOLEAN< /BASE-TYPE-ENCODING>
</SW-BLSE-TYPE>

<SW-BASE-TYFE>
<SHORT-NAME>nintl6</S5HORT-NAME:>
<LONG-NALME >
<L-4 L="EN">unsigned integer 1l6bit</L-4>
</ LONG-NAME >
<CRTEGORY>FIXED LENGTH</CATEGORY>
<INTRODUCTION>
<TRACE>
<SHORT-NAME>PLATFORMO14</SHORT-NAME>
<CRTEGORY>SPECIFICATION ITEM</CATEGCRY>
<P>
<L-1 L="EN">This standard AUTOSAR type shall be of 16 bit unsigned.</L-1>
</B>
</TRACE>
</ INTRODUCTICH>
<BRSE-TYPE-SIZE>16</BRSE-TYPE-SIZE>
<BRSE-TYPE-ENCODING>NONE</BLSE-TYPE-ENCODING>
</SW-BASE-TYPE>

Listing 19: ARXML code — base types boolean and uint16 (AUTOSAR R4.0.2)

5.6.4 Array Type (Complex Types)

The following application data type is defined in Swc appltypes.arxml for the array
array from section 4.4.2, Array Types, on page 43:
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<LR-PRCHLGE™>
<SHORT-NREME>ASCET Types</SHORT-NAEME:>
<RE-FRCHRGES>
<RR-PRCEAGE>
<SHORT-NAME>ApplicationDataTypes</SHORT-HAME>
<ELEMENTS:
<RPPLICATICH-LREAY-DRATR-TYPE:>
<SHORT-NEME>UInt8_16</5HORT-NAME>
<l—
array of 16 &quot;UIntd&gquot; wvalues
-
<CATEGORY>ARRAY< /CATEGORY>
<5W-DATAR-DEF-PROPS>
<SW-DRTR-DEF-FROPS-VRRIANTS>
<5W-DATR-DEF-PROPS-CCHDITICHAL
<SW-CALIBRATICHN-ACCESS>READ-ONLY</SW-CALIBRATION-ACCESS:>
</SW-DATA-DEF-PROPS-CONDITICONAL>
</ 5W-DATL-DEF-FROPS-VARILNTS>
</ SW-DRTA-DEF-PROFS>
«ELEMENT >
<SHORT-NAME >elementName<,/SHORT -NAME >
<CATEGORY>VALUE</CATEGORY>
<IYPE-TREF DEST="APPLICATION-PRIMITIVE-DATA-TYFE">
JASCET_Types/ApplicationDataTypes/UInt8</TYFE-TREF>
<LRRLY-SIZE-SEMRNTICS>FINED-SIZE</LARRAY-SIZE-SEMANTICS>
<MAR¥-NUMBER-OF-ELEMENTS5>16</MA¥-NUMEER-OF-ELEMENT 5>
</ELEMENT >
</RPPLICATICHN-ARRAY-DATA-TYFE>

</ELEMENTS>
< /BR-PRCELRGE>
</LR-FLCEREES>
< /BR-FRCHRGE>

Listing 20: ARXML code — application data type uInt8 16 of category ARRAY (AUTOSAR
R4.0.2)

In the swc_mappings.arxml file, the application data type is mapped to an
implementation data type:
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<RRE-FRCFAGE>
<SHORT-NAME-ASCET Mappings</SHORT-HAME:
<RRE-FPACFAGES>
<AR-PLCERAGE >
<SHORT-NAME:=DataMappings</SHORT-HNAME:>
<ELEMENTS>
<DARTA-TYFE-MARPPING-SET>
<SHORT-NAME>Tmpl<,/SHORT-NAME>
<DRTRA-TYFE-MAFS>

<DRTAR-TYPE-MLP>
<LPPLICATICN-DATA-TYPE-REF DEST="APPLICATION-ARRAY-DATA-TYPE" >
JASCET Types/ApplicationDataTypes/UIntg 16
</BPPLICATION-DATL-TYFE-REF>
<IMPLEMENTATICHN-DATA-TYPE-REF LEST="IMPLEMENTATION-DATA-TYFPE">
JASCET_Types/ImplementationDataTypes/auint8 16
</ IMFLEMENTATICN-DATL-TYPE-REF>

</DARTL-TYPFE-MAF>

«</DATR-TYPE-MRPS>
<MCDE-REQUEST-TYPE-MAPS></MODE-REQUEST-TYPE-MAPS>
</DATA-TYPE-MAPPING-SET>
</ELEMENTS>
«/LR-PRCKAGE>
< /BR-PACKAGES>
«/LR-PRCKAGE>

Listing 21: ARXML code — mapping of UInt8_ 16 application data type and implementation
data type (AUTOSAR R4.0.2)

The referenced implementation data type is not a platform type, i.e. it appears in the
Swc_impltypes.arxml file.

<AR-PLCEARGE>
<SHORT-MNAME>TmplementationDataTypes<,/SHORT-MLAME >
<ELEMENTS>
<IMPLEMENTATICH-DATA-TYFE>
<SHORT-NAME>uint® 16</SHORT-NAME>
<l——
array of 16 &quot;uint8&gquot; wvalues
-2
<CATEGORY>ARBAY</CLTEGORY>
<SUB-ELEMENTS>
<IMPLEMENTATICH-DATA-TYPFE-ELEMENT>
<SHORT-NAME>»elementName<, SHORT -HNAME>
<CLATEGORY>TYPE REFERENCE</CLTEGCRY>
<ARRARY-SIZE>16«/ARRAY-SIZE>
<RRRRY-SIZE-SEMANTICS>FIXED-SIZE</RRRAY-SIZE-SEMANTICS>
<5W-DATR-DEF-PROFS>
<EW-DATR-DEF-PROPS-VARIRNTS>
<SW-DATA-DEF-PROPS-CONDITICHAL>
<IMPLEMENTATICH-DATA-TYPE-REF DEST="IMPLEMENTATION-DATA-TYPE">
JAUTOSAR PlatformTypes/ImplementationDataTypes/uints
</IMPLEMENTATION-DATA-TYPE-REF>
</ SW-DATA-DEF-FPROPS-CONDITIOHAL>
</ SW-DATA-DEF-PROPS5-VARIANTS>
</ 5W-DATA-DEF-PROES>
</ IMPLEMENTATION-DATA-TYPE-ELEMENT>
</5UB-ELEMENTS>

</ELEMENTS>
</BR-PLCERGE>

Listing 22: ARXML code — implementation data type Record Impl (AUTOSAR R4.0.2)
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The implementation data type references the uint8 platform type. In the
AUTOSAR MOD PlatformTypes.arxml file, the referenced implementation data type
looks as follows:

<IMPLEMENTATICH-DATR-TYFE>
<SHORT-HAME>nint8</SHORT-HLME>
< LOMNG-HAME
<L-4 L="EN">unsigned integer 8bhit</L-4>
</ LONG-HLME>
<CATEGORYS>VALUE< /CATEGCORY >
<INTRODUCTICH>
<TRARCE>
<SHORT-NAME>PLATFORMO13</SHORT-IMNAME>
<CRTEGORY>SPECIFICATION ITEM</CRTEGCRY>
<P
«<L-1 L="EN">This standard AUTOSAR type shall be of & bit unsigned.</L-1>
</P>
</TRACE>
</ INTRODUCTION>
<SW-DRTAR-DEF-PROPS>
<5SW-DATR-DEF-PROPS-VARIANTS>
<SW-DATA-DEF-FROPS-CONDITICHNAL>
<BLEE-TYPE-REF DEST="SW-BASE-TYPE">»
SAUTOSAR PlatformTypes/SwBaseTypes/uint8</BRSE-TYFE-REF>
</ 5W-DATA-DEF-PROPS-COMDITIONAL
</ SW-DATA-DEF-PROPS-VARILNTS:>
</ SW-DATA-DEF-PROPS>
</ IMPLEMENTATICN-DATL-TYFE>

Listing 23: ARXML code — platform data type uint8 (AUTOSAR R4.0.2)

The uint8 platform type references the uint8 base type; the latter is provided in the
AUTOSAR MOD PlatformBaseTypes TC1796.arxml file:

<SW-BASE-TYPE>
<SHORT-NEME>unint8</SHORT-HAME>
<LOHNG-NAME >
<L-4 L="EN">unsigned integer Bbit</L-4>
</ LONG-HMLME>
<CRTEGCRY>FIXED LENGTH</CRTEGCRY>
<INTRCDUCT ION>
<TRLCE>
<5HORT-NAME>PLATFORMO13</SHORT-HAME >
<CRTEGCRY>SPECIFICATION ITEM</CRTEGCRY>
<P
<L-1 L="EN">This standard AUTOSAR type shall be of 8§ bit unsigned.</L-1>
</ P>
</TRRACE>
</ INTRODUCTION>
<BRSE-TYPE-SIZE>B</BRASE-TYPE-SIZE>
<BARSE-TYPE-ENCCDING>NONE</BASE-TYPE-ENCCODING:
</ SW-BRSE-TYPE>

Listing 24: ARXML code — base type uint8 (AUTOSAR R4.0.2)
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6 Interfaces

When an application consists of multiple software components, it may be necessary for the
software components to communicate, either to exchange data or to trigger some function.
Communication between AUTOSAR software components is designed in terms of ports and
interfaces. The following interface types are available:

1. Sender-receiver (signal passing) — see section 6.1
2. Mode-switch (communication of mode switches) — see section 6.2
3. Client-server (function invocation) — see section 6.3
4. Calibration — see section 6.4
5. NV-data® (non-volatile signal passing) — see section 6.5
These communication models are known as interfaces in AUTOSAR.

All ports of a software component (whether a provided or a required port) are typed by a
specific interface. Interface types are defined using either the <SENDER-RECEIVER-
INTERFACE> OF <MODE-SWITCH-INTERFACE>! Or <CLIENT-SERVER-INTERFACE> OF
<CALPRM-INTERFACE>?/ <PARAMETER-INTERFACE>! OF <NV-DATA-INTERFACE>"
elements.

The definition of sender-receiver, client-server and calibration interfaces is considered in
detail in this section.

Note that the way the software component interacts with the interface is defined by the
<INTERNAL-BEHAVIOR> element that references a software component. This is discussed
in chapter 8, Internal Behavior, on page 100.

6.1 Sender-Receiver

Sender-receiver communication involves the transmission and reception of signals consisting
of atomic data elements sent by one component and received by one or more components.

Each sender-receiver interface may contain multiple data elements, each of which can be
sent and received independently.

To create a sender-receiver interface:

= In the component manager, select Insert > AUTOSAR >
SenderReceiver_Interface.

= Name the sender-receiver interface SRInterface.

When generating code for an AUTOSAR project, ASCET defines a <SENDER-RECEIVER-
INTERFACE> element in the file Swc interfaces.arxml. The <SENDER-RECEIVER-
INTERFACE> element has the following structure in the configuration language:

1in AUTOSAR 4.0.*
2 in AUTOSAR R3.1.5 or lower
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<LE-PRCELEE>
<SHGRT—HEHE>ASEET_interfaces(HSHGRT—HﬁHEb
<DESC></DESC>
<SUE-FLCEAGES™
<LE-PRCELEE>
“SHORT-HLME>Impl</ SHORT-MLME>
<DESC></DESC>
<ELEMENT 5>

~ %SENDER-RECEIVER-INTERFACE> I
<SHORT-NAME>SRInterface</SHORT-NEME>
<I5-SERVICE>false</IS-SERVICE>
<DATL-ELEMENTS>

</DATR-ELEMENTS>
<MODE-GRCOUES>

< /HCDE-GRCOUPS>
\HEISEHDER—RECEI?ER—IHTERFRCE} A
< /ELEMENTS>
</AR-PRCEAGE>
</ SUE-PRCERGES>
< /RR-FRCERGE>

Listing 25: ARXML code — sender-receiver interface definition (AUTOSAR R3.1.2)

<AR-PACHKAGE>
<SHORT-NEME>ASCET Interfaces</SHORT-NAMES>
<BR-PLCHAGES>
<AR-PLCEAGE>
<SHORT-NAME>Impl</SHORT-NAME>
<ELEMENTS>
" <SENDER-RECEIVER-INTERFACE> ™
<SHORT-NAME>SRInterface</SHORT-NAME>
<I5-SERVICE>false</IS-SERVICE>
<DATL-ELEMENTS>

</DARTA-ELEMENTS>
%/ SENDER-RECEIVER-INTERFACE> A
</ELEMENTS>
</ AR-PRCERGE>
</ LR-PRCERGES>
</RR-FRCFRGE>

Listing 26: ARXML code — sender-receiver interface definition (AUTOSAR R4.0.%*)

The name of the sender-receiver interface definition is given by the <SHORT-NAME>. The
name is used within other elements that need to reference the interface type, for example a
software component may specify that it uses sender-receiver interface SRInterface.

The short-name of a sender-receiver interface should be a valid C identifier.
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A sender-receiver interface can be used to communicate data (using data element
prototypes within the <DATA-ELEMENTS> element) or modes (see section 6.2, Mode , on
page 67 for more details).

Note

In AUTOSAR R3.1.5 or lower, a sender-receiver interface can contain zero or more data
elements and/or zero or more mode groups. However, it is good practice to separate
Interfaces used for data transfer and interfaces used for mode management.

In AUTOSAR R4.0.*, a sender-receiver interface must contain either data elements or a
single mode group. If a sender-receiver interface contains both kinds of elements, an
error Is [ssued during code generation.

6.1.1 Data Element Prototypes

Each sender-receiver interface can specify zero or more data elements that constitute the
AUTOSAR signals communicated over the interface. Each data item defines a prototype of a
specific type and can be a primitive data type, a RECORD or an ARRAY type. See chapter 4,
Data Types, on page 33 for details of defining data types.

To create a data element in ASCET:

= In the component manager, double-click on SRInterface.

The "Sender Receiver Interface Editor for: SRInterface" editor
opens.

= Use the Signed Discrete Variable button to create an sdisc
variable.

The "Properties for Scalar Element: sdisc" dialog window opens.
= Name the signed discrete variable Speed.

[% SenderReceiver Interface Editor for: SRInterface EI@
File Edit VYiew Insert Extras Toocls Help
P P B |"% - Mg
TERIFETE = ﬁ Elements | ¥ Data | tﬁ. Implementation I 3?.5 Layout| ﬁ Elements =
3 Database MName Type MaxSize |Scope[kKind  |Reference|Exister g
-d 53 E_g = <« - B speed *E" sdisc|— local |Variable|-— real ﬁ

*$ Wl speed::sdisc

| i 3

[E self B Data & Impl

Figure 17: Data element speed for the sender-receiver interface SRInterface

To create an implementation of a data element:

= In the "Sender Receiver Interface Editor for: SRInterface" editor,
go to the Implementation tab.

= In the Implementation tab, double-click the speed element.
The "Implementation for: Speed" window opens.

= In the "Master" field, activate Implementation.

= In the "Implementation" field, select sint16.

= Right-click in the "Min" and "Max" fields and select Default
Value from the context menu.

= Close the "Implementation for: sdisc" window with OK.
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The Implementation tab of the "Sender Receiver Interface
Editor for: SRInterface" editor shall look like the figure below.

f% SenderReceiver Interface Editor for: SRInterface El@
File Edit VYiew Insert Extras Tools Help
P P % G v Mg Cd
: & trienentton i Lo SO
. 2

MName Type Impl. |Impl. |Impl. |Q |Formula|Limit tor

Type |Min  |[Max bit lengt

W speed |*S sdisc |sint1s|-32768|32767 |1 |ident  |Auto

?. Speed::sdisc

4 | i | L

My seif i Data &&, Impl

Figure 18: Implementation Tmp1 of the sender-receiver interface SRInterface with data
element Speed

An implementation of a sender-receiver interface in ASCET corresponds to a sender-receiver
interface in AUTOSAR. The sender-receiver interface in configuration language is generated

by ASCET in the file Swc_interfaces.arxml.

In AUTOSAR R3.1.5 or lower, the declaration of data elements within a sender-receiver
interface definition has the following structure:

<LR-PACKLGE>
<SHORT—HEHE>ASCET_interfaces(!SHORT—HﬁHE>
<DESC»</DESC>
< SUB-PLCHELRGCES>
<RR-PLCERGE>
<SHORT-NAME>Impl</SHORT-HAME>
<DESC»</DESC>
<ELEMENTS>
<SENDER-RECEIVER-INTERFACE>
<SHORT-NAME>SRInterface</SHORT-NAME>
«<I5-5ERVICE>false«/I5-5ERVICE>
<DRTE-ELEMENTS >
<DATR-ELEMENT-FROTCTIYFE>
<SHORT-NAME>Speed</ SHORT-NAME>
<SW-DATA-DEF-FROPS>
<SW-CLLIBRATICON-ACCESS>READ-ONLY </ SW-CLLIBRATICHN-ACCESS>
</ BW-DRTL-DEF-FROES>
<TYPE-TREF :EST=“INTEGER—TYPE”}jADTOSAR_pypestIutlﬁ
</ TYEE-TREF>
<IS-QUEUED>false<,/I5-QUEUED>
</DARTA-ELEMENT-FROTOTYFE>
</DARTL-ELEMENTS>
</ SENDEE-RECEIVER-INIERFLCE>
</ELEMENTS>
«/BRE-PLCHAGE>
</ 5UB-PLCEAGES>
< /BR-PACFLGE>

Listing 27: ARXML code - declaration of data elements within sender-receiver interface
(AUTOSAR R3.1.2)
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In AUTOSAR R4.0.*, the declaration of data elements within a sender-receiver interface
definition has the following structure:

<SHORT-NAMEXASCET Interfaces</SHORT-NAME>

—NEME>Impl<,/SHORT-HNAME>

MENTS>

<SENDER-RECEIVER-INTERFLCE>
H -MNEME=>SRInterface</SHORT-HAME
CE>false</I5-5ERVICE>
LEMENTS>
IRRELE-DRTR-PROTOTYFE>
<SHORT-NAME >Speed</SHORT-NAME >
SW-DATL-DEF-PROPS>
<SW-DATL-DEF-PROPE-VARIRNTE>
<SW-DATA-DEF-PROFS-CONDITICHAL>
<SW-ADDR-HMETHOD-REF DEST="SW-ADDR-METHOD" >
,fF!.SCET AddrMethods /RAM< / SW-LDDR-METHOD-REF>
<SW-CALIBEATICH-ACCESS>READ-ONLY
</ SW-CRLIBRATICON-ACCESS>
<SW-IMPL-PCLICY>STANDARD</SW-IMPL-POLICY >
</ SW-DATA-DEF-PROPS-CONDITICHAL>
</ SW-DATR-DEF-PROFS-VARILNTS>
</ EW-DLTE-DEF-PRCPS>
<TYPE-TREF LDEST="APPLICATION-PRIMITIVE-DATA-TYPE":>
JASCET Types/ApplicationDataTypes/SIntl6</T¥PFE-TREF>
< /VRRIABLE-DATA-FROTCOTYFE:>
\-ELEMENTS>
INTERFACE>

=
[

oA

?‘:
[T

Listing 28: ARXML code - declaration of data elements within sender-receiver interface
(AUTOSAR R4.0.2)

A data element is defined using the <DATA-ELEMENT-PROTOTYPE>! / <VARIABLE-DATA-
PROTOTYPE>? element, and all elements must be defined within an encapsulating <DATA-
ELEMENTS> element.
Each <DATA-ELEMENT-PROTOTYPE>/<VARIABLE-DATA-PROTOTYPE> element must
specify:

= the <SHORT-NAME> that you will use to refer to the item

» the <SW-DATA-DEF-PROPS> data properties, among them

— the <SW-CALIBRATION-ACESS>
* a<TYPE-TREF> reference to the type of the data item
» AUTOSAR R3.1.5 or lower only: whether the data reception <1S-QUEUED> or not

— <IS-QUEUED>false</IS-QUEUED> — means that a newly received value
overwrites the previous value of the datum. If a value is sent multiple times before
it is received then the receiver can only access the last transmitted value.

! AUTOSAR R3.1.5 or lower
2 AUTOSAR R4.0.*
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— <IS-QUEUED>true</IS-QUEUED> — means that the sender-receiver interface
queues arrivals of the datum on the receiver side.

Note

Queued communication can currently not be modeled in ASCET V6.2. It is possible,
however, to use queued communication by means of ASCET C code components.

Mode Switch

An AUTOSAR system can be configured to operate in one or more application modes. A
mode-switch interface can specify zero or more mode groups that define application modes.

In ASCET, mode-switch interfaces are realized as sender-receiver interface components that
contain mode groups.

In AUTOSAR R3.1.5 or lower, a sender-receiver interface that contains a mode group can
also contain data elements. However, it is strongly recommended to add either data
elements or mode groups to a single sender-receiver interface.

Beginning with AUTOSAR R4.0, a sender-receiver interface that contains a mode group must
not contain data elements, and vice versa. Mixing both kinds of elements leads to a code
generation error.

To create a mode group:

= In the component manager, select Insert > AUTOSAR >
Mode Group.

= Name the mode group Onof fMode.

= 1Inthe "1 Database" or "1 Workspace" pane, select OnOffMode
and go to the "3 Contents" pane.

= Select Mode = Rename to rename the label mode as of f.
= Select Mode = Add Mode - As Last to create a new mode

on.
(£ ASCET-MD-RP-SE =N R
File Edit View Insert Build Teels SCM  Mode Help
38 X 9 -
@ \Exercises\Chapter_5_Interfaces\Interfaces\OnOffode - ié)
1Database » | 3 Contents i
—E ELjInterfaces + (IMode
—— [y calinterface off <initial>
— [E'J.CSInterfacE an
—— [ByModelnterface E ‘
— t?‘.N".-'Data_Interface -
— [ﬁ! OnOffvode
— EESRInterfacE -
4 | [ 3
2 Comment x
rl b 4| m 3
7 none (3 d:\ETASData\ASCETE. 2\Database\AUTOSAR_UG_Tutorial &

Figure 19: Mode declaration group onOf fMode
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In AUTOSAR R3.1.5 or lower, ASCET declares the <MODE-DECLARATION-GROUP> in the
autosar types.arxml file, AUTOSAR package ASCET types.

<AR-PLCEAGE>
<SHORT-NAME>ASCET types</SHORT-NAME:
<DESC»</DESC>
<ELEMENTS>
<MODE-DECLARATICH-GROUE>
«SHORT-MAME>OnOffMode</ SHORT -HAME >
<INITIAL-MCDE-REF DEST="MODE-DECLARATION">/ASCET types/OnOffMode/off
«/INITIRL-MCDE-REF>
<MODE-DECLARERTICHS»
<MODE-DECLARATION>
<SHORT-NAME»off</SHORT -MAME>
< /MODE-DECLARLRTION>
<MODE-DECLARATICN>
<SHORT-NEME>on</ SHORT-MLME>
«/MODE-DECLARETION>
< /MODE-DECLARRATIONS>
< /MODE-DECLARATION-GROUE>
</ELEMENTS>

< /LE-PLCELGE>
Listing 29: ARXML code for a mode declaration group (AUTOSAR R3.1.2)

In AUTOSAR R4.0.*, ASCET declares the <MODE-DECLARATION-GROUP> in the <swc
name> appltypes.arxml file, AUTOSAR package ASCET types, sub-package
ApplicationDataTypes.

<LRE-PRCELAGE>
{SHGRT—HRHE}hSCET_Iypes(fSHGRT—HRHE}
<LR-PRCHRGES>
<LR-PRCELAGE>
<SHORT-HMAME=ApplicationDataTypes</SHORT-HAME>
<ELEMENTS>
<MODE-DECLARATION-GROUP>
< 5HORT-NAME>OnOf fMode< / SHORT -HAME >
<INITIAL-MCDE-REF DEST="MODE-DECLARATION":
SASCET Types/ApplicationDataTypes/0n0OffMode/off
</INITIAL-MODE-REF>
<MCODE-DECLARBTTIONS
<MCODE-DECLARATICN>
<SHORT-NAME»off«</SHORT-HAME>
</MODE-DECLARATICH>
<MODE-DECLARATICH>
<SHORT-MLAME>on</ SHORT-HLME:>
</MODE-DECLARATICN>
</MODE-DECLLRRATICHS>
< /MODE-DECLARATION-GROUE>

< /ELEMENTS>
</BR-FRCHLEE:
</BR-PRCKAGES>
</BR-FPRCHLEE>

Listing 30: ARXML code for a mode declaration group (AUTOSAR R4.0.2)
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To create a mode-switch interface:

Note
AUTOSAR R3.1.5 or lower allows more than one mode group per interface.

AUTOSAR R4.0.* allows only one mode group per interface.

= In the component manager, select Insert > AUTOSAR >
SenderReceiver Interface.

= Name the sender-receiver interface ModeInterface.
= Double-click on ModeInterface.

The "Sender Receiver Interface Editor for: Modelnterface" editor
opens.

= Select Insert > Component.
The "Select Item" window opens.

# "

4 Select Item...

(23]
1 Database (Filter: Interface, Enumeration, Mode_Group)
': ] Chapter_4 Types -
= K,LjChapter_E_Interfaces |
= U_j Interfaces B
. -

Figure 20: Selection of the mode group onOf fMode

= Inthe "1 Database" or "1 Workspace" field of the "Select Item"
window, select the mode group Onof fMode.

= Click OK to close the "Select Item" window and insert
OnOf fMode into ModeInterface.

The "Properties for Element: OnOffMode" window opens. You
can enter a name and a comment for the onof fMode instance.

= (Click OK to use the default name and comment.

[E SenderReceiver Interface Editor for: Modelnterface EI

File Edit View Insert Extras Tools Help

PSS LR O KRS e

free fans x E Elements | i Data I &, Implementation I EIJ.;l_E Layout| @ Elements - =
3 Database Mame Type MaxSize |Scopelkind — [Re: g
T MR - [ onoffviode | onOffvode [~ |local [variable|— | &
= [%. self::ModeInterface
— T — .
[E self B Data &. Impl

Figure 21: Mode-switch interface ModeInterface
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In AUTOSAR R3.1.5 or lower, the declaration of mode groups within a mode-switch interface
(i.e. a sender-receiver interface that contains a mode group) definition has the following
structure:

<SHORT-NAME>ModeInterface</SHORT-NAMES
<I5-5ERVICE>false</I5-SERVICE>
<MODE-GROUES>
<MODE-DECLARATION-GROUE-PROTOTYEE>
<5HORT-NLME>0nOf fMode</ SHORT-NAME>
<TYPE-TREF DEST="MODE-DECLARATION-GROUE">
/BSCET types/OnOffMode</TYFE-TREF>
</MODE-DECLARAT ICN-GROUP-PROTOTYERE>
</MODE-GROUES>

—_— T - e

</ SENDER-EECEIVEE-INTERFACEZX

Listing 31: ARXML code - declaration of mode group within sender-receiver interface
(AUTOSAR R3.1.2)

In AUTOSAR R4.0.%, the declaration of the mode group within a mode-switch interface
definition has the following structure:

<MCDE-SWITCH-INTERFACE>
<SHORT-MAME>R4 ModeInterface</SHORT-HAME>
<MCDE-GRCUE>
< SHORT-NAME>mode gronp<,SHORT-NAME>
<TYPE-TREF LDEST="MODE-DECLARATION-GROUP">
/ASCET Types/ApplicationDataTypes/0On0ffMode< /TYPE-TREF>
</ MODE-GROUEZ

< /MODE-SWITCH-INTERFACE>

Listing 32: ARXML code — declaration of mode group within mode-switch interface
(AUTOSAR R4.0.2)

In AUTOSAR R3.1.5 or lower, a mode group is defined using the <MODE-DECLARATION-
GROUP-PROTOTYPE> element, and all elements must be defined within an encapsulating
<MODE-GROUPS> element.

In AUTOSAR R4.0.*, a mode group is defined using the <MODE-GROUP> element.

Each <MODE-DECLARATION-GROUP-PROTOTYPE> / <MODE-GROUP> element must specify:
= the <SHORT-NAME> that you will use to refer to the item
» the <TYPE-TREF> reference to mode declaration group

The use of mode declaration prototypes within sender-receiver interfaces is considered in
detail in chapter 9, Modes, on page 134.

6.3 Client-Server

Client-server communication involves a component invoking a defined "server" function in
another component, which may or may not return a reply. Each client-server interface can
contain multiple operations, each of which can be invoked separately.

To create a client-server interface:

= In the component manager, select Insert > AUTOSAR >
ClientServer_Interface.

= Name the client-server interface cSInterface.
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When generating code in an AUTOSAR project, ASCET defines the <CLIENT-SERVER-
INTERFACE> element in the file Swe interfaces.arxml. The <CLIENT-SERVER-
INTERFACE> element has the following structure in the configuration language:

<CLIENT-SERVER-INTERFALCE>
<SHORT-NAME>CSInterface</SHORT-NAME:
<I5-5ERVICErfalse</I5-5ERVICE>
<OPERATICHS>

< /CPERATICHS >
</CLIENT-SERVER-INTERFACE>

Listing 33: ARXML code - client-server interface structure (all AUTOSAR versions)

A client-server interface is named using the <SHORT-NAME> element. The name is used
within other elements that need to reference the interface type.

The short-name of a client-server interface should be a valid C identifier.

A client-server interface consists of one or more operations defined using the
<OPERATIONS> container element.

Operations

An operation in a client-server interface can take zero or more parameters. The return value
of an operation is either of type std ReturnType or of an enumeration type, depending
on whether or not the operation returns an application error.

To create an operation:

= In the component manager, double-click on cSInterface.
The "Interface Editor for: CSInterface" editor opens.

= In the "Outline" tab, select the Main diagram.

= Select Insert > Method Signature.
An operation is added.

= Name the operation Maximumvalue.

To create arguments in an operation:

= Double-click the operation Maximumvalue.

The "Method Signature Editor for: MaximumValue" window
opens.

= Select Argument > Add and name the first argument InputAa.
Set:

— Argument Type: sdisc
— Direction: in

= Create a second argument InputB with the same type and
direction.

= Select Argument = Add and name the third argument
OutputMaximum. Set:

— Argument Type: sdisc
— Direction: out
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P "

E’f Method Signature Editor for: MaximumValue IEI
Argument  Return
Arguments | Return
*%" ) Inputa::sdisc Argument Properties
= (%] InputB::sdisc Argument Type
- ™ OutputMaximum::sdisc [sdisc -
Unit
Comment
Direction
Cut b
[ 0K ] [ Cancel ]

Figure 22: Arguments of the operation Maximumvalue

= Click OK.

ASCET represents the client-server interface CSInterface with
operation MaximumvValue and arguments Input?, InputB and
OutputMaximum as follows.

[f}} ClientServer Interface Editor for: CSlnterface EI@
File Edit View Insert Extras Tocols Help
FIEER e
free X | B eements |_e% Implementation | iF Layoutl HiE]
E Outine | [ Database Mame Type MaxSize |Scope Kind g
R ik Es | « v ) TnputaMaximumvalue| S sdisc - MaximumValue|Method A §
- ) TrputeMaximumyalue | S sdisc - MaximumValue (Method A
m. selfi:CSInterface . = -
= DMain |#] OutputMaximurm Maxin| § sdisc - MaximurnValue (Method A
I—E| ’ MaximumValue (InputA: :sdisc;InputB: | returnMaximumValue fﬁ Std_ReturnType|— MaximumValue|Return Ve
S [*] InputAssdise [In]
S ] Inputs::sdisc [In]
?[‘LJ QutputMaximum: :sdisc [Out]
[B [ return:std_ReturrType
4 m b < | mn 3
B- > &

Figure 23: Operation Maximumvalue for the client-server interface cSInterface

To create an implementation of an operation:

= In the "Interface Editor for: CSInterface" editor, go to the
"Implementation” tab.

= In the "Implementation" tab, double-click the Tnputa element.
The "Implementation for: InputA" window opens.
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= In the "Master" field, activate Implementation.
= In the "Implementation" field, select sint16.

= Right-click in the "Min" and "Max" fields and select Default
Value from the context menu.

= Close the "Implementation for: InputA" window with OK.

= Repeat the implementation procedure for the arguments InputB
and outputMaximum.

Interfaces

?QJ OutputMaximum::sdisc [Out]
B ) return::Std_ReturnType
1| I | 3

[L Clientserver Interface Editer for: CSlnterface E'@
File Edit View Insert Extras Tools Help
iR JE- YR
U * & Tmplementation | £F Layout i
Outli [ m
B outine | @ Database [Impl v] g
¥ A [de [O=
% 9 E‘—" = i Mame Type Impl. |Impl. |Impl. Farm &
Type |Min Max Bl
[I" W self::CSInterface 3 ]
5 dl‘t‘lain =] InputaMaximumValue % sdisc sint16(-32768|32757|1 |ident
|—E| T —h =] InputsMaximumyalue S sdisc sint16(-32768|32767 |1 |ident
?L'LJ InputA::sdisc [In] = OutputMaximum Maximumy ? sdisc sint16(-32768|32767 |1 |ident
I . —
5 |#J InputB::sdisc [In] | returnMaximumyalus [B std_ReturnType|—
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Figure 24: Implementation of the operation Maximumvalue

An implementation of a client-server interface in ASCET corresponds to a client-server
interface in AUTOSAR. The client-server interface in configuration language is generated by
ASCET in the Swc_interfaces.arxml file. The <OPERATIONS> element encapsulates
one or more <OPERATION-PROTOTYPE>! / <CLIENT-SERVER-OPERATION>? elements,
each of which defines a single operation in the client-server interface.

! AUTOSAR R3.1.5 or lower
2 AUTOSAR R4.0.*
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<CLIENT-SERVER-INTERFACE>
<SHORT-MNAME>CEInterfaoce<,/SHORT-NAME:>
<I5-5ERVICE>false</IS5-SERVICE:>
<OFERATICHNS>
<COFERRTICN-FROTOTYFE:>
<SHORT-NEME>MaximumWValne<,SHORT-HNAME>
<RBRGTMENTS>
<RARGUMENT-FROTOTYFE>
<SHORT-NEME>Inputh</SHORT-NEME:>
<TYFE-TREF DEZT="INTEGER-TYPE">/AUTOSAR types/SIntl6</TYFE-TREF>
<DIRECTICH>IN</DIRECTICH>
<« /BRGUMENT-PROTOTYPE >
<RARGUMENT-FROTOTYFE>
<SHORT-NAEME>InputB</SHORT-NAME:>
<TYPE-TREF DEZT="INTEGER-TYPE">/AUTOSAR types/SIntl6</TYFE-TREF>
<DIRECTICH>IN</DIRECTICH>
< /BRGUMENT-FPROTOTYPE >
<ARGUMENT-FROTOTYFE>
< SHORT-MAME>MaximomValne<  SHORT-HAME>
<TYPE-TREF DEZT="INTEGER-TYPE">»/AUTOSAR types/SIntl6</TYFE-TREF>
<DIRECTICN>OUT</DIRECTICH>
</BRGUMENT-FPROTOTYPE >
< /RRGUMENTS>
</OPERATICH-FROTOTYPE>
</OPERATICNS>
< /CLIENT-SERVER-INTERFACE:>

Listing 34: ARXML code — operation in a client-server interface (AUTOSAR R3.1.2)

<CLIENT-SERVER-INTERFACE>
<SHORT-NAME=CSInterface</SHORT-MLME>
<I5-5ERVICE>false</I5-5ERVICE>
<OPFERATICNS>
<CLIENT-SEEVER-COFERATICHN>
< SHORT-NAME >MaximuomValue<,/SHORT-HAME>
<ARGUMENTS>
<BRGUMENT-DATA-PRCTCOTYFE>
< SHORT-HAME > InputA</SHORT-NLME>
<TYPE-TREF DEST="APPLICATION-FRIMITIVE-DATA-TYPE">
JASCET Types/ApplicationDataTypes/SIntl6</TYFE-TREF>
<DIRECTION>IN«</DIRECTION>
< /LRREUMENT-DATL-PROTOTYEE>
<RRGIMENT-DATA-PROTCTYFE>
< SHORT-NAME>InputB</SHORT-NAME>
<TYFE-TREF DEST="APPLICATION-FRIMITIVE-DATA-TYPE">
JBSCET Types/ApplicationDataTypes/SIntlé</TYFE-TREF>
<DIRECTION>IN</DIRECTICN>
< /LRGUMENT-DATR-FROTOTYEE>
<ARGTHMENT-DATRA-PROTOTYFE>
<SHORT-NAME >OntpuntMaximom</ SHORT-HMAME>
<TYPFE-TREF DEST="APPLICATION-PFRIMITIVE-DATA-TYPE">
/ASCET Types/ApplicationDataTypes,/SIntl6</TYFE-TREF>
<DIRECTICH>0UT</DIRECTICH>
</BRGUMENT-DATA-PROTOTYPE>
< /LREUMENTS >
</CLIENT-SERVER-OFERLTICON>
< /OFPERATICHI>
</CLIENT-SERVER-INTERFLCE>

Listing 35: ARXML code — operation in a client-server interface (AUTOSAR R4.0.2)
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Each operation is named using the <SHORT-NAME> element. The name specified here will
form part of the name used by the RTE to refer to the operation in your code.

The <ARGUMENTS> element encapsulates one or more <ARGUMENT-PROTOTYPE>' /

<ARGUMENT-DATA-PROTOTYPE>? elements that define each argument (parameter) of the

operation.

Each <ARGUMENT-PROTOTYPE>/<ARGUMENT-DATA-PROTOTYPE> definition must define:
= the <SHORT-NAME> of the parameter

" a <TYPE-TREF> reference to the type of the parameter. The referenced type must
correspond to a defined type — see chapter 4, Data Types, on page 33

» the <DIRECTION> of the parameter as "IN" (read only), "ouT" (write only) or
"INOUT" (readable and writable by the component)

If nothing else is specified, operations in client-server interfaces return the RTE standard
return type std ReturnType. It is also possible to return an application error. This is done
by selecting a previously defined ASCET enumeration that contains all possible errors.

To create an enumeration with the possible errors in an application error:

= In the component manager, select Insert > Enumeration or
click on the Enumeration button.

= Name the enumeration ApplicationError.
= Select the enumeration and switch to the "Contents" pane.
= In the "Contents" pane, select the enumerator.

= Select Enumeration > Rename and set the label to
E_NOT OK.

=  Double-click on the value 0.

1Database = | 3 Contents
—E ] Chapter_5_Interfaces * (IWalue [Label
— @ [Jinterfaces 1 |E_MOT_oK
— fﬁ ApplicationError —
——— @ ARProject El
— fﬁ Enumeration
— [E,Swu: -

= Set the value to a number in the range 2. . 63.

Note

The value range for application errors is [2. . 63]. If the ASCET enumeration for the
application errors contains a value less than 2 or larger than 63, an error is issued during
code generation.

To assign an application error to the return value of an operation:

= In the component manager, choose the client-server interface
CSInterface and select Edit > Open Component or double-
click on csInterface.

The "Interface Editor for: CSInterface" editor opens.

= Create another operation (see page 71) and name it
Notification.

! AUTOSAR R3.1.5 or lower
2 AUTOSAR R4.0.*
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= Double-clik the operation Notification. The "Method
Signature Editor for: Notification" window opens.

= (o to the "Return" tab and open the "Return Type" combo box.

W
(1] v

Argurnent  Return

retur

Return Value

Properties

Return Type

<enumeration >
Std_ReturnType

Comment

YWrite for Referenced Element
Read for Referenced Element

o [ o=

Figure 25: Return type for the operation Notification

= Select <enumeration>.
The "Choose a enumeration type..." window opens.

= i[j Exercises

': ﬂChapter_‘l_Types El
=] {jchapter_ﬁ_lnterﬁces
L

= Select the enumeration ApplicationError.
= Click OK to close the "Choose a enumeration type..." window.

= Click OK to close the "Method Signature Editor for: Notification"

window.
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The operation Notification and the possible application errors in configuration language
are generated by ASCET in the Swc_interfaces.arxml file:

<CLIENT-SERVER-INTERFACE>
“SHORT-HLME>CEInterface« /SHORT-IHLME>
<I5-SERVICE>false«</I5-SERVICE>
<OPERATICHS>
<OPERATICH-PROTCTYFE>
< SHORT-NLME *MaximonWValne< / SHORT-IHLME >

</ OPERATICH-FROTOTIYEE:>
<COFERATICH-FRCOTCOTYFE>
<SHORT-HNAME=Notification< /SHORT-HAME »
CARGIMENTS»< /RARGIMENT S >
<POSS5IBELE-ERRCE-REFS>
<POS5IBELE-ERECE-EEF DEST="APPLICATION-ERROR" >
JASCET interfaces/Impl/CSInterface/E _NOT_OK
< /POSEIELE-ERROR-REF>
< /POSSIEZLE-ERRCR-REFS>
< /OPERATICH-PROTOTYPE>
< /OPERLATICHS>
<POSS5IELE-ERRCES™>
<BPPFLICATICH-ERRCR>
{SHGRT—HRHE}E_HDT_QRKfSHORT—HRHE}
<ERRCE-CODE>2+« /ERROE-CODE>
< /LPPFLICLATICH-ERROR>
< /POSSIZLE-ERRCRS>
</CLIENT-SERVER-INTERFLCE>

Listing 36: ARXML code - operation with possible application errors (AUTOSAR R3.1.2)
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<CLIENT-SEEVER-INTERFACEX
<SHORT-HAME>CSInterface«/SHORT-HNAME:-

oo Tt T T ocTTTTT

<I5S-SEEVICE>fal=se</I5-5SERVICE>

<CLIENT-S5EEVER-CPERATICH
< SHORT-HAME>MaximmmWValne«</ SHORT -HAME >

< /CLIEHN

B
<POSSIBLE-ERRCE-EEFS-
= -

</ POSSIBLE-ERRCE-EEF>
< /POSSIELE-ERRCE-EEFS5Z-
</CLIENT-SEEVER-CPERATICH>
</ OFERATICLS>

<POSSIBLE-ERRORS™>
<ARPPFLICATICH-ERRCE>
<SHORT-MAME>E NOT OK</SHORT-HAMEZ
ERROE-CODE>2</ CDE>

< /AFPLICATICH-ERROR>

&

ROE-COD

< /POSSIELE-ERRCRES>

< /CLIENT-S5EEVER-INTERFACE:

Listing 37: ARXML code - operation with possible application errors (AUTOSAR R4.0.2)

Note

Application errors are coded in the least significant 6 bits of Std ReturnType. The
value range for application errors is [2. . 63]. If the ASCET enumeration for the
application errors contains a value less than 2 or larger than 63, an error is issued during
code generation.

6.4 Calibration

Calibration interfaces are used for communication with Calibration components. Calibration
components are a kind of software component, which uniquely consist of calibration
information (parameters and characteristics).

Each calibration interface can contain multiple calibration parameters. A port of a software
component that requires an AUTOSAR calibration interface can independently access any of
the parameters defined in the interface by making an RTE API to the required port.
Calibration components provide the calibration interface and thus provide implementations
of the calibration parameters.

To create a calibration interface:

= In the component manager, select Insert > AUTOSAR >
Calibration Interface.

= Name the calibration interface calInterface.
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When generating code for an AUTOSAR project, ASCET defines a <CALPRM-INTERFACE>" /
<PARAMETER-INTERFACE>’ element in the file Swc_interfaces.arxml. The <CALPRM-
INTERFACE>/<PARAMETER-INTERFACE> element has the following structure in the
configuration language:

<CLALPEM-INTERFRCE>
<SHORT-NLME>CalInterface< /SHORT-HLME >
<I5-SERVICE»false</IS-SERVICE>
<CLLPRM-ELEMENT 5>
<CLLPEM-ELEMENT-FPROTCTYFE>

«/CALPREM-ELEMENT-PROTCTYPE>

< /CALPEM-ELEMENTS>
</CRLPEM-INTERFACE>

Listing 38: ARXML code - calibration interface structure (AUTOSAR R3.1.2)

<PARAMETER-INTERFACE>
<SHORT-NAME>CalInterface</SHORT-NAME>
<I5-5ERVICErfalse</I5-5ERVICE>
<PLELMETERS>
<PLEOMETER-DATA-PROTCTYPE>

</ PRRRMETER-DRTR-PROTCTYPE>
< /PRELMETERS>
</PREAMETER-INTERFACE>

Listing 39: ARXML code - calibration interface structure (AUTOSAR R4.0.2)

A calibration interface is named using the <SHORT-NAME> element. The name is used within
other elements that need to reference the interface type.

The short-name of a calibration interface should be a valid C identifier.

A calibration interface consists of one or more calibration elements defined using the
<CALPRM-ELEMENTS>! / <PARAMETER-DATA-PROTOTYPE>? container element.

6.4.1 Calibration Parameters

To create a calibration parameter:

= In the component manager, double-click on CalInterface.
The "Calibration Interface Editor for: Callnterface" editor opens.
ﬂ = Use the Logic Parameter button to create a logic parameter.
The dialog "Properties for Scalar Element: log" window opens.
= Name the parameter calpParaml.
= Create another logic parameter and nhame it CalParam?2.

ﬂ = "Use the Unsigned Discrete Parameter" button to create an
unsigned discrete parameter.

! AUTOSAR R3.1.5 or lower
2 AUTOSAR R4.0.*
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The "Properties for Scalar Element: udisc" window opens.
Name the parameter CalParam3.

To create an implementation of a calibration parameter:

In the "Calibration Interface Editor for: Callnterface" editor, go to
the "Implementation” tab.

In the "Implementation" tab, double-click the calpParam3

element.

The "Implementation for: CalParam3" dialog opens.
In the "Master" area, activate Model.
In the "Model" area, enter the value 24 in the "Max" field.

Click OK.

The Implementation tab of the "Calibration Interface Editor
for: Callnterface" editor shall look like the figure below.

ﬁ:, Calibration Interface Editor for Callnterface

[=llE]==

File Edit Wiew Insert BExtras Tools Help
P & [
Tree Pane = IEE Eemeat= I o Data| ;% Implementation EIJ_;} Layout ﬁ
# outine | @ Database lImpI 'l 3
) =
A [Odh [O=
B % I?11]'_“1 " v Mame Type Impl. {Impl. {Impl.|Q |Formula | Limit to 1 i
Type|Min [Max bit lengt [~
= ﬁ;-‘ self::Callnterface s P szI a 1 1 lident 2
T @ calParam1::log | J; b -
T-‘ CalParam?::log @ CalParam2| "L log |boal J0 : L |ident
"0 calParam3:udise ) calraram3|'D udisc|unt3|0 |24 |1 |ident Mo
4| 1 |

? CalParam1

B false

(% Phys: Impl: bool

Figure 26: Implementation Imp1 of the calibration interface CalInterface

An implementation of a calibration interface in ASCET corresponds to a calibration interface
in AUTOSAR. The calibration interface in configuration language is generated by ASCET in
the swe_interfaces.arxml file. The declaration of calibration elements within a

calibration interface definition has the following structure:
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<CALPEM-TNTERFLCE>
< SHORT-NAME>CalInterface</SHORT-NAME >
<IS-5ERVICE>false«/I5-SERVICE>
<CALPRM-ELEMENTS>
<CALLPEM-ELEMENT-PROTOTYFE>
<SHORT-MRME>CalParaml</SHORT-HAME:>
<SW-DATR-DEF-FROPS>
<SW-CRLIBRATICH-LACCESS>READ-WRITE<,/SW-CLLISRATICH-LCCESS>
</ 5W-DLTL-DEF-FROFS>
<TYPE-TREF :EST=”BDDLEAN—TYPE“>fAUTOSAR_ﬁypESIBGOIEan(fTYPE—TREF>
</CLLPFEM-ELEMENT-FROTCTYEE>
<CALPRM-ELEMENT-PROTCTYPE>
<SHCORT-NAME>CalParam2<,/ SHORT-HLME >
<SW-DATR-DEF-FROFPS>
<SW-CRLIBRATICH-ACCESS>READ-WRITE</ SW-CLRLIBRATICH-LACCESS>
</5W-DLTL-DEF-FROES>
<TYPE-TREF :EST=”BDDLEAN—TYPE“}fAUTDSAE_typESEEGOIEEH(ITYFE—TREFb
</ CRLFREM-ELEMENT-FROTOTYFE>
<CALPRM-ELEMENT-FRCICTYFPE>
<SHORT-MARME>CalParam3<,/ SHORT-HAME>
<SW-DATA-DEF-FROPS>
<SW-CRLIBRATION-ACCESS>READ-WRITE</ SW-CALIBRATICON-ACCESS>
</ 53W-DLRTL-DEF-FROES>
<TYPE-TREF DEST="INTEGER-TYFPE">
JASCET types/artificial /ASCET Scalar UInt8 ident pOp24</TYFE-TREF:
< /CRLPEM-ELEMENT-PROTOTYFE>
< /CLLPRM-ELEMENTS>
</CLLPEM-INTERFLCE>

Listing 40: ARXML code - declaration of calibration elements within a calibration interface
definition (AUTOSAR R3.1.2)
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<PRARAMETER-INIERFACE>
<SHORT-MLAME>CalInterface</SHORT-HMAME>
<I5-5ERVICE>fal=se</I5-5ERVICE>
<PRERMETERS>
<PLELMETER-DATL-PROTOTYFE>
<SHCORT-NAME>CalParaml<,/SHORT-HNAME >
<SW-DATR-DEF-FROPS>
<SW-DRTL-DEF-FROPS-VAEIANTS>
<SW-DATA-DEF-PRCOPS-CONDITICHAL>
<SW-ADDR-METHCOD-REF DEST="SW-ADDR-METHOD" >
thCET_ﬂﬂdrMEthDdsfCAL_MEMCfSW—EDDR—HETHGD—REF>
<SW-CLLIBRATICH-LCCESS>READ-WRITE</SW-CLRLIBRATICH-LCCESS>
<5W-IMFL-FOLICY>STANDARD <,/ SW-IMFL-FOLICY >
</ EW-DATA-DEF-PROPS-CONDITICNAL>
</5W-DARTL-DEF-PROPS-VLARILNTS>
</ 5W-DLTL-DEF-FROFS>
<TYPE-TREF DEST="APPLICATION-PRIMITIVE-DATA-TYPE">
JASCET Types/ApplicationDataTypes/Boolean</TYPE-TREF:
< /PLELMETER-DLTR-FROTOTYFE>
<PRARAMETER-DATA-PROTICTYPE>
<S5HORT-NEME>Cal Param2<,/ SHORT-NLME >

</PLRLMETER-DATL-FROTCOTYFE>
<PLELMETER-DATL-PROTOTYFE>
<SHCORT-NAME>CalParam3<,/ SHORT-HNLME >
<SW-DATR-DEF-FROPS>
<SW-DRTL-DEF-FROPS-VAEIANTS>
<SW-DATA-DEF-PRCOPS-CONDITICHAL>
< SW-ADDE-METHOD-REF DEST="S5W-ADDR-METHOD" >
EASEET_AddrMEthodsfﬂhL_MEM(fSW—EDDR—HETHGD—REF>
<SW-CLLIBRATICH-LCCESS>READ-WRITE</SW-CLRLIEBRATICHN-LCCESS:
< 5W-IMFL-FOLICY >SS TANDARD <,/ SW-IMFL-FOLICY >
</ BW-DATA-DEF-PROPS-CONDITICHAL>
</5W-DARTL-DEF-PROPS-VLARILNTS>
</ 5W-DLTL-DEF-FROFS>
<TYPE-TREF LDEST="APPLICATION-PRIMITIVE-DATA-TYPE">
/ASCET_Types/ApplicationDataTypes/UInt8_ident p0 p24</TYPE-TREF>
< /PRRAMETER-DATA-PROTOTYFE>
</PLRRMETERS>
< /PLERAMETER-TIHNTERFACE>

Listing 41: ARXML code - declaration of calibration elements within a calibration interface
definition (AUTOSAR R4.0.2)

A calibration element is defined using the <CALPRM-ELEMENT-PROTOTYPE>" /
<PARAMETER-DATA-PROTOTYPE>? element and all elements must be defined within an
encapsulating <CALPRM-ELEMENTS>! / <PARAMETERS>? element.
Each <CALPRM-ELEMENT-PROTOTYPE>/<PARAMETER-DATA-PROTOTYPE> element must
specify:

= the <SHORT-NAME> that you will use to refer to the item

» the <sW-DATA-DEF-PROPS> data properties, among them

- the <Ccalibration-ACESS>
" a<TYPE-TREF> reference to the type of the data item

! AUTOSAR R3.1.5 or lower
2 AUTOSAR R4.0.*
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6.5 NVData (AUTOSAR R4.0.* only)

AUTOSAR R4.0 introduced the <NV-DATA-INTERFACE> element, which defines an
interface used by an Nv-block software component type (see ...).

Note

NVData interfaces cannot be used in ASCET projects that use AUTOSAR R3.1.5 or lower.
If you try, an error message is issued during code generation.

Each NVData interface may contain multiple NVData elements, which can be sent and
received independently.

To create an NVData interface:

= Create a project named R4 project (page 23) and set the code
generation settings for AUTOSAR R4.0.2 (page 23).

= Create a software component named swc (page 26) and insert it
into R4 project (page 26).
= Open R4 project, then open swc.

= In the component manager, select Insert > AUTOSAR >
NVData Interface.

= Name the NVData interface NvData Interface.
= Insert NVData Interface into SwcC.

When generating code for an AUTOSAR project, ASCET defines an <NVDATA-INTERFACE>
element in the file Swc_interfaces.arxml. The <NVDATA-INTERFACE> element has
the following structure in the configuration language:

<AE-PRACHFRGE>
<SHORT-NRMEXASCET Interfaces</SHORT-NAME:
<AR-PRACHAGES>
«RE-PLCFRGE>
<SHORT-NA4ME>Tmpl<,/SHORT-HAME >

<ELEMENT Sz

WV -DATL- INTERFLCE > T
<SHORT-NAME>NVData Interface</SHORT-NAMES
<IS-SERVICE>false<,/I5-SERVICE>

< NV-DATLS>
MEEfH?—DR?E—:H?ERFECE} J,J

JSELEMENT Sz

Listing 42: ARXML code - calibration interface structure (AUTOSAR R4.0.2)

The name of the NVData interface definition is given by the <sHORT-NAME> element. The
name is used within other elements that need to reference the interface type, for example a
software component may specify that it uses NVData interface NvData interface.

The short-name of an NVData interface should be a valid C identifier.
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An NVData interface can be used to communicate non-volatile data using NVData elements,
i.e. variable data prototypes, within the <NvV-DATAS> element).

Variable Data Prototypes

Each NVData interface can specify zero or more NVData elements, or variable data
prototypes, which constitute the AUTOSAR signals communicated over the interface. Each
data element defines a prototype of a specific type and can be a primitive data type, a
RECORD Or an ARRAY type. See chapter 4, Data Types, on page 33 for details of defining
data types.

To set up an NVData element in ASCET:

= In the "Software Component Editor for: R4_SWC" window,
double-click on NvData Interface.

NvData Interface opens in the NVData interface editor.
= Create an sdisc element named Speed NV, as described on page

64.
= Create the same implementation for Speed NV as described on
page 64.
fr. MVData Interface Editor for NVData_Interface EI@
File Edit View Insert Extras Tools Help
i LS
Tree Pane * |E Elements -
i outine | 3 patabase z
- & E= &
.'é 5’2 E’.‘l ® v Mame Type Impl. |Impl. |Impl. |Q|Formula|Limit:| ™
Type |Min Max bit ler
- *S sdisc|sint16(-32768|32767 |1 |ident  |Auto
?. Speed_MNV:isdisc & Speed NV|'S sdisc|sin oen .
4 | m | ¥
fr. self B Data .:% Impl

Figure 27: NVData element Speed NV of the NVData interface NvData Interface with
implementation Tmp1l

An implementation of an NVData interface in ASCET corresponds to an NVData interface in
AUTOSAR. The NVData interface in configuration language is generated by ASCET in the file
Swc_interfaces.arxml. The declaration of NVData elements within an NVData interface
definition has the following structure:
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<NV-DATA-INTERFACE>
<SHORT-NAME>NVData Interface<,SHORT-NAME>
<IS-SERVICE>false</IS-SERVICE>
<NV-DATRS>
~~ <VARIRSLE-DATA-PROTOTYPE> “““\
<SHORT-NAME>speed nv</SHORT-NAME>
<SW-DATA-DEF-FROES>
<SW-DATA-DEF-PROPS—VARIANTS>
<SW-DATA-DEF-PROPS—CONDITIONAL>
<SW-ADDR-METHOD-REF DEST="SW-ADDR-METHOD">
/ASCET AddrMethods/RAM</SW-ADDE-METHOD-REE>
<SW-CALIBRATION-ACCESS>READ-ONLY
</ SW-CALIBRATION-ACCESS>
£SH-IMPL-POLICY>STANDARD</ SW-IMPL-POLICY>
</ SW-DATA-DEF-PROPS—CONDITIONAL>
</ SW-DATA-DEF-PROPS—VARIZNTS>
</ SW-DATA-DEF-FPROES>
<TYPE-TREF DEST="APPLICATION-PRIMITIVE-DATA-TYPE">
/ASCET Types/ApplicationDataTypes/SIntlé</TYPE-TREF>
‘. </VARIABLE-DATA-PROTOTYPE>
</NV-DATLS>
< /NV-DATA-INTERFACE>

Listing 43: ARXML code - declaration of NVData elements within NVData interface
(AUTOSAR R4.0.2)

An NVData element is defined using the <VARIABLE-DATA-PROTOTYPE> element, and all

elements must be defined within an encapsulating <NV-DATAS> element.

Each <VARIABLE-DATA-PROTOTYPE> element must specify:
» the <SHORT-NAME> that you will use to refer to the item
= the <SW-DATA-DEF-PROPS> data properties, among them

— the <SW-ADDR-METHOD-REF>
— the <SW-CALIBRATION-ACESS>
— the <SW-IMPL-POLICY>
" a<TYPE-TREF> reference to the type of the data item
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Software Component Types

A software component is the atomic software unit of application in AUTOSAR. Software
components interact through ports, which are typed interfaces. The interfaces control what
can be communicated and the semantics of the communication.

To create an AUTOSAR software component:

= In the component manager, select Insert > AUTOSAR >
Software Component.

= Name the software component Swc.

= Follow the steps described in section 3.1.2, Code Generation
Settings for AUTOSAR, on page 22 to create an AUTOSAR project
ARProject and set the AUTOSAR code generation settings.

= Insert the software component swc in the project, as described
on page 26.

To open a software component in an AUTOSAR project:

= In the component manager, double-click the ARProject project.
The project editor window opens.

= In the "Outline" tab of the project editor, double-click the swc
software component.

The software component editor window opens.
Each software component must have its component type declared in the RTE generator's
configuration. The component type makes the component available for composition into a

larger software system. An application software component type is defined using the
<APPLICATION-SOFTWARE-COMPONENT-TYPE> element in the <swc name>.arxml file.

<APPLICATICH-SCFIWARE-CCHPCOHNENT-TYFE>
<SHORT-MAME=SWC< /SHORT-HAME™
<PORTS>

</PORTS>
</BPPLICATION-SOFTWARE-COMPONENT-TYFE>
Listing 44: ARXML code — definition of application software component type (AUTOSAR
R3.1.2)
<LPPLICATION-SW-COMPONENT-TYFE>

<5SHORT-HNAME=SWC< /SHORT-HAME >

</ APPLICATICH-SW-CCHPCHENT-TYFE:>

Listing 45: ARXML code — definition of application software component type (AUTOSAR
R4.0.2)

The software component type must be named using the <SHORT-NAME> element. The
name must be system-wide unique; it is used within other elements to reference the
software component type.

The short-name of a software-component should be a valid C identifier.
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Ports

Ports provide the software component access to the interface. There are two classes of
ports: provided ports (Pports) and required ports (Rports).

The ports of a software component are defined within the <PORTS> element.

<PORIS>
<RE-FORT-FROTCTYFE>

<ER;ééRT—PRGTGTYPE>
;ELPGRT—PRGTGTYPE>
<EP;ééRT—PRGTGTYPE>
<IFéﬁéS>
Listing 46: ARXML code — port definition structure (all AUTOSAR versions)

Within the <PORTS> element, the <P-PORT-PROTOTYPE> and the <R-PORT-PROTOTYPE>
elements are used to define provided and required ports respectively. When two
components communicate then typically both provided and required ports reference the
same interface definition. This guarantees that they are compatible.

Provided Ports

‘Pports are used by a software component to provide data or services to other software
components. Provided ports implement senders and servers.
To create a sender port:

= In the "Software Component Editor for: Swc", select Insert >
Component.

The "Select item..." window opens.

= Inthe "1 Database" or "1 Workspace" field of the "Select Item"
window, select the interface srRInterface and click OK.

-

1 Select Itern... @
1 Database (Filter: Data_Interface, ClientServer_Interface, Enumeration, Record, Compaonent)
I—El -] Chapter_&_Ports -~
I—IH il Interfaces
— [F;_;CSInterface
s SRInterface -
2 Comment

Figure 28: Selection of the item SRInterface

The "Properties for complex element: SRInterface" window open.

= Name the Port sender, activate Provided in the "Internal
Access" area and click OK.
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General

Mame Sender
Unit

Comment

Interpolation

Kind L |Vanable

Basic Type

Complex

[% Properties for Complex Element: Sender

Component SRInterface (Exercises\Chapter 6_Ports\Interfaces) =

¥ Reference

Scope
B @ Local Imported Exported
Attributes External Access

Set() Method

Yirtual Get() Method
o Dependent Internal Access
" | Maon-Volatile Provided
Variants Dﬁequired
Calibration Access
Write
Read
Alwa}rs Show Editor for new Elements [ 0] 4 ] [ Cancel

Figure 29: Provided port sender of type SRInterface

Drag the element Sender: : SRInterface from the "Outline"
tab and drop it on the drawing area of the software component

editor.

The Pport sender with element speed appears in the drawing

area as follows.

Figure 30: Pport sender in the drawing area of the software component editor
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A provided port within a software component type definition is named using the <SHORT-
NAME> element. The name is used within other elements to reference the software
component type. The short-name of a provided port must be a valid C identifier.

Each provided port definition must specify the interface type over which it will communicate
with other ports. This is done in the <swc name>.arxml file, using the <PROVIDED-
INTERFACE-TREF> element. This <PROVIDED-INTERFACE-TREF> element must identify
the required interface.

<LR-PLCOCEAGE
<SHORT-NREME-ASCET swoomponents</SHORT-INAME>
<DESC></DESC>
<SUB-PRCEAGES>
<BR-PLCELEE>
< SHORT-NAME >Impl</SHORT-HAME >
<DESC></DESC>
<ELEMENTS>
<APPLICATICH-SCFTWARE-COMPCOHENT-TYPE=
<SHORT-NAME>Swo< /SHORT-HNAME >
<PORIS>
<P-FORT-PRCTCOIYFE>
<SHCRT-NAME»Sender<,/SHORT -HMAME>
<PRCVIDED-INTERFACE-TREF CEST="SENDER-RECEIVER-INTERFACE">
fASCET_interfaces/Impl/SRInterface
</FPROVIDED-INTERFACE-TREF>
</ F-FORT-FROTCTIYFE>
</ PORIS>

</RPFLICATICHN-SOFTWARE-COMPONENT-TYPE>

0
=

Listing 47: ARXML code — provided port Sender definition (AUTOSAR R3.1.2)

In addition, AUTOSAR R4.0.* requires the <PROVIDED-COM-SPECS> element that contains
details about individual data elements, e.qg.,

= <DATA-ELEMENT-REF> - which identifies the data element,
» <INIT-VALUE> - which specifies the initial value of the data element,
and others.
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<SHORT—HEME>ASCET_EomponentTypes<KSHORT—HAME>

<ELEMENTS>

<RPFPLICATICH-SW-COMPONENT-TYPE>
<SHORT-NRME>R4 SWC</SHORT-NEME>
<PFORTS>

/’?EtPORT—PRGTGTYPE} _EH“\

<SHORT-NAME>Sender</SHORT-NAME>
<PRCVIDED-COM-SPECS>
<HONQUEUED-SENDER-CCHM-SPEC>
<DATL-ELEMENT-REF DEST="VARTABRLE-DATA-PROTOTYPE">
JASCET_Interfaces/Impl/SRInterface/Speed</DRTA-ELEMENT-REF>
<INIT-VALUE>
<HNUMERICAL-VALUE-SPECIFICATION>
<VALUE>D</VALUE>
< /NUMERICAL-VALUE-SPECIFICATICN>
</ INIT-VALUE>
</ HOHNQUETED-SENDER-COM-SFEC>
</ PROVIDED-COM-SFPECS>
<PROCVIDED-INTERFACE-TREF LDEST="SEMNDER-RECEIVER-INTERFACE":»
JASCET Interfaces/Impl/SRInterface</PROVIDED-INTERFACE-TREE>

\agif—PGRT—PRGTOTYPE>
</BPORTE>

</BRPPFLICRTICN-SW-CCMFCONENT-TYFE>

</ELEMENTS>

«/RR-PRCHRGE>

Listing 48: ARXML code — provided port Ssender definition (AUTOSAR R4.0.2)

To create a server port:

= In the "Software Component Editor for: Swc", select Insert >
Component.

The "Select item..." window opens.

= 1Inthe "1 Database" or "1 Workspace" field of the "Select Item'
window, select the interface csInterface and click OK.

The "Properties for complex element: CSInterface" opens.

= Name the Port "server", activate Provided in the "Internal
Access" area and click OK.
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"

General

Mame Server
Unit

Comment

Interpolation

[i?_p Properties for Complex Element: Server

Kind L |Varnable
Basic Type
Complex
Component Cslnterface (Exercises\Chapter_&6_Ports\Interfaces, =
Scope
B @ Local Imported Exported
Attributes External Access
| ¥ Reference Set() Method
Yirtual Get() Method
o Dependent Internal Access
e Maon-Yolatile [7] Provided
Variants Dﬁequired
Calibration fccess
Write
Read
Alwa}rs Show Editor for new Elements I 0] 4 H Cancel

Figure 31: Provided port server of type CSInterface
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Then, ASCET creates the following items:
a server node named Server: :CSInterface under the

folder "Realized Interfaces",

a diagram Server CSInterface, and

a server runnable for each operation in the client-server
interface csInterface. In the screenshot below, ASCET
creates the runnables Server MaximumvValue and

Server Notification.
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@ Outline |'-_'T Mavigation | @ Datsbase
THET = -
= (%, [ self:swe
o+ [l SRInterface::SRInterface
B [_P;JREﬂliZEd Interfaces
e
': I;_]'I"«"Iaximum'l.-'al|_|E (InputA::sdisc; Inputh: isdisc; QutputMaximurm: :sdisc) return::5td_ReturnType
:_}N::uﬁﬁcaﬁcun (0 return::ApplicationErrar
EBE?FHM
= ﬂSErver_CSInterfacE
=] @Server_l"«"laximumvalue (InputA::sdisc;Inputd: :sdisc; OutputMaximum: :sdisc)
— ?.1] InputA::sdisc [In]
— ?Lij InputB::sdisc [In]
— ?.1] QutputMaximum: :sdisc [Cut]
[=l @Server_NDﬁﬁcaﬁnn () return:: ApplicationError
? | return::ApplicationError

Figure 32: Pport Server in the "Outline" tab of the software component swc

The entry function of the server runnable has a return type of void or std _ReturnType,
depending on whether or not the server returns an application error.

The provided port must specify the interface type over which it will communicate with other
ports using the <PROVIDED-INTERFACE-TREF>. ThiS <PROVIDED-INTERFACE-TREF>
element must identify the required interface.

<F-FCORT-FRCTCTYFE>
< SHORT-HMAME=Server</SHORT-LHLME>
<PRCVIDED-INTERFLCE-TREF DEST="CLIENT-SERVER-INTERFACE">
JASCET interfaces/Impl/CSInterface
< /PROVIDED-INTERFACE-TREF>
</P-PORT-PROTOTYPE>

Listing 49: ARXML code — provided port server definition (all AUTOSAR versions)

Furthermore, ASCET provides additional information to the internal behavior of the software
component swc. On the one hand, one operation-invoked event is created for each
operation in the server port. On the other hand, a runnable entity is created for each
operation in the server port. Refer to chapter 8, Internal Behavior, on page 100 for more
detailed information.

Note

A client-server interface might be edited once a server is inserted in a software
component. In this case, the user must update the server interface in the software
component using the menu option Build > Update Interfaces.

Required Ports

Rports are used by a software component to require data or services from other software
components. Required ports implement receivers and clients.

The definition of a required port is identical to that of a provided port, with the exception
that the <R-PORT-PROTOTYPE> element is used.
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To create a receiver port:

In the "Software Component Editor for: Swc", select Insert 2>
Component.

The "Select item..." window opens.

In the "1 Database" or "1 Workspace" field of the "Select Item"
window, select the interface SRInterface and click OK.

The "Properties for complex element: SRInterface" window
opens.

Name the Port Receiver, activate "Required" in the "Internal
Access" area and click OK.

r

Interpolation

Kind L Variable

Basic Type

Complex

mﬂ Properties for Complex Element: Receiver @
General
Mame Receiver
Unit
Comment

Component SRInterface (Exercises\Chapter_6_Ports\Interfaces) -

| % Reference

Scope
B @ Local Imported Exported
Attributes External Access

o Virtual Get() Method
2 R Internal Access
o Mon-Yolatile [ Provided
Varnants Required
Calibration Access
Write
Fead
[¥] Always Show Editor for new Elements [ Ok ] [ Cancel

Set() Method

Figure 33: Required port
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Receiver Of type SRInterface

Drag the element Receiver: :SRInterface from the "Outline"
tab and drop it on the drawing area of the software component
editor.

The Rport Receiver with element speed appears in the
drawing area as follows.
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SRInterface

M Speed r—

Figure 34: Rport Receiver in the drawing area of the software component editor

A required port within a software component type definition is named using the <SHORT-
NAME> element. The name is used within other elements to reference the software
component type. The short-name of a required port must be a valid C identifier.

The required port definition must reference an interface definition defined using the
<REQUIRED-INTERFACE-TREF> element:

<R-FCORT-FRCTCTYFE>
< SHORT-HAME>Receiver</SHORT-HAME >
T{E:J:RTE—_“I_L-{Fh”:E—:':{T DEET="SENDER-RECEIVEER-INTERFACE" >
JASCET interfaces,/Impl/SRInterface
</REQUIRED-INTERFACE-TREF>
</BE-PORT-FRCOCTCOTYFE>

Listing 50: ARXML code — required port Receiver definition (AUTOSAR R3.1.2)

In addition, AUTOSAR R4.0.* requires the <REQUIRED-COM-SPECS> element that contains

details about individual data elements, e.g.,
* <DATA-ELEMENT-REF> - which identifies the data element,
* <INIT-VALUE> - which specifies the initial value of the data element,

and others.

<RE-FPORT-FROTCOTYFE>

<SHCORT-HAME>Receiver</SHORT-HNLME>
<REQUIRED-CCHM-SFECS>
<HCOHNQUEUED-RECEIVER-CCM-S5PEC
<DATA-ELEMENT-REF DEZT="VARIABLE-DATA-PROTOTYFPE":-

JASCET Interfaces/Impl/SRInterface/Speed</DRTL-ELEMENT-REF:>

<IHIT-VALUE:>
<HIMERICAL-VALIUE-SFECIFICATICH>
<VALIOE>D</VALIE>
</HIMERTCAL-VALUE-SPFECIFICATICH
</ INIT-VALUE>
</ HOHQUEUED-RECEIVER-CCM-SFEC™
</BREQUIRED-CCHM-SFECS>
<REQUIRED-INTERFACE-TREF LDEST="SENDER-RECEIVER-THNTERFACE":>
/ASCET Interfaces/Impl/SRInterface</REQUIRED-INTERFACE-TREF>
</BE-PORT-FRCOTCTYFE>

Listing 51: ARXML code — required port Receiver definition (AUTOSAR R4.0.2)
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In the "Software Component Editor for: Swc", select Insert >
Component.

The "Select item..." window opens.

In the "1 Database" or "1 Workspace" field of the "Select Item"
window, select the interface cSInterface and click OK.

The "Properties for complex element: CSInterface" open.

Name the Port "c1ient", activate "Required" in the "Internal
Access” area and click OK.

Fo

-

Interpolation

Kind lll |Variable

Basic Type

Complex

[f?_]. Properties for Complex Element: Client
General
Mame Client
Unit
Comment

Component Cilnterface (Solutions\Chapter_&_Ports\Interfaces -

|| Reference

Scope
B @ Local Imported Exported
Attributes External Access

Yirtual Get() Method
2 Lot =i Internal Access
[ | Mon-Yolatile 7] Provided
Vanants Required
Calibration Access
Write
Fead
Always Show Editor for new Elements [ 0K ] [ Cancel

Set() Method

Figure 35: Required port Client of type CSInterface
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Drag the element Client: :CSInterface from the "Outline”
tab and drop it on the drawing area of the software component
editor.

If necessary, activate flexible layout for the interface
CSInterface:

— Go to the component manager.
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— Inthe "1 Database" or "1 Workspace" pane, right-click
CSInterface and select Flexible Class Layout = Activate
from the context menu.

— In the "Change Flexible Class Layout State" window, select
CSInterface and click OK.

= In the drawing area, right-click the c1ient port and select
Ports = Methods from the context menu.

The "Port Editor<CSInterface>" window opens.
= Deactivate the method Notification and click OK.

Ef;jf Port Editor< CSInterface> \EI
Paort Settings

= M Public Select All

U MaximumValue {InputA::sdisc;InputB::sdisc; QutputMaximum: :sdisc) return::Std_ReturnType [—-\
D - Notification () return::ApplicationErro Deselect Al

Default

oK ] [ Cance| l

Figure 36: Port editor window to select/deselect methods

= Resize the client block and reposition the pins.

The Rport client with operation Maximumvalue appears as
follows (or similar) in the drawing area.

r
- —# Inpukd C5Inkerface Cee
- —# InputB S
. []-i Maximumyalue — - -
- —A OukpukMazxinnarn

Figure 37: Rport c1lient in the drawing area of the software component editor

The required port definition must reference an interface definition defined using the
<REQUIRED-INTERFACE-TREF> element:

<R-FCRI-FRCTCTYFE>
«SHORT-HMRME>Client«/SHORT-N&ZME>
<REQUIRED-INTERFLCE-TREF DEST="CLIENT-SERVER-INTERFACE">
JASCET interfaces/Impl/CSInterface
< /REQUIRED-INTERFLCE-TREF>
</R-PORT-PROTOTYPE>

Listing 52: ARXML code — required port client definition (all AUTOSAR versions)

To create a calibration port:

= In the "Software Component Editor for: Swc", select Insert >
Component.

The "Select item..." window opens.

= Inthe "1 Database" or "1 Workspace" field of the "Select Item"
window, select the interface calInterface and click OK.

The "Properties for complex element: Callnterface" window
opens.
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= Name the Port calibration and click OK.
The "Internal Access" is set to Required; it cannot be changed.

= Drag the element Calibration::CalInterface from the
"QOutline" tab and drop it on the drawing area of the software
component editor.

The Rport Receiver with elements calparaml, CalParam2 and
CalParam3 appears in the drawing area as follows.

e

Callnterface

bl

CalParaml p—
CalParam?2 p—
CalParam3 p—

Calibration <Data=

Figure 38: Rport calibration in the drawing area of the software component editor

The required port definition must reference an interface definition defined using the
<REQUIRED-INTERFACE-TREF> element:

<R-FCORT-FROTCTYFE>
«SHORT-HMEME>Calibration</SHORT-HLME>
<REQUIRED-INTERFACE-TREF LDEST="CALPRM-TINTERFACE">
FASCET_interfaces/Impl/Callnterface</REQUIRED-INTERFACE-TREF>
< /RE-FORT-FROTOTYFE>

Listing 53: ARXML code — required port Calibration definition (AUTOSAR R3.1.2)

In addition, AUTOSAR R4.0.* requires the <REQUIRED-COM-SPECS> element that contains
one <PARAMETER-REQUIRE-COM-SPEC> element for each parameter interface with details
about the respective parameter, e.g.,

* <PARAMETER-REF> - which identifies the parameter,

* <INIT-VALUE> - which specifies the initial value of the parameter,

and others.

<RE—-PORT-PROTOTYFPE>
<SHORT-MLME>Calibration</SHORT-HAME>
<REQUIRED-COM-SPECS>
<PRELMETER-REQUIRE-COM-SFEC™
<INIT-VALUE:>
<HMIHMERICAL-VRLUE-SFECIFICATION>
<VLLUE>FALSE</VLLUE>
< /NUMERICAL-VLLUE-SPECIFICATICON>
</INIT-VLLUE>
<PAERMETEER-EEF DEST="PARAMETER-DATA-FPROTOTYFE">
JASCET Interfaces/Impl/CalIlnterface/CalParaml</FRERMETER-REF>
< /PLELRMETER-REQUIRE-COM-SFEC>

</REQUIRED-COM-SFECS>

<REQUIRED-INTERFLCE-TEEF DEST="PARAMETER-INTERFACE">

JASCET Interfaces/Impl/CalInterface</REQUIRED-INTERFRCE-TREF>
< /R-FORT-FROTCTYEE>

Listing 54: ARXML code — required port Calibration definition (AUTOSAR R4.0.2)
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To create an NVData port:

Note

NVData interfaces and ports are only available in AUTOSAR R4.0.*,

MyData_Interface

bl

Speed_MV p—

MYData MY

In the "Software Component Editor for: Swc", select Insert >
Component.

The "Select item..." window opens.

In the "1 Database" or "1 Workspace" field of the "Select Item"
window, select the interface NvData Interface and click OK.

The "Properties for complex element: NVData_Interface" window
opens.

Name the Port NvData and click OK.

The "Internal Access" is set to Required; it cannot be
changed.

Drag the element NVData: :NVData Interface from the
"Outline" tab and drop it on the drawing area of the software
component editor.

The Rport NvData with element speed NV appears in the
drawing area as follows.

Figure 39: Rport NvData in the drawing area of the software component editor

AUTOSAR R4.0.* requires the <REQUIRED-COM-SPECS> element that contains one <NV-
REQUIRE-COM-SPEC> element for each NVData element with details about the respective

NVData element, e.g.,

" <VARIABLE-REF> -

which identifies the NVData element,

*» <INIT-VALUE> - which specifies the initial value of the NVData element,

and others.

ASCET V6.2 AUTOSAR User’s Guide
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<RE-PORT-FROTOTYPE>
<SHORT-NRME=NVData<,/SHORT-HNLME>
<REQUIRED-COM-SFECS>
<NV-REQUIRE-CCOM-S5FEC>
<INIT-VALUE>
<HNHMERICAL-VALUE-SPECIFICATICHN>
<VALUE>0</VALUE>
< /HNUMERICAL-VLALUE-SPECIFICATION>
</INIT-VLLUE>
<VARTIABLE-REF DEST="VARTABLE-DATA-PROTOTYPE">
JASCET Interfaces/Impl/NVData Interface/Speed NV</VARIRELE-REF>
</ IV-REQUIRE-CCM-SFEC™
< /REQUIRED-COHM-SPECS>
<REQUIRED-INTERFACE-TREF DEST="NV-DATA-INTERFACE">
JASCET Interfaces/Impl/NVData Interface</REQUIRED-INTERFACE-TREF>
< /BE-FORT-FROTOTIYFE>

Listing 55: ARXML code — required port NvData definition (AUTOSAR R4.0.2)
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Internal Behavior

The internal behavior of a software component defines how the code that implements the
component interacts with the ports. In this chapter you will see how to configure the
internal behavior.

Internal behavior elements are used to define how the software component will interact with
the RTE at runtime. The internal behavior of a software component specifies:

* The runnable entities that belong to the software component and how they interact (if
at all) with the ports of the software component.

= The events that cause runnable entities to be activated at runtime.

= The interrunnable variables used for communication between the runnables of a
software component.

* The exclusive areas that exist so runnable entities can execute all or part of their code
in mutual exclusion from other runnable entities.

Each internal behavior description is applicable to a single software component and
therefore must reference the software component type to which it applies. In AUTOSAR
R3.1.5 or lower, the reference is established using the <COMPONENT-REF> element. In
AUTOSAR R4.0.*, the reference is established using the <DATA-TYPE-MAPPING-REF>
element.

<INTERMAL-EEHAVICR>
«SHORT-HRME>bSwe IRWV</SHORT-HAME>
<CCHMPCHENT-EEF DEST="APPLICATION-SOFTWARE-COMPONENT-TYPE">
JASCET sweomponents/Impl/Swe IRV</CCMPONENT-REF:
<!—— ewvents that cause runnable activation -->

<EVENTS>

<1— gpecification of mutual exclusive areas —-»
<EMCLUSIVE-LEELS™

< /EMCLUSIVE-LRELE

<1—— wariables for communication between runnables -->
<IHNTER-RIMNNLABLE-VLRILELES>

</ INTER-RUMNLEBLE-VLRILBLES>

<RUNNABLES>

</ RUHMHABLES>
Ty

</ INTERNAL-BEHRVIOR>

Listing 56: ARXML code — internal behavior description for swc (AUTOSAR R3.1.2)
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Internal Behavior

<IHNTERMNAL-EEHAVICRS>
<SWC-INTERNAL-BEHAVIOR™
< SHORT-HAME>bSwo </ SHORT-HAME >
<DATR-TYFE-MLFFING-REFS>
<DARTL-TYFE-MLFFING-REF CEZT="DATA-TYPE-MAPPTHG-SET">
JASCET Mappings/DataMappings/Impl</DRTE-TYPE-MLFFING-REF>
</ DATA-TYPFE-MAFFING-REFSZ>

<EXCLUOSIVE-RARERS>

< /EXCLUOSIVE-AREAS™

<EVENISZ

</EVENT 5S>

<EXPLICIT-INTER-RUNNABLE-VARIABLES:

</ IMPLICIT-INTER-RUNNABLE-VARTABLES:

<RUNNABLES>

</RUNNABLES>
</SWC-INTERNAL-BEHAVIOR>
R

w
5=

HLWTT

</ INTERNAL-BEHAVIO

Listing 57: ARXML code — internal behavior description for swc (AUTOSAR R4.0.2)

An internal behavior must be named using the <SHORT-NAME > element. The name is used
within other elements to reference the behavior. ASCET automatically names the internal
behavior of a software component with a prefix b followed by the name of the software
component.

The short-name of an internal behavior does not need to be a valid C identifier (but it must
pass the syntactic checks enforced by the XML Schema).

The following sections first outline the basic framework for events and runnable entities
before showing how to configure the RTE to achieve different types of runnable
entity/interface interaction.

Events

Events control how runnable entities are triggered by the generated RTE at runtime. ASCET
V6.2 supports the following events:

* TIMING-EVENT — activates a runnable entity periodically. The <TIMING-EVENT>
allows you to execute a runnable entity to poll an Rport to check if data has been
received, periodically call a server (i.e. be a client), periodically send data on a Pport
or simply to execute some internal software component functionality. Runnable
entities that are activated in response to a timing event are said to be time-triggered.

* OPERATION-INVOKED-EVENT — activates a runnable entity to handle a server call
for an operation on a provided port characterized by a client-server interface.

* MODE-SWITCH-EVENT — activates a runnable entity on either entry to, or exit from
an application mode.

The structure for specifying events is similar to the structure shown in Listing 58 and Listing
59. The actual sequence of events is determined by the event names.
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<EVENTS>

Internal Behavior

<OPERATION-INVOEED-EVENT >
<1—— eglements for event/runnable relationship —-->»
< /OPERATION-INVOEED-EVENT>

<TIMTNG-EVENT >

<1—— eglements for

</TIMING-EVENT >
<MODE-SWITCH-EVENT>

<1—— glements for
< /MODE-SWITCH-EVENT>

< /EVEHNTS>

event/runnable relationship -->

event/runnable relationship -->

Listing 58: ARXML code — structure for event specification (AUTOSAR R3.1.2)

<EVENTSZ>

<OPERATION-TNVOEED-EVENT >

< /COPERATICHN-INVOKED-EVENT>

<TIMING-EVENT >

< /TIMING-EVENT>

<SWC-MODE-SWITCH-EVENT >

< SWC-MODE-SWITCH-EVENT >

< /EVEHNTS>

Listing 59: ARXML code — structure for event specification (AUTOSAR R4.0.2)

An event can be used to activate a runnable entity when the event occurs. An event
references the runnable entity that is to be activated when the event occurs.

8.1.1 Timing Events

A <TIMING-EVENT> is used to indicate that a runnable entity will be activated periodically
by the Operating System. The RTE generator will use this information to generate an
appropriate schedule table that must be ticked from application code.

To create a timing event:

= In the "Software Component Editor for: Swc", go to the "Event
Specification" tab.

= Select Event > Add Event and name the event Cyclic 10ms.
= In the "Event Kind" combo box, select Timing.
= In the "Period" field, enter a period of 0.01 seconds.

The timing event Cyclic 10ms appears in the "Event
Specification" tab as follows.
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Figure 40: Definition of the timing event Cyclic 10ms

Note that ASCET enables the user to specify the modes in which this timing event shall be
activated. For the use of application modes refer to chapter 9, Modes, on page 134.

When the timing event is mapped to a runnable entity (see section 8.2, Runnable Entities,
on page 107), then ASCET generates the <TIMING-EVENT> element in the configuration
language:

<EVENT 5>
<TIMING-EVENT>
<SHORT-MAME>Cyolic 10ms< S BHORT-HARME>
<START-CH-EVENT-EREF DEST="RUNHABRLE-ENTITY">
FASCET swoomponents/Impl/bSwe/runnable
</ STLRRT-OH-EVENT-REF>
<PERICD>D.01</FERIOD>
</ TIMING-EVENT>
< /EVENTS>

Listing 60: ARXML code — definition of a timing event (all AUTOSAR versions)

A timing event must be named using the <SHORT-NAME> element. The name is used within
other elements to reference the timing event. The short-name of a timing event does not
need to be a valid C identifier.

The <START-ON-EVENT-REF DEST="RUNNABLE-ENTITY"> element defines the runnable
entity that is to be activated when the event occurs. The <PERIOD> element specifies the
time raster in seconds to be used by the RTE generator.

8.1.2 Operation-Invoked Events

Operation-Invoked events are automatically inserted in an ASCET software component when
you create a server port (see section 7.1.1, Provided Ports, on page 87 for how to create a
server port).
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Figure 41: Operation-Invoked event for the server operations Maximumval and
Notification

An Operation-Invoked event is defined using the <OPERATION-INVOKED-EVENT> element.
Each <OPERATION-INVOKED-EVENT> element must specify:
» the <SHORT-NAME> to refer to the event, which can be edited manually in ASCET by
the user
" A <START-ON-EVENT-REF DEST="RUNNABLE-ENTITY"> reference to the runnable
entity
" an <OPERATION-IREF> reference to the operation prototype and server port

The Operation-Invoked event for the operation Maximumvalue is defined in the
configuration language as follows:

<CPERATICHN-THVOKED-EVENT >
<5HGRT—HEHEprInvaent_Servep_Haximumvhlue<ISHGRT—HAHE>
<START-CH-EVENT-EEF DEST="REUNHABLE-ENTITY">
FASCET swcomponents,/Impl/bSwo/Server MaximumValune
</ STRRT-OH-EVENT-REF>
<CPERATICH-IREF>
<PF-PFCRT-FRCTCTYFE-EREF LDEST="P-PORT-FROTOTYFE">
FASCET swcomponents,/Impl/Swo/Server
«/P-FORT-FROTOTYFPE-REF>
<CPFERATICH-FRCTCTYFE-REF DEST="OPERATION-FROTOTYPE" >
JASCET interfaces/Impl/CSInterface/MaximunValus
< /OPERATION-PROTOTYPE-REF>
«/OPERLATICH-IREF>
< /OPERATIOHN-INVOEED-EVENT>

Listing 61: ARXML code — definition of an Operation-Invoked event (AUTOSAR R3.1.2)
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<CPERATICH-TNVOEED-EVENT >

Internal Behavior

<5HGRT—HEHEprInvaent_Servep_ﬂaximumvhlue<ISHGRT—HEHE>
<START-CH-EVENT-REF LDEST="RUNNABLE-ENTITY">

FASCET ComponentTypes/SWC/bSWC/Server MaximumValoe

<fSTART-CH-EVENT-REF>
<CPERATICH-IREF>

<CONTEXT-F-PORT-EEF DEZT="P-PFORT-FROTOTYFE"Z>

FASCET_ComponentTypes/SWC/Server</CCNTEXT-F-FORT-REF>
<TARGET-PROVIDED-CPERATICH-REF DEST="CLIENT-SEEVER-OPERATION">

JASCET Interfaces/Impl/CSInterface/MaximunValues

</TREGET-PRCVIDED-CFERARTICH-REEF>

< /CPERATICH-IEREF>
< /CPERATICH-INVOEED-EVENT>

Listing 62: ARXML code — definition of an Operation-Invoked event (AUTOSAR R4.0.2)

Mode-Switch Events

Mode-switch events activate a runnable entity on entry to, or exit from an application mode.

To create a mode-switch event:

= In the "Software Component Editor for: Swc", go to the Event

Specification tab.

= Select Event ©> Add Event and name the event ModeEvent.
= In the "Event Kind" combo box, select ModeSwitch.
= Set the following mode switch settings:

— Activation: entry

— Assigned Mode: on: :0nOffMode

Ewents

?!;,Cydic_lﬂms (Timing - 0.0[s])

= ﬁMndeEvent (ModeSwitch - entry - on::OnOffMode)
off::OnCffMode (ModeInterface,/OnCffvode)
on::OnOffMode (Modelnterface /OnCffMode)

ﬁOpInvaent_SerVer_MaximumVaIue (OperationInwve
ﬁOpInvaent_Server_NDh’ﬁcaﬁnn (OperationInvoke

i | mn | 3

Event Kind:
[ModeSwitd'u - ]

Mode Switch Settings

Activation @ entry ) exit

Assigned Mode:

|on;;DanﬂU!ode {Modelnterface,/OnCffivode) v]

off::OnOffiMode ﬁndelnh&rfaceEOnOfﬁ\ﬂodei
e on::OnOffMode (Modelnterface /OnOffMode]

Runnables

@runnable
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Figure 42: Modeling ModeEvent on entry with mode on of the application mode

OnOf fMode

When the mode-switch event is mapped to a runnable entity (see section 1.1, Responding to
Timing Events, on page 109), then ASCET generates the <MODE-SWITCH-EVENT>' / <SWC-
MODE-SWITCH-EVENT>? element in the configuration language:

! AUTOSAR R3.1.5 or lower
2 AUTOSAR R4.0.*
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<MCDE-SWITCH-EVENT>
«SHORT-HMLAME >ModeEwvent« /SHORT-HLME>
<START-CH-EVENT-EEF DEST="RUNHABLE-ENTITY">
JASCET sweomponents,/Impl/bSwe/ModeRunnable
</ STLRRT-OHN-EVENT-REF>
<LCTIVATIOH>ENTRY</LCTIVLTION>
<MODE-IREF>
<R-PCORT-FRCTCTYFE-EREEF DEST="R-PORT-FROTOTYFE">
FASCET swocomponents,/Impl/Swo/ModeInterface
< /RE-FORT-FROTOTYFE-REF>
<HMODE-DECLARATICH-GROUP-FROTOTYFPE-REF DEST=
"MODE-DECLARATION-GROUP-FROTOTYPE" >
FASCET interfaces/Impl/ModeInterface/On0ffMode
< /HMODE-DECLARLRTICH-GROUP-PROTOTYFE-REF>
<MCDE-DECLARLTICH-EEF DEST="MODE-DECLARATION">
thCET_ﬁypESfDanfMOdEfUﬂifHODE—DEC:RRRTIGH—REF}
< /HMODE-IREF>
< /HMODE-SWITCH-EVENT>

Listing 63: ARXML code — definition of a Mode-Switch event (AUTOSAR R3.1.2)

<SWC-HMCDE-SWITCH-EVENT >

< SHORT-HMAME >ModeEvent< /SHORT-HLME>

<START-CH-EVENT-EEF DEST="RUNHABLE-ENTITY">

JASCET ComponentTypes,/SWC/bSWC/ModeRunnable

</ STRRT-ON-EVENT-EEF>

<LCTIVATION>ON-ENTRY« /LCTIVLTION>

<MCDE-IREFS5

<HMOCDE-IREF>
<CONTEXT-FCORT-EREF DEST="R-PORT-FROTOTYFE">
FASCET ComponentTypes,/SWC/ModeInterface
</ CONTEXT-FORT-REF>
<CONTEXT-MODE-DECLARATICH-GROUP-FPROTOTYPE-REF DEST=
"MODE-DECLARATION-GROUP-FPROTOTYFPE" >
FASCET Interfaces/Impl/R4 ModeInterface/0n0OffMode
</ CONTEXT-MODE-DECLARLATICN-GROUP-FPROTOTYFE-REF >
<TARGET-MODE-DECLARATICH-REF DEST="MODE-DECLARATION":
FASCET Types/ApplicationDataTypes/On0ffMode/on
< /TRREET-MODE-DECLARLTION-REF>
< /HMODE-IREF>
< /MODE-IREFS>
</ SWC-MODE-SWITCH-EVENT>

Listing 64: ARXML code — definition of a Mode-Switch event (AUTOSAR R4.0.2)

In the "Events" field, all modes in the assigned mode group are shown below the Mode-
Switch event. They can be enabled/disabled individually. If at least one mode is deactivated
(see Figure 61 on page 139), the <MODE-DEPENDENCY>* / <DISABLED-MODE-IREFS>?
element is added to the configuration language, with one <DEPENDENT-ON-MODE-IREF>! /
<DISABLED-MODE-IREF>? element for each deactivated mode.

! AUTOSAR R3.1.5 or lower
2 AUTOSAR R4.0.*
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For ARXML code examples, see Listing 96 on page 140 (AZUTOSAR R3.1.2) or Listing 97 on
page 141 (AUTOSAR R4.0.2).

See section 9.3.3, Disabling Modes, on page 139 for more information on disabled modes.

A Mode-Switch event must be named using the <SHORT-NAME> element. The name is used
within other elements to reference the timing event. The short-name of a timing event does
not need to be a valid C identifier.

Each <MODE-SWITCH-EVENT> element must specify

= 3 <START-ON-EVENT-REF DEST="RUNNABLE-ENTITY"> reference to the runnable
entity,

" an <ACTIVATION> value, ENTRY or EXIT, for the activation type,
* a <MODE-IREF> element, which defines the mode associated with the event,
» and - if necessary — a <MODE-DEPENDENCY> reference to a mode declaration.

Runnable Entities

A runnable entity, or simply runnable, is a piece of code in a software component that is
triggered by the RTE at runtime. A software component comprises one or more runnables,
and each runnable must have a unique handle so that the RTE can access it at runtime.

To create a runnable entity:

= In the "Software Component Editor for: Swc", select a diagram
(e.g., Main) in the "Outline" tab.

= Select Insert » Runnable and name it RunnableEntity.

All runnable entities must be defined in the Software Component Template within the
<RUNNABLES> definition in an <INTERNAL-BEHAVIOR>! / <SWC-INTERNAL-BEHAVIOR>?
definition.

<RUNNABLE-ENTITY

< SHORT-HAME>RunnableEntity</SHORT-HAME >
<CAN-BE-INVOEED-CONCURRENTLY>false< /CAN-EE-INVOEKED-CONCURRENTLY >
<HINIMUM-S5TART INTEEVAL>D .0« /MINIMUM-5START-INTERVAL>

<SYMEBCL>Swao Impl BonnableEntity</5YMBOL>

</ RUNHLBLE-ENTITY>
Listing 67: ARXML code — runnable entity definition (AUTOSAR R3.1.2)

<RUNNABLE-ENTITY>
<SHORT-NAME>RunnableEntity</SHORT-NAME>
<MINIMOM-START-INTERVAL>0. 0« /MINIMUM-START-INTERVAL>
<5SW-ADDR-METHOD-REF DEST="SW-ADDR-METHOD"»>/ASCET AddrMethods/CODE

</ SW-ADDR-METHCOD-REF>

<CRN-BE-INVOKED-CONCURRENTLY>false</CAN-BE-INVCEED-CONCURRENTLY >
<5YMECL>SWC Impl RunnableEntity</SYMECL>

< /RUNNABLE-ENTITY>

Listing 68: ARXML code — runnable entity definition (AUTOSAR R4.0.2)

A <RUNNABLE-ENTITY> must be hamed using the <SHORT-NAME> element. The name is
used within other elements to reference the runnable entity.

! AUTOSAR R3.1.5 or lower
2 AUTOSAR R4.0.*
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The <SHORT-NAME> denotes the name of the runnable entity in the XML namespace, but it
does not tell the RTE what the associated function body you will provide in your code is
called. This information is provided by the <syMBOL> declaration that links the runnable
entity to the C function name you will use in your implementation. The <SYMBOL> name
must be a valid C identifier.

In AUTOSAR R4.0.*, the <sW-ADDR-METHOD-REF> element is used to determine the
memory class for the generated code.

The symbol of a runnable entity is optional information in ASCET. If not defined, ASCET
takes the name of the function in the ASCET-generated code that implements the runnable
entity. In the example, ASCET generates the C function SWC_IMPL RunnableEntity. If
the symbol is defined, then ASCET generates C code for the runnable entity according to the
given symbol.

To set the C identifier for a runnable:

= In the "Outline" tab of the software component editor, select the
runnable RunnableEntity and select Edit >
Implementation.

The window "Implementation for: RunnableEntity" opens.
= Enter the symbol RteRunnable Swc RunnableEntity.

= C(lick OK.
Eff Implementation foer: RunnableEntity () @
Inline
Use FPU
Memory Location [Defauﬂ v]
Cache Locking [Autumaﬁc v]
Symbal RteRunnable_SWC_RunnableEntity
[ QK ][ Cancel ]

Figure 44: Setting the symbol RteRunnable Swc RunnableEntity for the runnable
RunnableEntity

With that, ASCET will generate C code for the implemented runnable and name it
RteRunnable Swc RunnableEntity (see file Swc.c in this example):

FUMC {(wvoid, CCDE) RteRunnable SWC RunnableEntity (wvoid)
i

}
The <RUNNABLE-ENTITY> description is generated accordingly:

<RUNNABLE-ENTITY>
<SHORT-HAME>FunnableEntity«</SHORT-HNAME>
<CAN-BE-INVOEED-CONCURRENTLY>false< /CAN-EE-INVOEKED-CONCURRENTLY >
<MINITMOM-S5TART-INTERVAL>D . D</MINTMIM-START-INTERVAL:
«SYMBCL>RteRunnable SWC RuonnakbleEntity</3YHEOL>

< /BUNNABLE-ENTITY>

Listing 69: ARXML code — runnable entity definition with user-defined <symMBOL>
(AUTOSAR R3.1.2)
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<RUNMAEBLE-ENTITY>
<SHORT-HAME>RBunnableEnti ty<,/SHORT-HAME >
<MINIMOM-ST&RT-INTERVAL>0.0<,/MINIMUM-START-INTERVAL>
<EW-ADDR-METHOD-REF DEST="SW-ADDE-METHOD">/ASCET AddrMethods/CODE

</ 5W-LDDE-METHOD-REF>

<CAMN-BE-INVOEED-CONCURRENTLY>fal=e< /CAN-BE-INVOKED-CONCURRENTLY >
<SYHEDLbRteRunnabla_qu_BunnableEntity<f5YHEGL>

< /RUNHABLE-ENTITY>

Listing 70: ARXML code — runnable entity definition with user-defined <symMBOL>
(AUTOSAR R4.0.2)

This declaration is sufficient if your runnable entity does not need to interact with the
software component's ports. However, if a runnable entity needs to communicate through
ports, then you need to specify additional information that allows the RTE generator to
generate APIs to allow interaction to take place, for example:

1. What data items the runnable entity can send.
2. What data items the runnable entity can receive.
3. Which servers the runnable entity calls and how it expects the result to be returned.

You can use the same runnable entity to receive data on one port and send data on another
port, or to receive data on a port and then call a server port to process the received data.
For example, you may create a runnable entity that reads an integer value from an Rport,
multiplies it by two and sends it out on a Pport.

A runnable entity that is not invoked by an Operation-Invoked event can also specify a
minimum start interval to control the rate at which activations occur. A minimum start
interval will delay the activation of a runnable to prevent that the runnable is started more
than once within the interval.

Note

When using minimum start intervals, the user shall check how the runnable activation is
implemented by the RTE generator in use.

Responding to Timing Events

A runnable entity is executed periodically at runtime when the runnable entity is associated
with a timing event. Timing events specify how often the runnable entities should execute.

The <TIMING-EVENT> element specifies the <PERIOD> of occurrence in seconds and must
reference a runnable entity defined in the component's internal behavior using a <START-
ON-EVENT-REF> element. A period of zero is illegal.

The following example shows how to configure the RTE to activate a runnable entity every
10 milliseconds.
To assign a timing event to a runnable:

= (o to the "Event Specification" tab of the "Software Component
Editor for: Swc".

= In the "Events" field, select the event Cyclic 10ms.
= In the "Runnables" field, select the runnable RunnableEntity.
= Select Event > Assign Event or click the >> button.
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Figure 45: The event Cyclic 10ms is assigned to RunnableEntity

In the <TIMING-EVENT> element, the <START-ON-EVENT-REF DEST="RUNNABLE-
ENTITY"> element defines the runnable entity that is to be activated when the event
occurs. The <PERIOD> element specifies the time raster to be used by the RTE generator.

A timing event must be named using the <SHORT-NAME> element. The name is used within
other elements to reference the timing event. The short-name of a timing event does not
need to be a valid C identifier.

See also Listing 60: ARXML code — definition of a timing event (all AUTOSAR versions), on
page 103.

Sending to a Port

If your software component provides a sender-receiver interface, you must define at least
one runnable entity that sends data over the interface.

The runnable can send data in two ways:

= Explicitly, in which case the RTE generates an explicit API call that may be optimized
to a macro. The sent datum may be either queued or unqueued.

= Implicitly, in which case the RTE generates an implicit API call that will be optimized
to a macro. The sent datum must not be queued.

For senders, it does not matter how the runnable entity is triggered, so any event can be
used to activate the runnable entity.

Explicit Communication

To send to a port with explicit communication:

= Add a Pport sender to Swc, as described in section 7o create a
sender port on page 87.

= Drag the Pport sender from the "Outline" tab and drop it in the
drawing area of the software component editor.

4G * Use the RTE Access button to create an RTE Access operator
: and place it in the drawing area.
= Connect the output of the RTE Access operator with the data
element speed of the sender port.

= In the "Outline" tab, select the runnable RunnableEntity, then
double-click on the sequence call of speed.
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ASCET automatically assigns a sequence number for the sending
of the data element speed within the runnable
RunnableEntity, i.e. the sequence 5.

= Insert a literal with value 120 and connect the literal to the input
of the RTE Access operator.

Now you are able to generate code (see 7o generate code in a
project on page 27)..

-
SRInkterface

Speed m

Figure 46: Sending a value 120 to a sender port with explicit communication

Runnable entities sending data with explicit communication must define a <DATA-SEND-
POINTS> element that specifies the data items that will be sent for a given interface.

In AUTOSAR R3.1.5 or lower, a sent data item is described in @ <DATA-SEND-POINT>
element. Each <DATA-SEND-POINT> element must specify the following properties:

= the <SHORT-NAME> that you will use to refer to the item (the short-name does not
need to be a valid C identifier)

= the <DATA-ELEMENT-IREF> element that contains
— a<P-PORT-PROTOTYPE-REF> reference to the Pport
— a<DATA-ELEMENT-PROTOTYPE-REF> reference to the sent element

<RUHNNABLE-ENTITY>
< SHORT-HAME>BunnableEntity</SHORT-NAME >
INVCOEED-COHNCURRENTLY>false«/CRN-BEE-INVCOEED-CONCURRENTLY >
END-POINTS>
B-SEND-POINT =
<SHORT-NAME>dataSendPointl«</SHORT-HAME>
<DLTA-ELEMENT-IREF>

<CAN-BE-
<DATRE-5

<DR

<PF-PORT-PROCTOCTYFE-REF DEST="P-PORT-PROTOTYFE">
FASCET sweomponents/Impl/Swo/Sender</F-FORT-FROTOIYFE-REF>
<DLTL-ELEMENT-FPROTOTYFE-REF DEST="DATA-ELEMENT-PROTOTYPE" >

JASCET interfaces/Impl/SRInterface/Speed
</ DATR-ELEMENT-FROTCTYFE-REF™>
</DATR-ELEMENT-IEEF>
</DATR-SEND-POINT >
</ DARTR-SEND-POINTIS>
<MINIMUOM-START-INTERVAL>0D.0< /MINIMUM-START-INTERVAL>
<SYMECL>RteRunnable SWC EonnableEntity</SYMECLL:

</RUNNABLE-ENTITY>

Listing 71: ARXML code — runnable entity with explicit send (AUTOSAR R3.1.2)

In AUTOSAR R4.0.*, a sent data item is described in a <VARIABLE-ACCESS> element. Each
<VARIABLE-ACCESS> element must specify the following properties:

» the <SHORT-NAME> that you will use to refer to the item (the short-name does not
need to be a valid C identifier)
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= the <ACCESSED-VARIABLE> element that includes the <AUTOSAR-VARIABLE-
IREF> element that contains

— a <P-PORT-PROTOTYPE-REF> reference to the Pport
— a <TARGET-DATA-PROTOTYPE-REF> reference to the sent element

<RUNHNABLE-ENTITY>
< SHORT-NAME >REunnableEnti ty«</SHORT-HNLME >
<MINIMUOM-START-INTERVAL>0D. </ HINIMUM-START-INTERVAL>
< SW-ADDRE-METHCD-EEF :EST=“SW—ADDR—METHDD“>fASCET_ﬁddrM3thcdstDDE
</ SW-LDDE-METHOD-REF>
<CAN-BE-INVOEED-CONCURRENTLY>fal=e</CAN-BE-INVOKED-CONCURRENTLY >
<DATA-SEND-FOINTS>
<WVLRRILRBLE-RCCESS>
<5HORT-MAME>DataSendPointl«</SHORT-HMLME >
<RCCESSED-VARILABLE>
<RUTOSLAE-VLARILERLE-IREF>
<PORT-PROTOTYPE-REF DEST="P-PORT-PROTOTYPE">
JASCET ComponentTypes/SWC/Sender</FCORT-FROTCTYPE-REF>
<TLRGET-DATA-FREOTCTYPE-REF DEST="DATA-PROTOTYFE" >
JASCET Interfaces/Impl/SEInterface/Speed
< /TREGET-DATL-FROTOTYFE-REF>
< /LUTOSAR-VARIABLE-IREF:>
</BCCESSED-VLRIABLE>
</VARILBLE-LCCESS>
</DATA-3END-POINTS>
<SYHEDL>RtERunnablE_qu_ﬁunnablEEntity<f5YHEDL>
</RUMHLELE-ENTITY>

Listing 72: ARXML code — runnable entity with explicit send (AUTOSAR R4.0.2)

For senders, it does not matter how the runnable entity is triggered, so any event can be
used to activate the runnable entity.

For the ASCET-generated code, refer to section 10.3.1, Sending to a Port, on page 146.

8.4.2 Implicit Communication

Runnable entities can also communicate using implicit data read/write access. Such
configuration is guaranteed to be implemented as a simple macro that accesses global
storage defined in the RTE rather than through a C function call.

There are two possibilities to model implicit communication in ASCET:

1. Changing the RTE access from explicit to implicit.

2. Modeling the implicit communication without using the RTE access operator.
To change the RTE access to implicit:

= In the drawing area, right-click the RTE access operator from the
example of section 8.4.1 and select Access - Implicit from the
context menu as shown in Figure 47.
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Figure 47: Changing the access type of the RTE Access operator to implicit

To send to a port with implicit communication:

= Drag the Pport sender from the "Outline" tab and drop it in the
drawing area of the software component editor.

= Insert a literal with value 120 and connect the literal to the data
element speed of the port Sender.

= In the "Outline" tab, select the runnable RunnableEntity, then
double-click on the sequence call of the data element speed.

ASCET automatically assigns a sequence number for the sending
of the data element speed within the runnable
RunnableEntity, i.e. the sequence 10.

------------------ SRInkerface

O

120 Speed

Figure 48: Writing a value 120 to a sender port with implicit communication

The configuration of the implicit communication is almost identical to the explicit
communication. Instead of a <DATA-SEND-POINTS> element, the implicit communication is
defined using a <DATA-WRITE-ACCESSS> element:
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<RUNHNABLE-ENTITY>
< SHORT-MAME>RunnableEntity</SHORT-HNAME >
<CARN-BE-INVOEKED-CONCURRENTLY>false</CAN-EE-INVOKED-CONCURRENTLY >
<DATR-WRITE-RCCESSS>
<DLRTR-WRITE-RCCESS>
<SHORT-NLME>dataWritehocessl</ SHORT-IILME>
<DATA-ELEMENT-IREF>
<P-PORT-PROCTOCTYPE-REF DEST="P-PORT-PROTOTYFE">
SASCET swoomponents/Impl/Swe/Sender</F-FORI-FROTIOTYFE-REF>
<DATAR-ELEMENT-FROTOTIYPE-EEF DEST="DATA-ELEMENT-PROTOTYFE">
JASCET interfaces/Impl/SRInterface/Speed
</DATL-ELEMENT-FROTOTYFE-REF>
</DATL-ELEMENT-IREF>
</DATR-WRITE-LCCESS>
</DARTR-WRITE-LCCESSS>
<MINIMUM-START-INTERVAL=0.0< /MINIMIM-START-INTERVAL
<SYHBGZ>RteRunnabla_SWQ_BunnableEntity(fSYHBG:b
</RUNHLELE-ENTITY>

Listing 73: ARXML code — runnable entity with implicit send (AUTOSAR R3.1.2)

<RUNHNABLE-ENTITY>>
< SHORT-NAME >REunnableEnti ty«</SHORT-HNLME >
<MINIMUM-START-INTERVAL>D.0</HINIHUM-START-INTERVAL:>
< SW-ADDRE-METHCD-EEF :EST=“SW—ADDR—HETHDD“>EASCET_ﬁddrMethcdstDDE
</ SW-LDDE-METHOD-REF>
<CAN-BE-INVOEED-CONCURRENTLY>fal=e</CAN-BE-INVOKED-CONCURRENTLY >
<DATAR-WRITE-RCCESS5>
<WVLRRILRBLE-RCCESS>
<5HORT-MAME>DataWritelAccessl</SHORT-NLME>
<ACCESSED-VARIABLE>
<RUTOSLAE-VLARILERLE-IREF>
<PORT-PROTOTYPE-REF DEST="P-PORT-PROTOTYFPE">
JASCET ComponentTypes/SWC/Sender</FCORT-FROTCTYPE-REF>
<TLRGET-DATA-FREOTCTYPE-REF DEST="DATA-PROTOTYFE" >
JASCET Interfaces/Impl/SEInterface/Speed
< /TREGET-DATL-FROTOTYFE-REF>
</AUTOSLR-VLRILELE-IREF>
</BCCESSED-VLRIABLE>
< /VARILRBLE-LCCESS>
</DATAR-WRITE-LCCESSS>
<5YHBDL}RteRunnable_ﬁwq_BunnableEntity<f5YHBDL>
</RUMHLELE-ENTITY>

Listing 74: ARXML code — runnable entity with implicit send (AUTOSAR R4.0.2)

For the ASCET-generated code, refer to section 10.3.1, Sending to a Port, on page 146.

8.5 Receiving from a Port

Similarly, if your software component requires a sender-receiver interface then you must
define at least one runnable entity that receives data over the interface. Data can be
received in the following ways:

= Implicit data read access — your runnable is activated by some event, e.g. a timing
event, and makes an RTE API call to read data

ASCET V6.2 AUTOSAR User’s Guide 114



ETAS

Internal Behavior

= Explicit Data read access — your runnable entity is activated by an event and makes
an RTE API call to read/receive the data. The receiver uses a non-blocking API to poll

for the data.

8.5.1 Explicit Data Read Access

To receive from a port with explicit communication:

Add an Rport Receiver to SWC, as described in section 70 create
a receiver on page 93.

Drag the Rport Receiver from the "Outline" tab and drop it in
the drawing area of the software component editor.

Use the RTE Access button to create an RTE Access operator
and place it in the drawing area.

Connect the data element Speed of the Receiver port to the
input of the RTE Access operator.

Insert a signed discrete variable and name it Speedswec.

Implement the variable SpeedSwc as a sint16 with
implementation range [-32768, 32767].

In the "Outline" tab, select the runnable RunnableEntity, then
double-click on the empty sequence call of the variable
SpeedSwc.

ASCET automaticallys assign a sequence number to SpeedSwc
within the runnable RunnableEntity, e.g., the sequence 10.

SRInterface

M Speed

L Receiwer .

Figure 49: Receiving the value speed from the Rport Receiver with explicit

communication

Runnables that are required to receive data with explicit "data read access" must define a
<DATA-RECEIVE-POINTS>! / <DATA-RECEIVE-POINT-BY-VALUES>? element that

specifies the received data items.

In AUTOSAR R3.1.5 or lower, a received data item is described in @ <DATA- RECEIVE-
POINT> element. Each <DATA- RECEIVE-POINT> element must specify the following

properties:

» the <sHORT-NAME> that you will use to refer to the item (the short-name does not
need to be a valid C identifier)

= the <DATA-ELEMENT-IREF> element that contains

— a<P-PORT-PROTOTYPE-REF> reference to the Rport

— a<DATA-ELEMENT-PROTOTYPE-REF> reference to the sent element

! AUTOSAR R3.1.5 or lower

2 AUTOSAR R4.0.*
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<REUNNAELE-ENTITY>
£ 5HORT-HMEME>RunnableEntity</SHORT-HLME>
<CAN-BE-INVOEED-CONCURRENTLY>false< /CRN-BE-INVOEED-CONCURRENTLY >
<DATA-RECEIVE-FOINTS>
<DATA-REECEIVE-FOINT>
<SHORT-NLME>dataReceivePointl«</SHORT-MLME>
<DATL-ELEMENT-IREF>
<E-PORT-FROCTOTYPE-REEF DEST="R-PORT-PFROTOTYPE">
JASCET swcomponents,/Impl/Swo/Receiver</R-FORT-PROTOTYFE-REF>
<DATA-ELEMENT-FREOCTOTYPE-REF LDEST="DATA-ELEMENT-FPROTOTYFE" >
JASCET interfaces/Impl/SRInterface/Speed
</DLATR-ELEMENT-FROTOTYEFE-REF>
</DLRTL-ELEMENT-IREF>
</DATL-RECEIVE-POINT>
< /DARTL-RECEIVE-POINTS>
<MINIMUM-START-INTERVAL>D. 0</MINIMUM-START-INTERVAL
<5YH3@1>RtERunnable_SWC_BunnableEntity(fSYHEG:>
</RUNHABLE-ENTITY>

Listing 75: ARXML code — runnable entity with explicit receive (AUTOSAR R3.1.2)

In AUTOSAR RR4.0.*, a received data item is described in @ <VARIABLE-ACCESS>
element. Each <VARIABLE-ACCESS> element must specify the following properties:

» the <SHORT-NAME> that you will use to refer to the item (the short-name does not
need to be a valid C identifier)

= the <ACCESSED-VARIABLE> element that includes the <AUTOSAR-VARIABLE-
IREF> element that contains

— a<P-PORT-PROTOTYPE-REF> reference to the Rport
— a <TARGET-DATA-PROTOTYPE-REF> reference to the received element

<RUNNABLE-ENTITY>
< SHORT-MLZME>BunnableEntity«/SHORT-NAME>
<HMINIMUM-START-INTERVAL>D.0</MINIMUM-START-INTERVAL>
<SW-LDDR-METHCOD-REF :EST=“SW—ADDR—METEOD“>EASCET_ﬁddrMEthodstDDE
</ 3W-LDDE-METHOD-REF>
<CAN-BE-INVOEED-CONCURRENTLY>false</CAN-BE-INVOKED-CONCURRENTLY >
<DATA-RECEIVE-POINT-BEY-VALUES>
<WVRRIABLE-LCCESS>
<SHORT-MAME>DataReceivePointl«</SHORT-HAME>
<ACCESSED-VARIABLE>
CRAUTOSAR-VARIABLE-IREF>
<PORT-PROCTOTYPFE-REF DEST="R-PORT-PROTOTYPE">
JASCET ComponentTypes/SWC/Receiver</PORT-PROTCTYPFE-REF>
<TARGET-DATA-FROTOTIYPFE-REF DEST="DATA-FPROTOTYFE">
JASCET Interfaces/Impl/SRInterface/Speed
< /TLRGET-DATL-FROTOTYFE-REF>
< /AUTOSAR-VARRILRELE-IREF>
< /BACCESSED-VARILEBLE>
< /VLRRILBLE-LCCESS>
</DATR-RECEIVE-POINT-BY-VLALUES>

<5YHBGL>RteRunnable_ﬁwc_RunnableEntity(fSYHEDL>
</RUNNABLE-ENTITY:>

Listing 76: ARXML code — runnable entity with explicit receive (AUTOSAR R4.0.2)

ASCET V6.2 AUTOSAR User’s Guide 116



ETAS

8.5.2

Internal Behavior

Using data read access implies that the runnable entity is polling the Rport for the specified
data item. It is common, therefore, that a runnable entity which defines a <DATA-
RECEIVE-POINTS>! / <DATA-RECEIVE-POINT-BY-VALUES>? element will be activated
by a <TIMING-EVENT> that specifies the required polling period.

For the ASCET generated C code, refer to section 10.3.2, Receiving from a Port, on page
149.

Implicit Data Read Access

The following possibilities to model implicit communication are available in ASCET:
1. Changing the RTE access from explicit to implicit.
2. Modeling the implicit communication without using the RTE access operator.
To change the RTE access to implicit:

= In the drawing area, right-click the RTE access operator from the
example of section 8.5.1 and select Access = Implicit from the
context menu as shown in Figure 50.

W - e
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..... Receiver. . . . . . . . . .. Sth Sequence Ca"s e

Figure 50: Changing the access type to implicit in the RTE Access operator

To receive from a port with implicit communication:

= Drag the Rport Receiver from the "Outline" tab and drop it in
the drawing are of the software component editor.

= Insert a signed discrete variable, nhame it SpeedSwc, and
implement it as a sint16 with implementation range [-32768,
327677.

= Connect the data element speed of the Receiver port to the
variable Speedswec.

= In the "Outline" tab, select the runnable RunnableEntity, then
double-click on the empty sequence call of the variable
SpeedSwc.

ASCET automatically assigns a sequence number to SpeedSwc
within the runnable RunnableEntity, e.g., the sequence 10.

! AUTOSAR R3.1.5 or lower
2 AUTOSAR R4.0.*
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e
SRInterface
/10/RunnableEntity
>—D Speed
SpeedSwe

Receiver

Figure 51: Receiving the value speed from the Rport Receiver with implicit
communication

Likewise, runnables that are required to receive data with implicit data read access must
define a <DATA-READ-ACCESSS> element that specifies the data items they will receive.

<REUNNAELE-ENTITY>
< SHORT-MEME>RunnableEntity</SHORT-HMLME>
<CAN-BE-INVOEED-CONCURRENTLY>false< /CAN-BE-INVOEED-CONCURRENTLY >
<DATR-RERD-RCCESSS>
<DATA-READ-ACCESS>
<SHORT-NLME>dataReadAccessl</SHORT-HLME>
<DATL-ELEMENT-IREF>
<E-PORT-FROCTOTYPE-REEF DEST="R-PORT-PFROTOTYPE">
JASCET swcomponents,/Impl/Swo/Receiver</R-FORT-PROTOTYFE-REF>
<DATA-ELEMENT-FREOCTOTYPE-REF LDEST="DATA-ELEMENT-FPROTOTYFE" >
FASCET interfaces/Impl/SRInterface/Speed
</ DATER-ELEMENT-FROTOTYPE-REF>
</DLRTL-ELEMENT-IREF>
< /DRTL-RELRD-LRCCESS>
< /DRTL-RELRD-LCCESSS>
<MINIMUM-START-INTERVAL>D. 0< /MINIMUM-STLART-INTERVAL
<5YMBECL>RteRunnable SWC RunnableEntity< S EYHMBOL>
</RUNHABLE-ENTITY>

Listing 77: ARXML code — runnable entity with implicit receive (AUTOSAR R3.1.2)
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<RUNNABLE-ENTITY>
< SHORT-MLZME>BunnableEntity«/SHORT-NAME>
<HMINIMUM-START-INTERVAL>D.0</MINIMUM-START-INTERVAL>
<SW-LDDR-METHCOD-REF :EST=“SW—ADDR—HETHDD“>EASCET_ﬁddrMEthodstDDE
</ 3W-LDDE-METHOD-REF>
<CAN-BE-INVOEED-CONCURRENTLY>false</CAN-BE-INVOKED-CONCURRENTLY >
<DATAL-READ-ACCESS5S5>
<WVRRIABLE-LCCESS>
<SHORT-MAME>DataReadhccess1</SHORT-HAME >
<ACCESSED-VARIABLE>
CRAUTOSAR-VARIABLE-IREF>
<PORT-PROCTOTYPFE-REF DEST="R-PORT-PROTOTYPE">
JASCET ComponentTypes/SWC/Receiver</PORT-PROTCTYPFE-REF>
<TARGET-DATA-FROTOTIYPFE-REF DEST="DATA-FPROTOTYFE">
JASCET Interfaces/Impl/SRInterface/Speed
< /TLRGET-DATL-FROTOTYFE-REF>
< /AUTOSAR-VARRILRELE-IREF>
< /BACCESSED-VARILEBLE>
< /VLRRILBLE-LCCESS>
</DATR-REARD-ACCESSS>

<5YHBGL>RteRunnable_ﬁwc_RunnableEntity(fSYHEDL>
</RUNNABLE-ENTITY:>

Listing 78: ARXML code — runnable entity with implicit receive (AUTOSAR R4.0.2)

A single received data item is described by a <DATA-READ-ACCESS>' /| <VARIABLE-
ACCESS>? element. A <DATA-READ-ACCESS>/<VARIABLE-ACCESS> element must be
named using the <SHORT-NAME> element. The name is used within other elements to
reference the data read access. The short-name does not need to be a valid C identifier.

For the ASCET-generated code, refer to section 10.3.2, Receiving from a Port, on page 149.

8.6 Responding to a Server Request on a Port

In software components that provide a client-server interface, ASCET defines one runnable
entity for each operation in the interface. These runnable entities are the servers for the
client-server Pports on the software component.

The runnable entity to be regarded by the RTE as a server must be tied to an
<OPERATION-INVOKED-EVENT>. This RTE event allows the RTE to call the runnable entity
at runtime in response to client requests. The <OPERATION-INVOKED-EVENT> must
specify what operation request on the server interface will result in the runnable entity being
activated.
The following example shows how ASCET configures the runnable server Maximumvalue
to be executed when the operation called Maximumvalue is called on the Pport server of
interface type CSInterface. See also

1. section 6.3, Client-Server, on page 70 for the creation of the client interface

CSInterface,

2. section 7.1.1, Provided Ports, on page 87 for the creation of the Pport server, and

1 AUTOSAR R3.2.5 or lower
2 AUTOSAR R4.0.*
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3. section 8.1.2, Operation-Invoked Events, on page 103 for a detailed description of
Operation-Invoked events.

<INTERNAL-BEHAVICRE>
<SHORT-HAME >bhSwo< / SHORT -HAME >
<COMPCHENT-REF DEST="APPLICATION-SOFTWARE-COMPONENT-TYFE">
fASCET_swcomponents/Impl/Swo</COMFONENT-REF>
<EVENIS>

<OPERATICH-INVCEED-EVENT >
<5HORT—HAME>0pInvaent_ﬁervep_ﬂaximuﬂ?ﬁlue(fSHORT—HAHE}
<START-ON-EVENT-REF DEST="RUNNABLE-ENTITY">
SASCET swoomponents/Impl/bSwe/Server MaximumValune
</ STLRT-CN-EVENT-REF>
<OPERATICN-IREF>
<P-PORT-PROTOTYPE-REF DEST="P-PORT-PROTOTYPFE">
fASCET_swcomponents/Impl/Swe/Server</F-FPCRT-FRCTCTYFE-REF>
<OPERATION-PROTOTYPE-EEF DEST="OPERATION-PROTOTYFE" >
SASCET interfaces/Impl/CSInterface/MaximunValue
< /COPERATICHN-PROTCTYFE-REF>
< /OPERLATICH-IREF>
</OPERATICH-INVOEED-EVENT>

< /EVENTS>
<RUNNLEBLES>

<RUHNHABLE-ENTITY>
<SHGRT—HEHE>Servep_MaximuMUﬁluecfSHGRT—HEHE}
<CAN-BE-INVCEED-CONCIRRENTLY>false<,/CAN-BE-INVOKED-CONCIRRENTLY >
<5YMEG:>qu_Impl_Servep_ﬂaximuﬂ?ﬁluecf5YM3@1>

< /RUNNABLE-ENTITY:

< /RUHNHABLES>
</ INTERNAL-BEHAVICR>

Listing 79: ARXML code — internal behavior responding to a server request (AUTOSAR
R3.1.2)
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<SWC-INTERNAL-BEHAVICR>
< SHORT-MLME>bhSWC< / SHORT-HAME>
<DATA-TYPE-MAPPING-REFS>
<DATA-TYPE-MAPPING-REF DEST="DATA-TYPE-MAPPING-SET">
JASCET Mappings/DataMappings/Inpl</DATA-TYFE-MAFFING-REF>
< /DATL-TYPE-MLRPPING-REFS>
<EVENTS>

<OFERATICH-INVOKED-EVENT >
<5HDRT—NAHE>0pInvaent_ﬁervep_naximuﬂUElue(fSﬂGRT—NAMEb
<START-ON-EVENT-REF DEST="RUNNABLE-ENTITY">
JASCET ComponentTypes/SWC/bBSWC/Server MaximumValune
</ STLRRT-ON-EVENT-REF>
<OFERATICH-IREF>
<CONTEXT-P-PORT-REF DEST="P-PORT-PROTOTYPE" >
/ASCET ComponentTypes/SWC/Server</CONTEXT-P-PORT-REF>
<TARGET-PROVIDED-CPFERATICH-REF DEST="CLIENT-SERVER-OFERATION":>
fASCET Interfaces/Impl/CSInterface/MaximumValue
</ TLRGET-FROVIDED-COPERATICH-REF>
</OPERLTICH-IREF>
< /OPERLTICH-INVOKED-EVENT >
< /EVENTS>
<RUNHABLES>
<RUNNABLE-ENTITY>
<SHDRT—NAHE>Servep_yaximumvalueCISHDRT—NAHE>
<SW-ADDR-METHCD-REF :EST=“SW—ADDR—HETEDD”>EASCET_ﬁddrH6thodstDDE
</ SW-LDDR-METHOD-REF>
<CAN-BE-INVOEED-CONCURRENTLY>false</CAN-BE-INVOKED-CONCURRENTLY >
<5YHEDLbSNQ_;mpl_Server_ﬂaximumvalue<!SYHEDL>
</RUNHLEBLE-ENTITY>

< /RUNNABLES>
</ SWC-INTERNAL-BEHAVIOR>

Listing 80: ARXML code — internal behavior responding to a server request (AUTOSAR
R4.0.2)

An <OPERATION-INVOKED-EVENT> must be named using the <SHORT-NAME> element.
The name is used within other elements to reference the event. The short-name does not
need to be a valid C identifier.

8.6.1 Concurrent Invocation of Servers

When a runnable acting as a server is written to be invoked concurrently, then the RTE can
optimize invocation by clients on the same ECU to a direct function call. This means that no
queuing is required (or possible) and therefore multiple invocations of the server can occur
concurrently.

The RTE generator needs to know which runnable entities can be called in this way.
To enable concurrent invocation of a server:

= In the "Outline" tab of the software component editor, double-
click the server runnable server MaximumValue.
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The server runnable Sserver MaximumValue was automatically
inserted by ASCET when the Pport server was created in
section 7.1.1, Provided Ports, on page 87.

The dialog "Runnable Signature Editor for:
Server_MaximumValue" opens.

= Select the "Settings" tab.
= Activate the Can be Invoked Concurrently option.

';E’H Runnakle Signature Editer for: Server_MaximumValue @

Local Variable

Settings

Properties

Can be Invoked Concurrently

Minirmum Start Time {ms)
0.0

K ] [ Cancel

Figure 52: Setting Can be Invoked Concurrently for the runnable
Server MaximumValue

= Close the runnable signature editor with OK.
Concurrent invocation is defined within the server's runnable entity definition as follows:

<RUNNABLE-ENTITY>
<SHCORT-HAME>rServer MaximomValue</SHORT-HNAME>
<CAMN-BE-INVOEED-CONCUREENTLY>trne</CAN-BE-INVOEED-CONCURRENTLY >
“SYMBCL>Swe Tmpl Serve r_Maximum".Taluem"SYHE oL

< /RUNHABLE-ENTITY>>

Listing 81: ARXML code — server runnable with concurrent invocation (AUTOSAR R3.1.2)

<RUNHABLE-EMTITY>
<SHORT-HAME>rServer MaximomValune</SHORT-NAME>
<5SW-ADDR-METHOD-REF DEST="SW-ADDR-METHOD">/ASCET AddrMethods/CODE
</ 5W-ADDRE-METHOD-REF>
< CAN-BE-INVCEED-CCHCURRENTLY »true< /CAN-BE-INVCEED-CONCURRENTLY >
{SYHEDL>SHE_;mpl_ﬁerver_ﬂaximumvaluecfﬁYHEDLb
< /RUHHABLE-ENTITY>

Listing 82: ARXML code — server runnable with concurrent invocation (AUTOSAR R4.0.2)
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Note

The runnable must be written to be invoked concurrently. If this is not the case, then
data consistency is not guaranteed when there is more than one client simultaneously
requesting the server.

8.7 Making a Client Request on a Port

Similarly, if your software component requires a client-server interface, then you must define
at least one runnable entity that acts as the client.

In ASCET, clients can access servers synchronously, which means that the client will be
blocked while the server processes the request. When the server has processed the request,
the result is passed back to the client and the client continues the execution. The user has to
ensure that the client is triggered by an RTE event.

To make a client request on a port:

= Add an Rport client to Swc, as described in section 70 create a
client on page 95.

= Drag the Rport client from the "Outline" tab and drop it in the
drawing area of the software component editor.

= Deactivate the method Notification, as described on page
95.

= Insert a signed discrete variable, name it A, and implement it as
a sint16 with implementation range [-32768, 32767].

= Connect A to the argument Inputa of the Rport client.

= Create the signed discrete variables 8 and ¢ with the same
implementation as A.

= Connect B to the argument TnputB of Client.
= Connect C to the argument outputMaximum of Client.

4g "= Use the RTE Invoke button to create an RTE Invoke operator
: and place it in the drawing area.

= Connect the return value of the operation Maximumvalue to the
RTE Invoke operator.

= Choose the runnable RunnableEntity in the tree pane and
double-click on the empty sequence call InvokeOp.

ASCET will automatically assign a sequence number to
InvokeOp within the runnable RunnableEntity, i.e. the sequence

5.

............. ‘ L e e
—Pl?}—'* IrputA CsInterface [
............. InpUtB Eﬂ

. 'II[B ......... S

—[[ AN JutputMaximum Maximumyalue ='@|| .
e ] i i .
....................... C|IEI‘|t P e e e e e

Figure 53: Request on Rport Client to compute Maximumvalue (A, B) and storeitin C

Runnable entities that need to call a server synchronously must define a synchronous server
call point. The <SYNCHRONOUS-SERVER-CALL-POINT> element defines which operations
the client can call, and specifies a global <TIMEOUT> value for all called operations. The
<TIMEOUT> specifies the maximum time that the client will wait for any of the servers
providing an operation.
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<RUNNABLE-ENTITY>
< SHORT-NAME >RunnableEntity</SHCORT-NAME:>
<CAN-BE-INVOKED-COMNCURRENTLY>false< /CAN-BE-INVOKED-CONCURRENTLY >

<MINIMUM-START-INTERVAL>D. 0</MINIMUM-START-INTERVAL:-
<SERVER-CALL-POINTS>
<SYHNCHRONOUS-SEEVER-CALL-FOINT >
<SHORT-HEME>serverCallPointl</SHORT-HLME>
<OFERATICH-IREFS>
<OPFEBRATICH-IREF>
<R-PORT-PROTOTYPE-REF DEST="R-PORT-PROTOTYPFE">
JASCET swcomponents/Impl/Swo/Client
</R-PORT-FROTOTIYPE-REE>
<OPERATION-PROTOTYPE-REF DEST="0OPERATION-PROTOTYPE">
JASCET interfaces/Impl/CSInterface/MaximmmValue
</COPERATICH-PROTOIYPE-REF>
</OPERRTICH-IREF>
< /OPERLRTICH-IREFS>
<TIMECUT>0«/TIMECQCTT>
</ 3YNCHRONCOUIS-3ERVER-CRLL-POINT >
< /SERVER-CLRLL-FOINTIS>
<5YHEG:bRteRunnablE_SWC_BunnableEntity<f5YH36:>
< /RUNHLABLE-ENTITY>

Listing 83: ARXML code — runnable entity with client request (AUTOSAR R3.1.2)

<RUNHABLE-ENTITY>
<SHORT-MAME >RunnableEntity</SHORT-HLME>
<MINIMUM-START-INTERVAL>D.0< /MINIMUM-START-INTERVAL>
<SW-RDDR-METHOD-REF DEST="SW-ADDR-METHOD">/ASCET AddrMethods/CODE
</SW-ADDR-METHOD-REF>
<CAN-BE-INVCEED-CCHCURRENTLY>false</CAN-BE-INVOEED-CONCURRENTLY >

<SERVER-CALL-POINTS>
< SYNCHRCHOUS-SEEVER-CALL-POINT >
<SHORT-HAME>ServerCallPointl«</SHORT-MLME>
<OPERATICHN-IREF>
<CONTEXT-E-PCORT-REF DEST="R-PORT-FPROTOTYFE" >
/ASCET ComponentTypes/SWC/Client</CONTEXT-R-PORT-REF>
<TARGET-REQUIRED-CFPFERATICH-REF DEST="CLIENT-SEEVER-OPERATION">
FASCET Interfaces/Impl/CSInterface/MaximmmiValne
</ TRREET-REQUIRED-OPERATION-EEF>
</OPERATICH-IREF>
<TIMECUT>0«,/TIMECUT >
</ SY¥HNCHRONOUS-SERVER-CLRLL-POINT>
< /SERVER-CALL-POINTS>
<5YH3DL>RteRunnable_$wc_BunnableEntity(fSYHBDLb
< /RUNHAELE-ENTITY>

Listing 84: ARXML code — runnable entity with client request (AUTOSAR R4.0.2)

A <SNCHRONOUS-SERVER-CALL-POINT> must be named using the <SHORT-NAME>
element. The name is used within other elements to reference the call point. The short-
name does not need to be a valid C identifier, but it must pass the syntactic checks imposed
by the AUTOSAR schema.
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Note

The global <TIMEOUT> value for all the called operations is always set to 0 in ASCET.

For the ASCET-generated C code, refer to section 10.4.2, Making a Client Request on a Port,
on page 154.

The same runnable entity can be used as a server on one interface and client on another
interface. For example, you may create a runnable entity that handles a server request for
sorting on a Pport and uses an auxiliary operation on an Rport.

8.8 Interrunnable Variables

In non-AUTOSAR projects, ASCET messages can be used for inter-process communication.
These messages are not available in AUTOSAR software component. Instead, interrunnable
variables are used for communication between different runnable entities.

Communication via interrunnable variables is equivalent in semantics to implicit/explicit
sender-receiver communication (see also section 6.1, Sender-Receiver, on page 62), but
within the scope of the software component instance.

To specify interrunnable variables:

El = In the software component editor, use the Interrunnable
Variable button to add an interrunnable variable.

The "Properties for Scalar Element: interrunnable" dialog window
opens.

= Name the interrunnable variable TRV explicit.
= Set the "Internal Access" to Explicit.

= Select a "Basic Type", e.g. Unsigned Discrete.
= Close the properties editor with OK.

= Create a second interrunnable variable IRV implicit with
Implicit internal access.

= Implement both interrunnable variables as sint8 (see Figure
10).

In AUTOSAR R3.1.5 or lower, an interrunnable variable is specified in an <INTER-
RUNNABLE-VARIABLE> element. The <COMMUNICATION-APPROACH> element determines
whether the variable uses implicit or explicit access.
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<INTERE-RUNMNAELE-VREILBLES>

<INTER-RUNMABLE-VARILBLEX
<SHGRT—HRHE>IR?_§xplicit(fSHGRT—HEHE>
<SW-DATE-DEF-PROFS>

<SW-CRLIBRATION-ACCESS>READ-ONLY«/SW-CRLIBRATION-LCCESS>

</ 5W-DATR-DEF-FROFS>
<TYPE-TREF :EST=“INTEGER—TYPE”>fAUTOSAR_typestIntB(fTYPE—TREF}
<COMMONICATION-AFFROARCH>EXPLICIT</COMMUNICATION-APPROLCH>
<INIT-VRLUE-REF DEST="INTEGER-LITERAL">/ASCET types/constants/c_nint80/value
</ INIT-VALUIE-REF>

</ INTER-RUNHASLE-VARIASLE >

<INTER-RUNMAELE-VRRILELE>
{SHGRT—HEHE>IHq_imp1icit{ISHORf—HﬁHE>
<SW-DATER-DEF-PROES>

<SW-CRLIBRATION-ACCESS>READ-ONLY </ SW-CALIBRATION-LCCESS>

</ 5W-DATL-DEF-FROES>
<TYPE-TEEF :ESI=“INTEGER—TYPE”>fADTOSAR_ﬁypestIntB<f:YPE—TREF}
<COMMUNICATION-APFROACH>IMPLICIT«,/COMMUNICATION-AFPROACH>
<INIT-VRLUE-REF DEST="INTEGER-LITERAL">/ASCET types/constants/c ninté6/value
</ INIT-VALUE-REF>

</ INTER-RUNHAEBLE-VARIAELE>

</ INTER-RUNHABLE-VARIAELES>

Listing 85: ARXML code — explicit and implicit interrunnable variables (AUTOSAR R3.1.2)

In AUTOSAR R4.0.*, an interrunnable variable is described in @ <VARIABLE-DATA-
PROTOTYPE> element. Explicit and implicit interrunnable variables are stored in different
elements of the <SWC-INTERNAL-BEHAVIOR>, i.e. <EXPLICIT-INTER-RUNNABLE-
VARIABLES> (see Listing 86) and <IMPLICIT-INTER-RUNNABLE-VARIABLES> (see
Listing 87).

<EXFLICIT-INTER-EUNHABLE-VARILBLES>
<WVRRIRBLE-DATE-FROTOTYFE
<SHGRT—HEHE}IRf_axpliGit<fSHORT—HAHE>
<SW-DATL-DEF-FROES>
<SW-DATA-DEF-PFROPS-VARIANTS>
<SW-DATL-DEF-FROPS-CONDITICHAL>
<SW-LDDR-METHCD-EREF :EST=“SW—ADDR—HETHDD“}IASCET_AddrMEthodSIRAM
</ 5W-LRDDR-METHOD-REF>
<SW-CRLIBRATICHN-ARCCESS>READ-ONLY<,/SW-CALIBRATICH-RCCESS>
< SW-IMPL-FOLICY»STANDARD <,/ SW-IMFL-POLICY >
</ SW-DATA-DEF-FROFS-CONDITICNAL>
</ SW-DATA-DEF-FROFS-VARIRNTS>
</ SW-DATL-DEF-FROES>
<TY¥PFE-TREF LEST="APPLICATIOCH-PRIMITIVE-DATA-TYFE">
FASCET Types/ApplicationDataTypes/UInt8</TYFE-TREF>
<INIT-VALUE>
<HNUMERICAL-VALUE-SPECIFICATIOH>
<VLLUE>0</VALUE>
</ HNIMERICAL-VALUE-SFECIFICATICN>
</ INIT-VLLUE>
</VARRILBLE-DATR-PROTOTYFE>
< /EXFLICIT-INTER-RUNNABLE-VARILABLES>

Listing 86: ARXML code — explicit interrunnable variable (AUTOSAR R4.0.2)
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<IMPFLICIT-INTER-EUNHABLE-VAREILBLES>
<WVRRIRERLE-DRTR-FROTCTYFE:
<SHORT-NAME>IEV implicit</SHORT-NAME>
<SW-DATL-DEF-FROES>
<SW-DATL-DEF-FROPS-VARIANTS>
<SW-DATL-DEF-FROPS-CONDITICHAL:>
<SW-LDDR-METHCD-EREF :ES?=“SW—ADDR—HETHDD“}fASCET_AddFHEthodeRAH
</ E5W-ADDR-METHCD-REF>
<SW-CRALIBRLATICHN-ACCESS>READ-ONLY< /SW-CRALIBRLATICHN-RCCESS>
< SW-IMPL-POLICY>STANDARD< /SW-IMPL-POLICY >
</ SW-DATL-DEF-PROFPS-CCOMNDITICHNAL>
</ SW-DATL-DEF-PROFS-VARILANT S
</ SW-DATL-DEF-PROFS>
<TY¥PE-TREF DEST="APPLICATION-PRIMITIVE-DATA-TYFE">
FASCET Types/ApplicationDataTypes/UInt8</TYFE-TREF>
<INIT-VALUE:>
<NUMERICAL-VALUE-SPECIFICATICH>
LVLRLITE>6< LUE>
</ HMOMERICAL-VALUE-SPECIFICATICN>

/ INIT-VLLUE>

< SV ABLE-DATR-FROTOIYFE>
</IMPLICIT-INTER-RUNNABLE-VARIABLES>

Listing 87: ARXML code — implicit interrunnable variable (AUTOSAR R4.0.2)

Each interrunnable variable must be named using the <SHORT-NAME> element. The name
is used within other elements to reference the interrunnable variable.

8.8.1 Read and Write Access

Each runnable entity must explicitly specify whether it reads or writes an interrunnable
variable at runtime.

F10/runnable /5 ModeRunnable
Ha—

100 E
IRV _explict sdisc

:IE|

#15/runnable

[ =]
IRY_implicit
Figure 54: Interrunnable variables used by two runnable entities

In AUTOSAR R3.1.5 or lower, access is declared within <READ-VARIABLE-REFS> and
<WRITTEN-VARIABLE-REFS> elements. The example shown in Figure 54 results in the
following description for the involved runnables:
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<RUNNABLE-ENTITY>
<SHORT-NLME >ModeRunnable< /SHORT-HLME >
<CAN-BE-INVOKED-CONCURRENTLY>false</CAN-BE- INVOKED-CONCURRENTLY >
<MINIMUM-START-INTERVAL>D.0< /MINIMUM-START-INTERVAL>
< REARD-VREILEBELE-REFS>
<RELD-VRRILBLE-EEF LDEZT="INTER-REUNHABLE-VARIARLE">
JASCET swoomponents/Impl/bSwo/IRV explicit</RERD-VARILBLE-REF>
<RELD-VRRILBLE-EEF LDEZT="INTER-REUNHABLE-VARIARLE">
JASCET swoomponents/Impl/bSwo/IRV implicit</RERD-VARILBLE-REF>
< /RELD-VLRILSLE-REFS>
<5YHEO:>qu_IR?_ImpL_HodeRunnablE<f5YH3@l>
</ RUNNLEBELE-ENTITY>
<RUNHABLE-ENTITY>
<5HORT-NAME>runnable</SHORT-HLME:>
<CAN-BE-INVOHED-CONCURRENTLY>false</CAN-BE-INVOXED-COHNCURRENTLY >
<MTHNIMOM-START-INTERVALSD.0</MINTMOM-START-INTERVAL
<RELD-VARILABLE-REFS5>
<READ-VARIABLE-REF DEST="INTER-RUNHABLE-VARTABLE">
JASCET swcomponents,/Impl/bSwo/IRV implicit</RERD-VERILRBLE-REF>
< /RELD-VLRILELE-REFS>
<5YH30:>qu_1mpl_punnable<ISYHEG:>
<WRITIEN-VLRIAEBLE-REFS>
<WRITTEN-VARIAEBLE-REF DEST="INTER-EUNNABLE-VARTABLE">
JASCET swoomponents/Impl/bSwo/IRV explicit</WRITTEN-VARIAELE-REF>
<WRITTEN-VARTABLE-HEF DEST="INTER-REUNMNABLE-VARTABLE">
JASCET swoomponents/Impl/bSwo/IBV implicit</WRITIEN-VARIRELE-REF>
</WRITTEN-VARILELE-REFS>
</ RUNNLEBELE-ENTITY>

Listing 88: ARXML code — runnable entities with read and write access to interrunnable
variables (AUTOSAR R3.1.2)

In AUTOSAR R4.0.*, access is declared within <READ-LOCAL-VARIABLES> and
<WRITTEN-LOCAL-VARIABLES> elements. The example shown in Figure 54 results in the
following description for the runnable runnable:
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<RUNNABLE-ENTITY>
<SHORT-NAEME>runnable<,/SHORT-NAME>
<MINIMUM-START-INTERVAL>0.0</MINIMUM-START-INTERVAL>
<SW-ADDR-METHOD-REF ST="SW-ADDR-METHOD">»/ASCET AddrMethods/CODE</SW-ADDR-METHOD-REF>
<CAN-BE-INVOKED-CCNCURRENILY>»false<,/CRN-BE-INVOXED-CCNCURRENTLY>

JASCET ComponentTypes/Swo/bSwe/IRV implicit</LOCRL-VARIABLE-REF

<SHORT-NAME>Write IRV explicit</SHORT-NAME>
<LCCESSED-VARIRELE>
~VARTRBLE-REF DEST="VARIABLE-DATA-PROTOTYPE">
/ASCET ComponentTypes/Swo/bSwe/IRV explicit</LOCARL-VARIABLE-REF>

< /BCCES

RCCESSED-VARIAELE>

-NEME>Write IRV implicit</SHORT-NRME>

AT TLET T

ESSED-VARILELE>
<LOCAL-VARIARLE-REF DEST="VARIARLE-DATA-PROTOTYPE"
/ASCET ComponentTypes/Swo/bSwe/IRV implicit</LOCAL-VARIABLE-REF>

</RCCESSED-VARIAELE

</VRRILBLE- 5=
</WRITTEN

</RUNNABLE-ENTITY>

[

LOCAL-VARIABLES>

Listing 89: ARXML code — runnable entity with read and write access to interrunnable
variables (AUTOSAR R4.0.2)

Exclusive Areas

Software components that need to provide mutual exclusion over data shared by two (or
more) of their runnable entities do so by configuring exclusive areas.

The RTE generator uses exclusive area configuration to create operating system
configuration files and to optimize exclusive areas. For example, if the only components that
access a region are mapped to the same task then the entire region can be elided.

Exclusive areas are defined in the XML configuration and are associated with the runnable
entities that use them.

New in ASCET V6.2

In previous ASCET versions, exclusive areas were used to protect read/write access to
messages in an SWC. An exclusive area named ASCET exclusive area was created
automatically.

With ASCET V6.2, messages in an SWC are no longer permitted, and messages in included
ASCET modules must be mapped to AUTOSAR elements. With that, an exclusive area for
protected message access is no longer required, and ASCET exclusive area is no longer
available.

Configuration

Exclusive areas are created by means of ASCET resources.
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To create an exclusive area:

= In the software component editor, use the Resource button to
= create a resource, and place it in the drawing area.

= In the "Outline" tab, right-click the resource , select Rename
from the context menu and rename the resource to
SwcExclusiveArea

When the newly created exclusive area SwcExclusiveArea is used in the software
component (see section 8.9.3), then the <INTERNAL-BEHAVIOR>! / <SWC-INTERNAL-
BEHAVIOR>? declaration names the <EXCLUSIVE-AREAS> it uses:

<INTERNAL-BEHAAVIOR>

< SHORT-HMAME=bSwo< / SHORT-HLME>

<CCHMEPCHENT-REF DEST="APPLICATION-SOFTWARE-COMPONENT-TYPE" >
JASCET sweomponents/Impl/Swo</CCOHPCHENT-REF>

<EVENT 5>

< /EVENTS>
<EMCLOSIVE-LARELS™
<EXCLUSIVE-AREL>
< SHORT-HAME>SwoExclusiveArea</SHORT-NLME >
< /EXCLUSIVE-LEEL>
< /EXCLUSIVE-LRELS>
<RUNHABLES>

< /RUNMHABLES>

</ INTERNLL-EEHLVICOR>
Listing 90: ARXML code — exclusive area definition (AUTOSAR R3.1.2)

<SWC-INTEENAL-BEHAVICR>

< SHORT-HAME>bSWC< /SHORT-HLME >
<DATA-TYFE-MLFFING-REFSx>
<DATA-TYFE-MLFFING-REF DEST="DATA-TYPFE-MAFPTHG-SET">
FASCET Mappings/DataMappings,/Impl</DLTA-TYPE-MAPPING-REF>
< /DRTLR-TYPE-MLFFING-REFS>
<EXCLUSIVE-ARELS>
<EXCLUOSIVE-AREL>
<SHORT-HNLME>SwoExclu=ivehrea</ SHORT-HMLME >
< /EXCLUSIVE-LREL>
< /E¥CLUSIVE-LEELS>
<EVENT 5>
</EVENTS>
<RUNHABLES>

< /RUNNABLES>

</ SWC-INTERMNAL-BEHLVICOR>
Listing 91: ARXML code — exclusive area definition (AUTOSAR R4.0.2)

! AUTOSAR R3.1.5 or lower
2 AUTOSAR R4.0.*
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Note that this means that the scope of any exclusive areas that you define is the software
component instance. It is not possible to define exclusive areas that cross software
component boundaries. Data that is shared between multiple software-component instances,
which can potentially be accessed concurrently, should be encapsulated in its own
component and then normal sender-receiver or client-server communication used to access
the data.

Each exclusive area defined within an internal behavior definition must be named using the
<SHORT-NAME> element. The name is used within other elements to reference the software
component type and to form the "handle" by which the exclusive area is accessed at run-
time. The short-name of an exclusive area should be a valid C identifier.

Additionally, the RTE can be informed how to implement the exclusive area with an
ExclusiveArealmplementation element within the ECU description.

Note

If the definition of the ExclusiveArealmplementation for an exclusive area is omitted, then
the RTE defaults to "OS resource” implementation strategy.

A different exclusive area implementation method can be set for each exclusive area and
SWC instance.

Note

The InterruptBlocking method will cause all OS interrupts to be blocked in the worst case
for the longest execution time of the protected critical section.

8.9.3 Usage

Each runnable in the <INTERNAL-BEHAVIOR>! / <SWC-INTERNAL-BEHAVIOR>? section
can declare if it uses one of the named exclusive areas and how it uses the area at runtime.

ASCET defines exclusive areas with explicit access. The <RUNNABLE-ENTITY-CAN-ENTER-
EXCLUSIVE-AREA> element determines that the exclusive area is accessed using an explicit
API. The area's name forms part of the generated API (explicit access is similar to a
standard resource in OSEK OS).

In ASCET V6.2 or later, exclusive areas can only be accessed by assigning sequences of a
runnable entity in a user-defined exclusive area.

Note

Beginning with ASCET V6.2, messages and the automatically generated exclusive area
ASCET exclusive area are no longer available in software components.

To assign sequences of a runnable in an exclusive area:

= Edit the sequence call reserve of the SwcExclusiveArea and
provide the sequence number 8 in the method
RunnableEntity.

! AUTOSAR R3.1.5 or lower
2 AUTOSAR R4.0.*
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= Edit the sequence call release of the SwcExclusiveArea and
provide the sequence number 22 in the method

RunnableEntity.
....................... -
L R Interface N,
| oreserve - release JI0RuUnnableEntity
. ,-’E.IF!unn.ablaEntItv! ] #22{runnableEntity b=L] speed .
.................... SpEEdSWE Ce .
o SweExdusivedrea - L
T Receiver. . . . . ... ...
o AR PR CSinterface A
L E———— nputs C=C lneekeop
A B - /20RunnableEnkity

- [N OukputMaximunm Maximumvalle —— % | - . -
...... =

Figure 55: Use of the exclusive area SwcExclusiveArea in RunnableEntity

In the definition of the <RUNNABLE-ENTITY> element, the reference to the
SwcExclusiveArea Will be generated as shown in Listing 92 and Listing 93.

<RUNNABLE-ENTITY>

< SHORT-HAME>RunnableEnti ty«</5H0RT-NAME >

<CAN-BE-THVCOEED-CONCURRENTLY>false< /CAN-BE-THVCOEED-CONCUORRENTLY >

<CAN-ENTER-EXCLUSIVE-RREL-REF5>

<CAN-ENTER-EXCLUSIVE-AREL-EREF DEST="EXCLUSIVE-AREA" >
FASCET swocomponents,/Impl/bSwo/SwoExclusiveArea

</ CAN-ENTER-EXCLUSIVE

AREL-EEF>

B
</ CRN-ENTER-EXCLUSIVE-LREL-REFS>

<SYHECL>RteRunnable SWC RunnableEntity</SYMECL>

</RUNMAELE-ENTITY>

Listing 92: ARXML code — runnable entity with reference to exclusive area (AUTOSAR

R3.1.2)
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<RUNHAELE-ENTITY>
< SHORT-HMAME>RunnableEntity<,/SHORT-HLAME >
<CAN-ENTER-EXCLUSIVE-AREL-REFS>
<CAN-ENTER-EXCLUSIVE-AREL-EFEF DEST="EXCLUSIVE-AREA">
/ASCET ComponentTypes/SWC/bSWC/SweExclusivehArea
< /CRHN-ENTER-EXCLUSIVE-LREL-REF>
</ CLHN-ENTER-EXCLUSIVE-AREL-REFS>
<HINIMOHM-START-INTERVAL>D . 0« /MINIMUHM-5TART-INTERVAL>
<SW-ADDR-METHCOD-EEF :EST=“SW—ADDR—HETEDD”>fASCET_ﬁﬂdrﬂeth0dstDDE

</ SW-ADDR-METHCOD-REF>
<CAN-BE-INVOKED-CONCURRENTLY>false<,/CAN-BE-INVOKED-CONCURRENTLY >

{SYHEDLbRtERunnabla_ﬁwq_ﬁunnableEntity(fSYHEDLb
< /RUMHABLE-EMTITY>

Listing 93: ARXML code — runnable entity with reference to exclusive area (AUTOSAR
R4.0.2)

For the ASCET-generated C code, refer to section 10.7, Concurrency Control with Exclusive
Areas, on page 163.
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The previous chapters have explored how an AUTOSAR software-component type can be
defined and configured. In this chapter you will learn how to define application modes that
can be used by software-components to control the execution of runnable entities.

This chapter summarizes the topics related with modes of the following sections:
* 6.2, Mode, on page 67
= 8.1.3, Mode-Switch Events, on page 105

Defining Modes

Modes are declared within a <MODE-DECLARATION-GROUP> element contained in the
AUTOSAR package ASCET types. The package ASCET types contains software-
component-specific types.

In AUTOSAR R3.1.5 or lower, the ASCET types package is stored in the types file of the
software component, i.e. the generated file Swc Types.arxml.

<AE-FPACELGE>
«SHORT-NAMEXASCET types</SHORT-NAME>:
<DESC></DESC>
<ELEMENT S

<MODE-DECLARATTON-GROUE>

< /MODE-DECLARATICHN-GROUTE
</ELEMENTS

</LRE-PLCELGE>
Listing 94: ARXML code — mode declaration group (AUTOSAR R3.1.2)

In AUTOSAR R4.0.*, the ASCET Types package is stored in the application types file of the
software component, i.e. the generated file SWC appltypes.arxml.

<AE-PACHKAGE>
<SHORT-HAMErASCET Types<,/SHORT-NAME>
<AR-PRACEAGES>
<AR-PRCFAGE>
<SHORT-NAME-ApplicationDataTypes<,/SHORT-NAME:
<ELEMENT 5>
<MODE-DECLARATTON-GROUP>

</MCDE-DECLARETICHN-GROUP>

< /ELEMENTS>
</AR-PACKAGE>
< /RR-PRCHELGES>
< /BAR-PRCEAGE>

Listing 95: ARXML code — mode declaration group (AUTOSAR R4.0.2)

The <MODE-DECLARATION-GROUP> element is used to declare one or more modes that are
subsequently used by interface declarations.
To create a mode group:

= In the component manager, select Insert > AUTOSAR >
Mode Group.
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= Name the mode group OnoOf fMode.
= Create two modes, of £ and on, as described on page 67.

e "

(52 ASCET-MD-RP-SE =E =R =
File Edit View Insert Build Teels 5CM  Mode Help
BEH & -
ﬁ \Exerdses\Chapter_5_Interfaces\Interfaces\OnOffviode 5’)
1Database ® | 3 Contents i
—& {lInterfaces * (IMode
—— [y callnterface off <initial>
— m'JCSInterface an
—— [Py Modelnterface = ‘
— [’_?".N"J'Data_lnterface -
—— M onOffMode
— E%SRInterface -
4 | 1 3
2 Comment *
Fl b 4| m 3
*F none 3 d:\ETASData\ASCETS. 2\Database\AUTOSAR_UG_Tutorial g

Figure 56: Mode declaration group onOf fMode

Note

A mode declaration group resembles an ASCET enumeration. In contrast to
enumerations, the representing value cannot be set explicitly.

ASCET declares the <MODE-DECLARATION-GROUP> in the AUTOSAR package
ASCET_ types. See Listing 29 on page 68 for an AUTOSAR R3.1.2 ARXML example and
Listing 30 on page 68 for an AUTOSAR R4.0.2 ARXML example.

One mode within a <MODE-DECLARATION-GROUP> element is marked as the group's initial
mode through the <INITIAL-MODE-REF>. Mode-Switch events that are attached to the
ENTRY of an initial mode are triggered by the RTE when this is started using Rte Start.

A <MODE-DECLARATION-GROUP> can be used (referenced) by multiple mode-switch
interfaces and therefore inherently used by multiple software-components.

Mode Communication

Modes are communicated over a mode-switch interface (see section 6.2, Mode , on page
67).

In ASCET, mode-switch interfaces are realized as sender-receiver interface components that
contain mode groups.

In AUTOSAR R3.1.5 or lower, each mode-switch interface can specify zero or more mode
declaration group prototypes that define the AUTOSAR modes communicated over the
interface.
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In AUTOSAR R4.0.*, each mode-switch interface must specify one mode declaration group
prototype.

Each mode declaration group prototype defines a prototype of a specific mode declaration
group.

To create a mode group interface:

= In the component manager, select Insert > AUTOSAR >
SenderReceiver Interface.

= Name the sender-receiver interface ModeInterface.
= Double-click on ModeInterface.

The "Sender Receiver Interface Editor for: Modelnterface" editor
opens.

= Select Insert > Component.
The "Select Item ..." window opens.

= Inthe "1 Database" or "1 Workspace" field of the "Select Item"
window, select the mode group onof fMode (see also Figure 20
on page 69).

= Click OK to close the "Select Item" window and insert
OnOffMode into ModeInterface.

The "Properties for Element: OnOffMode" window opens.
= (Click OK to use the default name and comment.

The mode group interface ModeInterface now looks as shown
in Figure 21 on page 69.

The declaration of mode declaration group prototypes within a mode-switch interface
definition has the structure shown in Listing 31 on page 70 (AUTOSAR R3.1.5 or lower) or
Listing 32 on page 70 (AUTOSAR R4.0.*).

In AUTOSAR R3.1.5 or lower, a mode group is defined using the <MODE-DECLARATION-
GROUP-PROTOTYPE> element and all elements must be defined within an encapsulating
<MODE-GROUPS> element.

In AUTOSAR R4.0.*, a mode group is defined using the <MODE-GROUP> element.
Each <MODE-DECLARATION-GROUP-PROTOTYPE>/<MODE-GROUP> must specify:
= the <SHORT-NAME> that you will use to refer to the item
» the <TYPE-TREF> reference to mode declaration group

In AUTOSAR R3.1.5 or lower, a sender-receiver interface component can specify both
<DATA-ELEMENTS> and <MODE-GROUPS> in the same declaration. However, it is strongly
recommended that you add either data elements or mode groups to a single interface.

In AUTOSAR R4.0.*, a sender-receiver interface component that contains a mode group
must not contain data elements, and vice versa. Mixing both kinds of elements leads to a
code generation error.

9.3 Using Modes

A software component can be a mode user activated in response to a mode switch. In this
section you learn how to use modes in a software component.

To insert a mode group interface in a software component:

= Create and set up a project as shown in section 3.1.2, Code
Generation Settings for AUTOSAR, on page 22.

= Insert a software component Swc in the project, as described in
7o insert an AUTOSAR software component in a project on page
26.
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= In the "Outline" tab of the project editor, double-click swc to
open the software component editor.

= In the software component editor, select Insert > Component.
The "Select item..." window opens.

= Inthe "1 Database" or "1 Workspace" field of the "Select Item"
window, select the interface ModeInterface and click OK.

The "Properties for complex element: Modelnterface" opens.
= Click OK to accept the default settings.

Software Component Initialization and Finalization

AUTOSAR modes can be used to execute code when the RTE is started, e.g. to initialize
internal data structures, etc. Similarly, when a system is shut down your software
component may need to store data, log operational details, etc.

Each mode declaration group describes an initial mode — to activate a runnable when the
system is started created by a <MODE-SWITCH-EVENT>' / <SWC-MODE-SWITCH-EVENT>?
for entry to the initial mode.

To create a mode-switch event:

= In the "Software Component Editor for: Swc", go to the "Event
Specification" tab.

= Select Event 2 Add Event and name the event ModeEvent.
= In the "Event Kind" combo box, select ModeSwitch.

= Set the following mode switch settings (see also Figure 42 on
page 105):

— Activation: entry
— Assigned Mode: On: :OnOffMode

A runnable entity within a software component can be started when the RTE is started by
declaring a <MODE-SWITCH-EVENT> / <SWC-MODE-SWITCH-EVENT> for entry to an initial
mode.

Triggering a Runnable Entity on a Mode-Switch

A runnable entity can be activated on either entry or exit from a mode using a Mode-Switch
event configured, like all other events, in the <INTERNAL-BEHAVIOR>! / <SWC-
INTERNAL-BEHAVIOR>? element of a software component.

To create a runnable entity:

= In the "Software Component Editor for: Swc", select a diagram
(e.g., Main) in the "Outline" tab.

= Select Insert & Runnable and name it ModeRunnable.
For details on runnable entities, refer to section 8.2, Runnable Entities, on page 107.

If RunnableEntity is defined for entry, the runnable entity must be of Category 1. This
means that it must not make any (blocking) RTE calls nor access other application
components.

Similarly, when a system is defined for exit, your software component may need to store
data, log termination etc. The principle is the same as initialization, except that finalization is
simply a transition to a new mode that is simply associated with shutdown.

! AUTOSAR R3.1.5 or lower
2 AUTOSAR R4.0.*
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To add a Mode-Switch event to a runnable:

= Go to the "Event Specification" tab of the "Software Component
Editor for: Swc".

= In the "Events" field, select the event ModeEvent.
= In the "Runnables" field, select the runnable ModeRunnable.
= Select Event - Assign Event or click the >> button.

Events Runnables lﬂ;

+HH

= GngDdESwitd'l (ModeSwitch - entry - on::0n w |
el

[¥] off::OnoffMode (ModeInterface/OnO I—E| {%Modeﬁwitch (ModeSwitch - entry - oni:OnOffh E

[¥] on::0nofMode (Modelnterface fOnCr off::OnCffMode (ModeInterface /OnOffivode) E
on::0OnOffvode (Modelnterface fOnCffMode) ]

=

Event Kind: =
MadeSwitch - —

Mode Switch Settings
Activation @ entry (7 exit

Assigned Mode:

BLdde ) abessaly @

Inn: :0nOffMode (Modelnterface /OnOfv v]

LopREd |y aeds JuAd S}\& asmolg FE | uogedlynad

Figure 60: ModeEvent is assigned to ModeRunnable

When the Mode-Switch event is mapped to a runnable entity, then ASCET generates the
<MODE-SWITCH-EVENT>! / <SWC-MODE-SWITCH-EVENT>? element in the configuration
language as shown in Listing 63 on page 106 (AUTOSAR R3.1.2) or Listing 64 on page 106
(AUTOSAR R4.0.2).

A <MODE-SWITCH-EVENT>/<SWC-MODE-SWITCH-EVENT> element defines the following
things:
1. The <START-ON-EVENT-REF> element defines the runnable entity to be activated.
The reference must be to a runnable entity within the same software component type.

2. The <ACTIVATION> element defines whether the runnable entity is triggered on
entry to, or exit from, the mode. ASCET supports the text ENTRY or EXIT. A Mode-
Switch event can apply either to entry to a mode or exit from a mode, but not to
both. If runnable activation is required for entry and exit, then two Mode-Switch
events must be defined.

3. The <MODE-IREF> element defines the mode associated with the Mode-Switch event.
The <MODE-IREF> element must contain three references (the port prototype, the
mode declaration group prototype and the mode declaration group that types the
declaration group prototype).

One mode within a <MODE-DECLARATION-GROUP> element is marked as the group's initial
mode. Any Mode-Switch events that are attached to the entry of an initial mode within any
group are triggered by the RTE when this is started using Rte Start.

! AUTOSAR R3.1.5 or lower
2 AUTOSAR R4.0.*
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Note

When more than one runnable entity is triggered by the same mode entry (or exit), the
order of execution of runnable entities is not defined. For portability, therefore, a system
should not rely on a particular execution order.

9.3.3 Disabling Modes

A <MODE-DEPENDENCY>' / <DISABLED-MODE-IREFS>? element permits the behavior of
an event to be different in different modes. This allows such use cases as the activation of a
runnable entity to be suppressed/permitted when a certain mode is active.

To disable the activation of a runnable:

= In the software component editor, go to the "Event Specification”
tab.

= In the "Events" pane, select the event ModeEvent.
= Disable the mode off.

Events Runnables
[+ H
Bl ﬁMDdESwitch (ModeSwitch - entry - on::On = @ ModeRunnable b
=)
M off::onOffMode (Modelnterface/Ono I—EI %ModeSwib:h (ModeSwitch - entry - on::OnOffh ﬁ
[+] on::0nofMode (Modelnterface fOnOr on::0nOffvode (Modelnterface /OnOffiMode) E
o
=
4| n 3 - z
=
Event Kind: =
[ModeSwitch v] |

Mode Switch Settings
Activation @) entry () exit

Assigned Mode:

Budde | abEssa) Ej

[on: :0nOffMode (ModeInterface OnOffv V]

LopEIyRads s & asmoug [ | uoealypads 5
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Figure 61: Mode of f disabled in ModeEvent

The <MODE-DEPENDENCY>! / <DISABLED-MODE-IREFS> element specifies the disabled
modes:

! AUTOSAR R3.1.5 or lower
2 AUTOSAR R4.0.*
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<MCDE-SWITCH-EVENT>
< SHORT-MREME>ModeEvent</SHORT -HNAME >

<MCDE-DEPENDENCY >
<DEPENDENT-CN-MODE-TIREFS>
<DEPENDENT-CH-MCDE-IREF>
<R-PCRT-FROTCTYPE-REF DEST="R-PORT-FROTOTYFE">
JASCET swoomponents/Impl/Swo/ModeInterface</R-FPORT-FROTOTYFE-REF:
<MODE-DECLARLTICON-GROUP-PRCTCTYPE-REF
DEST="MODE-DECLARATION-GROUP-FPROTOTYPE" >
[ASCET_interfaces/Impl/ModeInterface/0On0ffMode
</ MODE-DECLARATICH-GROUP-PROTCTYFE-REF>
<MODE-DECLARATICHN-REF :ESI=“HDDE—DECLARATIDN”>fh£CET_ﬁypestanfMode!off
</MODE-DECLARATION-REF>
< /DEPENDENT -ON-MODE-TREF>
<DEPENDENT-CN-MODE-IREFS>
</MODE-DEPENDENCY>

<STRRT-CH-EVENT-REF LDEST="RUNHABLE-ENTITY">

/ASCET swoomponents/Impl /bSwe/ModeRunnable</5TART-CH-EVENT-REF>

<ACTIVATION>ENTRY</ACTIVATION>

<MCDE-IREF>
<R-PCORT-PFROTCTYFE-REF DEST="R-PORT-PROTOTYPE" >
FASCET swoomponents/Impl/Swo/ModeInterface</R-FORT-FROTOTYPE-REF>
<MODE-DECLARATICH-GROUP-PROTCOTYFE-REF DEST="MODE-DECLARATION-GROUP-PROTOTYPE" >
FASCET interfaces/Impl/ModeInterface/0On0ffMode
</HMODE-DECLARATION-GROUP-PROTOTYPE-REF >
<MODE-DECLARATICN-REF :EST=”HODE—DECLARATION“>thCET_ﬁypestnOffModefon
</HMODE-DECLARRTION-REF>

< /MODE-IREF>

< /MODE-SWITCH-EVENT>

Listing 96: ARXML code — definition of a Mode-Switch event with disabled mode (AUTOSAR
R3.1.2)
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<SWC-MCDE-SWITCH-EVENT>
<SHORT-NEME >ModeEvent</ SHORT-HAME >
«DISRELED-MCDE-IREFS>
<DISABLED-MODE-IREF>
<CONTEXT-PORT-REF DEST="R-PORT-PROTOTYPE">
/ASCET ComponentTypes/SWC/ModeInterface</CONTEXT-FORT-REF>
<CONTEXT-MCDE-DECLARATICH-GROUP-PROTOTYPFE-REF DEST=
"MODE-DECLARATION-GROUP-FROTOTYPE" >
JASCET Interfaces/Impl/ModeInterface/On0ffMode
</CONTEXT-MODE-DECLARATION-GROUP-PROTOTYFPE-REF>
<TARGET-MCDE-DECLARATION-REF DEST="MODE-DECLARATION":
JASCET Types/ApplicationDataTypes/0OnOffMode/off
</TLRGET-MODE-DECLARATION-REF>
</DISABLED-MODE-IREF>
</DISLELED-MODE-IREFS>
<5TART-CH-EVENT-REF DEST="RUNNABLE-ENTITY" >
JASCET ComponentTypes/SWC/bSWC/ModeRunnable<,/STRRT-0ON-EVENT-REF>
<ACTIVATICH>ON-ENTRY< /LCTIVATICH>
<MCODE-IREFS>
<MODE-TREF>
<CONIEXT-PCRT-REF DEST="R-PORT-PROTOTYFE">
/ASCET ComponentTypes/SWC/ModeInterface</CONTEXT-FORT-REF>
<CONTEXT-MCDE-DECLARATICH-GROUP-PROTOTYPFE-REF DEST=
"MODE-DECLARATION-GROUP-FROTOTYPE" >
JASCET Interfaces/Impl/ModeInterface/On0ffMode
</CONTEXT-MODE-DECLARATION-GROUP-FROTOTYFPE-REF>
<TARGET-MCDE-DECLARATION-REF DEST="MODE-DECLARATION"
JASCET Types/ApplicationDataTypes/0OnOffMode/on
</TLRGET-MODE-DECLARATION-REF>
</MODE-IREF>
</MODE-IREFS>
</ SNWC-MODE-SWITCH-EVENT>

Listing 97: ARXML code — definition of a Mode-Switch event with disabled mode (AUTOSAR
R4.0.2)

When the mode specified within the <MODE-DEPENDENCY>' / <DISABLED-MODE-IREFS>?
element is active, the RTE will not activate the runnable (the activation is discarded).

For more information about the implementation of mode instances, please refer to the RTA-
RTE User Guide.

! AUTOSAR R3.1.5 or lower
2 AUTOSAR R4.0.*
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10 Implementing Software Components

This section shows how to model software components in ASCET so that the objects
required by the RTE are declared, and how to use the RTE API generated by the RTE
generator.

10.1 Basic Concepts

10.1.1  Namespace

All RTE symbols (e.g. function names, global variables etc.) that are visible in the global
namespace use either the prefix Rte or the prefix RTE .

Note

You must not create symbols that use either the prefix Rte or the prefix RTE to
remove the possibility of namespace clashes.

10.1.2  Runnable Naming Convention

The RTE generator generates code that activates your runnable entities. To do this, the
RTE's internal mechanisms need to be able to access your code through defined interfaces.

Each of the named runnable entities defined in your runnable entity <syMBOL> declarations
must be implemented. Failure to define all runnable entities will be detected at compile time
when your application is linked to form the ECU's executable image. The linker error
message will reference the missing runnable entity entry point.

Runnable entities are executed by RTE-generated code when required. The function
providing an entry point for a runnable entity should not be invoked directly by an
application software component.

10.1.3  API Naming Convention

The RTE API calls are generated for each software component using names derived from the
RTE generator's input. The RTE API provides a consistent interface to each software
component but allows the RTE generator to provide different implementations of the API
functionality.

Each API call name is formed from:
» The prefix Rte
» The call functionality (read, write etc.)
= Either

— The port name and data item name (sender-receiver) or operation name (client-
server) through which the call operates

or

— The name of the object (e.g. exclusive area) upon which the call operates
Thus RTE API calls involving communication through ports have the format:
Rte StatusType Rte <API call name> <port> <dataitem/operation>

Whereas other RTE APIs have the format:
Rte StatusType Rte <API call name> <object name>
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10.1.4  API Parameter Passing Mechanisms

The RTE API calls may have one or more parameters. The API parameters (if any) fall into
one of three classes:

= "In" Parameters — All "in" parameters that are AUTOSAR primitive data types (with the
exception of a string) are passed by value. Strings and other "in" parameters that are
of a complex data type (i.e. a record or an array) are passed by reference.

Note that while AUTOSAR defines a string as a primitive data type, its inherent size
makes it inefficient to pass by value and is therefore treated the same as a complex
data type.

"In" parameters are strictly read-only.

= "Out" Parameters — All "out" parameters are passed to RTE API functions by
reference. This is required to ensure that the API functions can modify the parameter.

"Out" parameters are strictly write-only.

= "In/Out" Parameters — All "in/out" parameters are passed to the RTE API functions by
reference except for an asynchronous client-server call when primitive data types
(other than strings) are passed by value to Rte_Call and by reference to Rte_Result.

"In/out" parameters can be read and written by the API function being called.

Note

ASCET configures the identifiers of the API parameters in the XML configuration file
specified in the project properties (see To define a memory sections definition file on
page 24). The standard configuration of the AUTOSAR memory sections is provided in the
exemplary files memorySections Autosar.xml and

memorySections Autosar4.xml.

When generating code in an AUTOSAR project, ASCET load's the memory sections defined
in the specified XML file. Changes in the * . xm1 file will only be taken into account if the
user performs Build - Touch = Recursive before the code generation is started.

10.2 Application Source Code

ASCET is a C code generator and the RTE also generates C code. ASCET V6.2 supports, at
present, single-instance software components.

10.2.1  Application Header Files

Each software component generated in ASCET includes the relevant application header file
created during RTE configuration.

H#include "REte SoftwareComponentiName.h"

&* Component implementation for " SoftwareComponent MName" * S
Listing 98: C code - include application header file

The RTE API is specific to each software component type and therefore it must be included
only in the component's application header file for each source code file that defines a
component (whether completely or partially).
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Note

ASCET includes the header files in the application software when exporting the generated
code into a storage directory (see how to generate code in a project in section 3.1.4,
Code Generation, on page 26). The user shall not use intermediate files taken from the
code generation directory.

A single source module must not include multiple application header files as the API
mappings they contain may be different for different software components. The header files
generated by the RTE generator protect against such multiple file inclusion.

The component type specific header file defines the component's RTE API.

10.2.2  Entry Point Signature for Runnable Entities

The user models in ASCET the implementation of the runnables in the software component.
ASCET generates the source code of all the runnable entities required to make a software
component work at runtime.

ASCET provides an entry point (i.e. a C function) for each <RUNNABLE-ENTITY> declared in
the component description.

* begin region Runmable Definition RunmableEntit =
# BEGIN: DEFINITION OF EUMHAELE 'Swc Impl RunnableEntit
* model name: BEunnableEntit
¥ memor a0 = 3 = CODE
/% messages used by this runnable */
/% public BEunmableEntity () ®F
FUMC (void, CODE) Swc_Impl RunnableEntity (vold)

{

t
Listing 99: C code — entry point for runnable entity

The signature of a runnable entity entry point function follows the following implementation
rules:

= There are no user-defined parameters.
= There is no return value (i.e. a return type of void must be specified).
= The memory class must be CODE.

All RTE events other than Operation-Invoked events use the same basic signature for
runnable entity entry points, irrespective of the event that actually triggers the runnable
entity.

If the runnable entity responds to an <OPERATION-INVOKED-EVENT>, then additional
parameters may be required.
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* bhegin region Runnable Definition Server MaximumValue *

# BEGIN: DEFINITICHN OF RUNNABLE 'Swc Impl Server MaximumValue'

*omodel MAMS: v . e e s n s nnsan s n s a s 'Server MaximumValue'
¥ IMEIOTY ClaSS: . e e eanrsannsasnanssnnnnnnnsnsnns '"CCDE"

* messages used by this runnable #*

#

sdizc:InputE: tsdizc:;0utputMaximam: : =di=c) =

FUMC (void, CODE) Swc_Impl Server MaximumValue (
f* IN #/ VAR (35Intlé, AUTCMATIC) Inputh,
S IN #/ VAR (5Intle, AUTCMATIC) InputB,
J= OUT =/ CONSTP2VAR(5Intlée, AUTCMATIC, RTE APPL DATA) OutputMaximum

{
/* Server MaximumValue: segquence call #5 */
JS#% assignment to CutputMaximum: min=-32768, max=32767, hex=phys,
limit=(maxBitLength: true, asszign: true), zero incl.=true */f
(*CutputMaximum) = ((Inputh >= InputB) ? Inputhk : InputB):

}

Listing 100: C code — server runnable entity

The signature of a runnable entity entry point function invoked as a result of an Operation-

Invoked event follows the following implementation rules:

»= There is a return value when a server specifies application errors, in which case
Std ReturnType is used.

» Formal parameters are the operations IN, IN/OUT and OUT parameters. These
parameters are passed by value or reference depending on the type.

= The memory class must be CODE.

Sender-Receiver Communication

The RTE API calls for handling non-queued sender-receiver communication differ for the
type of data access.

» Non-queued communication with explicit access
— Send with Rte Write
— Receive with Rte Read
— Receive with Rte Dread (AUTOSAR R4.0.%)

Non-queued communication with explicit access can be optionally implemented with

status.
» Non-queued communication with implicit access

— Send with Rte IWrite
— Receive with Rte IRead
The implicit API uses a locally cached copy of data to preserve consistency over a

calling runnable entity invocation. Data is read into a global cache before the runnable
entity starts executing and is written from the global cache after the runnable entity

terminates. Data writes are done once, no matter how many times it is written.

The RTE guarantees cached data does not change during execution of the runnable

entity.

ASCET V6.2 AUTOSAR User’s Guide

145



ETAS Implementing Software Components

The implicit API should be used when you need to guarantee that every access to a
datum in a runnable entity will provide the same result irrespective of how many
times it is accessed during an invocation of the runnable entity.

The following sections show how to use these sections in your application.

10.3.1 Sending to a Port

Sending to a Port with Explicit Communication

Components communicate data to other components using the Rte Write call. The call is
defined per port and interfaces data item for each component and therefore has the
following signature:

Rte StatusType Rte Write <Port> <Dataltem>(DataltemType Data)
For the example of section 8.4.1, Explicit Communication,

-
SRInkterface

Speed m

ASCET generates the following C code:

FUNC(void, CODE) RteRunnable SWC RunnableEntity (void)
{
S* temp. wvariables =/

VAR (Std ReturnType, AUTCHMATIC) ASCET Rteltatus;

/% RunnableEntity: =segquence call #5 */f

SCET RteStatus = Rte Write Sender Speed| ) :

I

t
Listing 101: C code — explicit send (example of section 8.4.1, Explicit Communication)

Sending to a Port with Explicit Communication with Status

Explicit access can be optionally implemented with status.
To set explicit communication with status

= Open the ARProject project and Swc software component from
the example in section 8.4.1, Explicit Communication, on page
110.

= In the drawing area of the software component editor, right-click
the RTE access operator and select Access 2> Explicit with
Status from the context menu (see Figure 62).
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SRInterface

Speed Fl-b

Views, ..

Fill Color. ..
Show Sequence Calls

Browse Connected Elements

Implicit

E:xplicit

v Explicit with Status

Figure 62: Setting explicit communication with status.

5 "

RTE_E_NO_DATA

- =
EFLUH

-

T

Use the RTE Status button to create an RTE Status operator
and place it in the drawing area.

Use one of the * Literal buttons to create a literal, and place the
literal in the drawing area.

Edit the literal (see the online help for details) and enter one of
the status/error values listed in section Std_ReturnType, on page
39.

This example uses RTE E NO DATA.,

Add a logic variable nhamed, e.g., noData.

Covert the variable's sequence call into a connector (see the
online help for details).

Add an Equal operator.

Connect literal, RTE status block, operator and variable as shown
in Figure 63.

Connect the pin below the RTE Status block with the connector
of the variable noError.

v
Speed

JERunnableEntity

SRInterface

Spesd m

Sender

Figure 63: Sending a value 120 to a sender port using explicit communication with status

For the example, ASCET generates the following C code:
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#define noData Swc RAM.noData
FUNMC {(void, CCDE) ERteRunnable SWC RunnableEntity (void)
{

S* temp. wvariables */f

VAR (Std ReturnType, AUTCHMATIC) ASCET Rteltatus:

/* RunnableEntity: segquence call 5 */f

_ASCET Rte3tatus = Rte Write Sender Speed|( yo:
if ( ASCET RteStatus != RTE E OK)
{

f#* RTE ExplicitWithStatus-block: sequence call #Explicit write
error/Status §#1 */
nolData = ASCET Rtebtatus = RTE E H{O DATA;

Listing 102: C code — explicit send with status

Sending to a Port with Implicit Communication

The implicit API includes a reference to the runnable entity that is declared as accessing the
data in the API name. Care should be taken when writing a runnable entity to invoke the
correct API. The Rte IWrite API reads data:

Rte StatusType Rte IWrite <runnable> <port> <data>( DataltemType
Data)

The cache is updated before the runnable entity starts. Rte IWrite writes datato a
cached copy and changes are only made visible after the runnable entity terminates
irrespective of the number of times the data is written.

For the example of section 8.4.2, Implicit Communication,

ASCET generates the following C code:
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FUNC (void, CODE) RteBunnable SWC RunnableEntity (vold)

{
/% Runnable Entity sequence call F10 =
JS* Bender.Speed: min=-32768, max=32767, hex=phvs,
limit=(maxBitlLength: true, assign: true), zero incl.=true */

Ete IWrite Runnable Entity Sender Speed( b s
}

Listing 103: C code — implicit send (example of section 8.4.2, Implicit Communication)

Receiving from a Port

Receiving from a Port with Explicit Communication

Components receive communicated data items from other components using the Rte Read
call. The call is defined per port and interfaces data item for each component and therefore
has the following signature:

= AUTOSAR R3.1.5 or lower

Rte StatusType Rte Read <Port> <Dataltem>(DataltemType* Data)
= AUTOSAR R4.0.*

Rte StatusType Rte DRead <Port> <DataItem> ()

For the example of section 8.5.1, Explicit Data Read Access,

SRInterface

w Speed

..... Receiver

ASCET generates the following C code:
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fdefine _Speed3wc Swc RAEM. SpeedSwc

FUNC (void, CCDE) ERteRunnakble SWC RunnableEntity (wvoid)
{
f* temp. wvariables */f
VAR (5td ReturnType, RUTOMATIC) LASCET RteStatus;
VAR (5Intlé, AUTCOMATIC) tS5peed;

J* BunnableEntity: segquence call 10 =/f

_ASCET Rteltatus Rte Read Receiver Speed(&(_tSpeed)):

/#% assigmnment to SpeedSwc: min=-32T768, max=32767, hex=lphys+0,
limit=(maxBitlLength: true, assign: true), zZero incl.=true */

_SpeedSwc = _tSpeed;
}

Listing 104: C code — explicit receive (example of section 8.5.1, Explicit Data Read Access;
AUTOSAR R3.1.2)

fdefine Speed SWC SWC RAM.Speed SWC

FUONC(void, SWC_CODE) RteRunnable Swc RunnableEntity (wvoid)

{
J*% temp. wariables #/f
VAR (5td Returnlype, AUTCHATIC) ASCET RteStatus;
/#% RunnableEntity: sequence call #1040 #/
/% assignment to Speed SWC: min=-3276E8, max=32767, hex=lphys+0,
limit=(maxBitlLength: true, assign: true), zero incl.=true */f
_Speed SWC = Rte DRead Receiwver Speed():

}

Listing 105: C code — explicit receive (example of section 8.5.1, Explicit Data Read Access;
AUTOSAR R4.0.2)

Receiving from a Port with Explicit Communication with Status

Explicit access can be optionally implemented with status. To set explicit communication
with status, see the example in section 10.3.1, Sending to a Port, subsection Sending to a
Port with Explicit Communication with Status, on page 146.

When setting explicit communication with status to the example of the previous section,

L
SRInterface
/10/RunnableEntity
}-D Speed Wit r
LTJ Speedswe
= = — -
Receiver RTE_E_NO_DATA noData
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ASCET generates the following C code:

fdefine _noData Swc RaM.noData
fdefine _SpeedSwc Swc ROM. SpeedSwc

FUNC(void, CODE) RteRunnable SWC RunnableEntity (wvoid)

{
/*% temp. wariables =/
VAR (Std ReturnType, AUTCMATIC) ASCET RtelStatus;
VAR (5Intlé, AUTOMATIC) _tS5peed:
f% RTE ExplicitWithS3tatus-block: sequence call #Explicit write
error/Status #1 !
_ASCET Rteltatus = Rte Read Receiver Speed(&(_tSpeed)):
if (_ASCET RteStatus != RIE E CFK)
i
_noData = ASCET RteStatus = RTE E NO DATA:
¥} /% end if */
/* RunnableEntity: seguence call #10 =/
_SpeedSwc = _tSpeed:
¥

Listing 106: C code — explicit receive with status (AUTOSAR R3.1.2)

#define noData SWC RAM.noData
#define _Speed SWC SWC BRAM.Speed SWC
$define Speed SWC REF (& (SWC_RAM.Speed SHC))

FUONC(void, SWC_CODE) RteRunnable Swc RunnableEntity (woid)

{
J*% temp. wariables #/f
VAR (Std Returnlype, AUTCHMATIC) ASCET RteStatus;
/% RTE ExplicitWith3tatus-block: segquence call #Explicit write
error/Status #1 !
_BSCET RteStatus = Rte Read Receiver Speed(_Speed SWC _REF ) ;
if (_ASCET RteStatus != RTE E OK)
i
_noData = RSCET RteStatus = RIE E NC DATA:
¥y /% end if */f
¥

Listing 107: C code — explicit receive with status (AUTOSAR R4.0.2)

Rte Read is non-blocking even if no data is present to read. If no data is present, the
return value from the call is RTE_E _NO DATA.
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Receiving from a Port with Implicit Communication

The implicit API includes a reference to the runnable entity that is declared as accessing the
data in the API name. Care should be taken when writing a runnable entity to invoke the
correct API. The Rte IRead API reads data:

DataltemType Rte IRead <runnable> <port> <data>()

The cache is updated before the runnable entity starts and therefore within a single
execution of a runnable entity the value returned by Rte IRead is guaranteed not to
change.

For the example of section 8.4.2, Implicit Communication,

i
SRInterface
/10/RurinableEntity
}-D Speed
SpeedSwe

Receiver

ASCET generates the following C code:

#define SpeedSwc Swc RAM. SpeedSwc

FUMC (void, CCDE) RteRunnable SWC RunnableEntity (wvoid)

* RunnableEntity: =sequence call 10 =
/* assigmnment to SpeedSwc: min=-32T768, max=32767, hex=phys,
limit=(maxBitLength: true, assign: true), zero incl.=true */

_SpeedSwc = Rte_IRead RunnableEntity Receiver Speed():
1

Listing 108: C code - implicit receive (example of section 8.4.2, Implicit Communication)

Client-Server Communication

Client-server communication is initiated using the Rte call API call.

When the CLIENT MODE is set to synchronous, then Rte Call returns after the operation
has been completed by the server. This means that your code will not continue to execute
until the server returns the result. Once the result has been computed, it is passed back to
the component by the return value of the Rte call.

Rte StatusType Rte Call <Port> <Operation>( InParamlType 1In 1,
ey

InParamNType In N,

OutParamlType Out 1,

ey

OutParamMType Out M)
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Implementing a Server Operation

Each component that defines a server port must implement a runnable entity that responds
to an Operation-Invoked event. The signature of the runnable entity must conform to the
rules defined in section 10.2.2, Entry Point Signature for Runnable Entities, on page 144.

In what follows, we show how to implement the runnable Server Maximumvalue of
section 8.6 Responding to a Server Request on a Port.

To implement a server operation

= Create a Pport server as described in 7o create a server port on
page 90.

= Load the diagram Server CSInterface.

= Implement the operation Server MaximumValue as shown in
Figure 64.

l& Software Component Editor for: Swe [ Server_CSInterface ] Project: ARProject [ANSI-C/Object]
File Edit View Insert Build Extras Tools Window Help

e N2 PeDE REaS 8 [Soma =] 0%
Tree Pane &

@ Outline |".'E Mavigation | E] Databasel

THEYT |9 M

= [F;‘_}Realized Interfaces -

Lg oG [l Server::CSInterface
58 Main InputB/Server_Maximumvalue

QutputMaximum /Server  Maximumyalue

= @F‘J server_CsInterface
=17 Bl server Maximumvalue (Inputa::sdisc
?1] InputA::sdisc [In]
?i] InputB::sdisc [In]
?Lﬂ QutputMaximum: :sdisc [Out]

m

Figure 64: Implementation of the operation Server Maximumvalue in the diagram
Server CSInterface

For the operation Server Maximumvalue, ASCET generates the following server runnable:
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DEFINITICN OF RUNMNABLE 'Sw

/% messages used by this runnable */
/* public Server MaximumValue

[Inputh: :sdisc;InputB: :sdisc;CutputMaximom: :sdisc) L

FUNC (void, CODE) Swc Impl Server MaximumWValue |

f* IN =/ VAR (5Intlée, AUTCHMATIC) Inputh,
f* IN #/ VAR (5Intle, AUTCOMATIC) Inputh,
f# CQUT  +/ CONSTP2ZVAR(5Intlé, AUTCMATIC, RTE AFFL DATZA) CutputMaximam
)

{
/* Server MaximumWValue: sequence call 5 */
/* assignment to CutputMaximum: min=-32T768, max=32T767, hex=phys,
limit=(maxBitLength: true, assign: true), zero incl.=true *,
(*CutputMaximum) = ((Inputh >= InputB) ? Inputd : InputB)

}

Listing 109: C code — server runnable

Servers may be invoked from multiple sources, for example, through a request from a client
received via the communication service or directly via intra-task communication. Unless
marked as concurrently executable within the runnable’s configuration, the RTE will serialize
access to the server, queuing requests on a first-in/first-out basis.

Making a Client Request on a Port

A runnable entity will be invoked by the RTE each time a request is made for an operation
on the server's port.

For the example of section 8.7, Making a Client Request on a Port, on page 123,

............. ‘ L e e
—Pl?}—'* IrputA CsInterface [
............. InpUtB Eﬂ

__[%1 ......... S

—[[O [N JutputMaximum Maximumyalue ='|E|| .
e ] i it .
....................... Cllent B T

ASCET generates the following C code:
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#define _E S?C_REH B
#define E Swc RAM.E
Fdefine C Swc RAM.C
#define C REF (& (Swc_ RAM.C))

FUONC(void, CODE) RteRunnable SWC RunnableEntity (void)
{

J*% temp. wariables #/f
VAR (5td ReturnType, AUTCHMATIC) ASCET RteStatus:

/#% RunnableEntity: sequence call 5 =/

_BSCET RteStatus = Rte_Call Client MaximumWValue( &, B, C REF }:

1
Listing 110: C code — client request

Accessing Calibration Parameters

If a software component declares calibration parameters, then each characteristic is
accessed at runtime using the API call:

CalprmElementType Rte Calprm <Port> <CalprmElement> ()

The call returns either the calibration data (primitive types) or a pointer to the data (complex
types).

Calibration data in a function is modeled by means of ASCET parameters. In an application

software component, the calibration data can be mapped to the calibration parameters of an
AUTOSAR calibration component using the parameter mapping table.

To create a function with parameters:

= In the ASCET component manager, select Insert = Class 2>
Block diagram in order to create an ASCET class.

= Name the class ClassWithParam.
= Open ClassWithParam in the block diagram editor.
ﬂ = Use the Logic Parameter button to create a logic parameter.
The dialog "Properties for Scalar Element: log" opens.

= Name the parameter 1ocalLog and change the scope to
Imported.
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T Properties for Scalar Element: locallog
General
Name -
Unit
Comment
Interpolation
Kind ) | Parameter -
Basic Type
Logic -
Component
Scope
@ @ Local @ Imported () Exported
Attributes External Access
- Reference 5et() Method
wF [ Virtual Get() Method
& Dependent Internal Access
. Mon-Volatile Write
Variants Read
Calibration Access
Write
Read
Alwa}rs Show Editor for new Elerments QK ] [ Cancel

Figure 65: Parameter 1ocallLog defined as imported

ﬂ = Add an unsigned discrete parameter with name localuUdisc
and scope Imported.

=  Model the following method:
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I§ Block Diagram Editor for: Class\WithParam [ Main ] Project: ARProject [AMSI-C/Object] [o | = =]
File Edit View Insert Build Extras Tools Window Help
Pl B X w2 eSeE ko s a0 a [<shon al>
Tree Pane & “
] outine | =% Navigation | (3 Database | J5fcale g w
T TN L = — -~ 2
M ‘ & - locallog 5] . E’:
- ‘ outljcalc =3
=l ey @ self::ClasswithParam g
- . lllf
L @ locallog::log L
?‘J localUdisc: :udisc inlf%: D'L%L @
= B main g
I—E| ; Bl calc (in1::cont;in2: udisc;out Liicont; out2: udisc) J10/calc ]
"€ %] iniicont [in] = > =
ﬂl:Il—liJ in2::udisc [In] in2fcalc out2fcalc
?11] outl:icont [Out] locallidise
?m out2::udisc [Out] s
< T 3
B [ J o X:37¥:27

Figure 66: Block diagram of method calc

To map internal parameters of a function to AUTOSAR calibration parameters:

= Create a project as described on page 23.
= Insert Swc into the new project as described on page 26.

= Insert the calibration interface CalInterface created in section
6.4, Calibration, on page 78 into the software component Swc.

= Insert the class ClassWithParam into the software component

Swc.

= Insert the variables invaluel, invValue?2, outValuel and
outValue2 as shown in the block diagram below.

P

= [E. selfi:Swe_1

A0 @ Calinterface::Callnterface

M'1:2|—. inYalue1::cont

ﬂl.:l|-. inValue2: ;udisc

ﬁ-:::i-. outValue1::cont

ﬂl.:ll—. outValue2: udisc
m}Realized Interfaces

=] @B’ Main

L @ E?:] Runnable_Entity {

invalue1

outValue1

inValue2

outValue2

(B, Software Component Editor for: Swe_l [ Main ] Project: ARPraject_1 [ANSI-C/Object] = ECR==
File Edit View Insert Build Extras Tools Window Help

PalH & +@ %[00 @ PSP E|REE B B [sona o

Tree Pane £ ~

B outine |"EE Navigaﬁonl ] Databasel calc H
BUUET e v /oRemebe B

in2
Mout2

nl
. Class\WithParam

Class\ithParam

| Buidde |y 1a3@weley ‘j

uaedynads Jus sy & I asMolg EI uogeayynads ﬁ

| Budde ) abessag E]

- . - X:260 ¥:221
Figure 67: Accessing ClassWithParam in the software component
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Create a runnable Runnable Entity and provide a sequence
to the method ca1lc within this runnable.

Go to the "Parameter Mapping" tab in the software component
editor.

The left column of the table lists all imported parameters in
modules and classes of the software component.

The right column of the table contains a drop-down list for each
imported parameter. Each list provides the calibration parameters
in the software component matching, in type, the imported
parameters.

For the parameter 1ocallLog, select the calibration parameter
calParaml.

o Mapping is not complete! Update ] [ e ] E -
. -
Mapping T
= o
=Y =
o
Imported Parameter Calibration Parameter ]
=
T @ locallog D &
=" =
0 @ localldisc D 3
allnterface.CalParam1 =

Callnterface.CalParam2

| uo|ealynads uaag ﬂ | QsMOIG % | uoealypads

Budde |y abessal E

Figure 68: Mapping an imported parameter and a calibration parameter

For the parameter 1ocaluUdisc, select the calibration parameter
calParam3.

o Mapping is not complete! Update ] [ Auto-Mapping ] E ﬁ
Mapping o
=Y :

Imported Parameter Calibration Parameter T
? & locallog 0 ? ¥ Calinterface.CalParam1 .DDEJ
T & locallldisc (s | - E'
1
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I@ Mapping complete. Update ] [ AutoMa
Mapping

=Y
Imported Parameter Calibration Parameter
? &/ locallog @ ? ¥ Callnterface.CalParam1
“l_:l'- & localudisc @ 1"l_zl'- ¥ Calinterface.CalParam3

Figure 69: Completed parameter mapping

For the class classwithParam, ASCET generates the following C code:

FUNC (void, CODE) CLASSWITHPARARM TMPL calc |
S* IN =/ VAR (5Int32, AUTCHMATIC) inl,
f* IN =/ VAR (UIntZ, AUTCMATIC) in2,
S* OUT =/ CONSTP2VAR (5Int32, AUTCMATIC, RTE APPL DATA) outl,
S* OUT =/ CONSTP2VAER (UIntg2, AUTCMATIC, RTE APPL DATA) outl
)
{
f* calc: sequence call £#5 */
if (Rte_Calprm CaliInterface CalParaml())
{
f* If-block: sequence call #5/Then #1 *
(*cutl) =
}
else
{
f* If-block: sequence call #5/Else F1 */f
(*outl) = inl;
Y /% end if ®/f
/* calc: sequence call 10 */
(*outl) = (UIntZ) ((TIntlé)ind * Rte Calprm Callnterface CalParam3()):

}

Listing 111: C code — class with mapped parameters

Note

If a calibration interface is edited when the software component is open, the user shall
update the changes in the "Parameter Mapping" tab using the menu option Mapping >
Update.

10.6 Accessing ASCET Messages

AUTOSAR does not know the concept of ASCET messages. If your SWC uses one or more
modules that contain ASCET messages, all messages must be mapped to semantically
equivalent AUTOSAR elements.

For this purpose, ASCET provides a special editor in the "Message Mapping" view of the
software component editor.

In that editor, messages can be mapped to AUTOSAR elements according to the following
rules:

= A message must be mapped to an element of compatible type.
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Message type AUTOSAR element type
Continuous (cont) cont / sdisc / udisc

Signed Discrete (sdisc) cont / sdisc / udisc

Unsigned Discrete (udisc) cont / sdisc / udisc

Logic (log) log

Enumeration (enum) Enumeration of the same type

Table 3: Message types and compatible AUTOSAR types

A pure send message can only be mapped to an element of a sender-receiver
interface used as Pport, since the message value is not used within the SWC and thus
provided to be used by another SWC.

A pure send message is a send message that appears in only one module of the
software component, i.e. it is not received by another module.

A pure receive message can only be mapped to an element of a sender-receiver
interface used as Rport, since the message value is not given within the SWC and
must therefore be given by another SWC.

A pure receive message is a receive message that is not used as send message within
the SWC.

All other messages, i.e. SendReceive messages and messages specified as send
message in one module and as receive message in another module, can be mapped
to an interrunnable variable or to an element of a sender-receiver interface used as
Pport.

To ease reuse of ASCET modules in SWC, it is possible to export mappings from one SWC
and import them into another SWC. See the ASCET online help for details.

To create a module with messages:

= In the ASCET component manager, select Insert > Module >
Block diagram in order to create an ASCET module.

= Name the module ModuleWithMsg.
= Open ModuleWithMsg in the block diagram editor.

= N Use the SendReceive Message button to create a receive
message.

The dialog "Properties for Scalar Element: message" opens.

= Name the message sendrRecMsgl and change the basic type to
Signed Discrete.

= Click OK to close the properties editor.

= Add a second SendReceive message with name SendRecMsg?2
and basic type signed Discrete.

7 * Add a send message with name sendMsg and basic type Logic.

= Implement SendRecMsgl and SendRecMsg2 as sint8 (see
Figure 10).

= Implement sendMsg as bool.
= Model the following process:
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f5jprocess

TP - o
[ 3] [ ]

SendRecMsg? M

100

[]
SendRecMsgl
10 fprocess

Sendvsg
Figure 70: Block diagram of process process

To map ASCET messages to AUTOSAR elements:

= Create (cf. page 23) and set up (cf. page 23) a project
ARProject.

= Create a software component swc (cf. page 26) with a runnable
entity and three interrunnable variables (cf. page 125):

name IRV sdiscl IRV sdisc2 IRV log
basic type Signed Discrete Logic
Impl. type sint8 bool
Internal access implicit explicit implicit

= Create a sender-receiver interface SRinterface (cf. page 62)
with two sdisc data elements, implemented as sint8, and one
log element, implemented as bool.

-

% SenderReceiver Interface Editor for: SRinterface EI@
File Edit View Insert Extras Tools Help
P B |*S v e 0D
2 & omension |[+]2 [
Outi @
ﬁ utine | (3 Database Impl - g
¥ A [ B=
B % s - M Name Type Impl. |Impl. {Impl. Q = i
Type |Min  [Max B
Bl mj. self::SRinterface = b L
?. log:log B log [ log |bool [ 1 1|2
?. sdisc_1::sdisc B sdisc_1 'S sdisc [sint |-128 |127 1
?. sdisc_2::sdisc B sdisc_2 'S sdisc [sint8 |-128 [127 1 P
4 | 1 | k
% sdisc_2 ELY! &5, Phys: sint32 [-128,127] Impl: sintd [-128,127]

= Add the module ModuleWithMsg to Swec.

= Use srRinterface to create a sender port in the SCW (cf. page
87).

* Add swc to ARProject.

= In the "Outline" tab of the project editor, double-click swc to
open the component in the project context.

= In the software component editor, go to the "Message Mapping"
tab and the "Internal Access" sub-tab.

The left column of the table lists all messages that can be
mapped to interrunnable variables.
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The right column of the table contains a drop-down list for each
message. Each list provides the interrunnable variables that can
be mapped to the message.

Map the messages to interrunnable variables as shown in Figure
71.

'S Internal Access [% External Access [+
. )

@ Mapping complete, ’ Update ] ’ P ] o
Mapping %
P T

EY Z

Messages Variables =
=

*S = sendrecMsg? @[T @ wry_sdisc1 2

*§ = sendRecMsal &|'S B Ry _sdisc2

Budde ) abessaly E
| uoeaymads juasg & | asmo1g @ | uajeayypads ﬁ

Figure 71: Mapping messages and interrunnable variables

Now go to the "External Access" sub-tab.

The left column lists all messages that can be mapped to data
elements in sender or receiver ports.

The right column contains a drop-down list for each message.
Each list provides the data elements that can be mapped to the
message.

Map the messages to data elements as shown in Figure 72.

g Internal Access % External Access [E,

N L%5]

@ Mapping complete, [ Update l [ T ] E o }:"_l:

Mapping % E-

2y =

%Ih‘lessages Variables = ﬁ
= — S

5 1C @SEndMsg L I sender.log 2|

E:

&

m

5 ¥ sender.edisc_1
*S W sender.sdisc_2

5|8 X SendRechMsgi
SR|'S = sendrecMsg2

L8]

Bundde y abessaly m

uoEalyRads uaal

Figure 72: Mapping messages and data elements

With that, message mapping is complete.

For the module ModulewithMsg, ASCET generates the following C code:
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FUNC (void, CODE) MODULEWITHMSG IMPL process (woid)

/¥ temp. wvariables */f
VAR (sintg8, AUTCMATIC) _tlsintd;
VAR (5td_ReturnType, RUICMATIC) _ASCET RteStatus;

/* process: sequence call #5  */
if (Rte_TrvIRead runnable IRV sdiscl () <= 100)

/* If-block: sequence call #5/Then #1 */

_tlsint8& = Rte_TrvIRead runnable IRV sdiscl();

_ASCET_Rte3tatus

= Rte_Write Sender sdisc_1(((_tlsints® <= 126) ? (_tlsint® + 1) : 127}));:

_tlsintg& = Rte_IrvIRead runnable IRV sdiscl();

Rte IrvWrite runnable IRV sdisc2 (((_tlsintd <= 126) ? (_tlsintd + 1) : 127));
else

/* If-block: sequence call #5/Else £1 =/

_R5CET_Rte3tatus = Rte_Write Sender sdisc_1(1):

Rte IrviWrite_ runnable IRV sdisc2 (1);

f*% end if =/
/* process: seqguence call #10 =*/
Rte IWrite_ runnable Sender log(Rte IrvIRead runnable IRV sdiscl() <= 100);

Listing 112: C code — module with mapped messages

10.7 Concurrency Control with Exclusive Areas

Where a component has multiple runnable entities that require concurrent write access to
the same prototype state, then the Rte Enter and Rte Exit API calls must be used to
ensure that data consistency is maintained.

A component includes multiple runnable entities each of which can be active simultaneously.
The potential exists for concurrent access to private global data (e.g. elements in the data
memory sections) and/or non-reentrant functions.

Operating system concurrency control mechanisms are hidden from components. However
the RTE API implements explicit access to exclusive areas by exposing an appropriate OS
mechanism to components:

* Rte Enter <exclusive area name> enters an exclusive area.
" Rte Exit <exclusive area name> exits an exclusive area.

Where components declare exclusive areas, the generated RTE API for the component
includes these API calls to allow you to control concurrent access to shared data.

10.7.1  Sequences of a Runnable Assigned to an Exclusive Area

A component can use the Rte Enter and Rte Exit API calls for any exclusive area ID
you define at configuration time.

For example, for the exclusive are swcExclusiveArea of section 8.9, Exclusive Areas, on
page 129, the following C calls are used:
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& Code protected from concurrent execution */

Fre Exit JwcExclusivelrea():

Listing 113: C code — enter/exit exclusive area

For the example of section 8.9.3 on page 131,

—
SRInterfacs A
J10fRURnableEntity

Speed .
SpeedSwec

.............. puti
.............. nputB

- [ NOukpukMaximunn

C3lnkerface

O=C

Maximumyalue

" /Z0JRUnnableEntity

Fdefine & 5SWC BaM.A
f#define :3 SW::EAH.S
Fdefine C SWC RAM.C
FUNC (void, CODE) RreRunnakble Swe RunnableEntity (void)
{
* temp variables =/
VAR (Std ReturnType, AUTCOMATIC) ASCET RteStatus:
A% RunnableEntity: seguence call %8 =
Rte Enter SwcExclusivelreal()
A% RunnableEntity: sequence call 10 *,
_Speed SWC = Rte_IRead BunnableEntity Receiver Speed():
# RunnableEntit sequence call 20 =
_ASCET RteStatus = Rte Call Client MaximumWValue({ &, B, C REF }:
f* RunnableEntit sequence call #22 b
Fte Exit SwcExclusiwvelAreal()
}

Listing 114: C code — exclusive area example

Note

The scope of an exclusive area is the software component prototype and not the
software component type or system wide. Therefore, exclusive areas only provide
concurrency control within a software component. Wider scope can be achieved using an
AUTOSAR component to broker access to shared data.
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11 ETAS Contact Addresses

ETAS HQ

ETAS GmbH

BorsigstraBe 14 Phone:  +49 711 89661-0
70469 Stuttgart Fax: +49 711 89661-106
Germany WWW: www.etas.com/

ETAS Subsidiaries and Technical Support

For details of your local sales office as well as your local technical support team and product
hotlines, take a look at the ETAS website:

ETAS subsidiaries WWW:  www.etas.com/en/contact.php
ETAS technical support WWW:  www.etas.com/en/hotlines.php
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exclusive area, 129
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implicit communication, 112, 117
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runnable entity, 107
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memorySections_Autosar4.xml, 25
mode, 141

create mode group, 134

define, 134

disable, 139

trigger runnable on mode-switch event, 137

use, 136
mode communication, 135

create mode group interface, 136
mode group, 67

create, 67, 134

R3.1.5 or lower, 67

R4.0.*, 67
mode group interface

create, 136

insert in SWC, 136
mode-switch interface

create, 69
mode-switch event, 105

add to runnable, 138

create, 105, 137

trigger runnable, 137
mode-switch interface, 67

R4.0.*, 67

NVData
interface, 83
NVdata element
create, 84
NVData interface
create, 83
create data element, 84
implementation, 84
implementation of data element, 84
variable data prototypes, 84
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operation, 71, 153
assign application error to return value, 75
create, 71
create argument, 71
implementation, 72
specify in ASCET, 153
operation-invoked event, 103
Overview, 18-21
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behavior modeling tool, 21
runtime environment, 20
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port, 87
client request, 154
client request on ~, 123
create calibration port, 96
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required, 92
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send to ~, 110

PPort. see provided port
primitive data types, 33, 47

with semantics, 36, 50

project

configure ARXML output, 25
insert software component, 26

provided port, 87

R

create sender port, 87
create server port, 90

receive from port, 114, 149

explicit communication, 115, 149
explicit communication + status, 150
implicit communication, 117, 152

record, 39, 52

create, 39

required port, 92

create calibration port, 96
create client port, 95
create NVData port, 98
create receiver port, 93

respond to server request on port, 119
RPort. see required port
RTE API

client-server communication, 152
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parameter passing mechanism, 143
sender-receiver communication, 145

RTE generator, 30
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RTE phase, 31

Rte_Call, 152
Rte_Calprm, 155
Rte_DRead, 149
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Rte_Exit, 163
Rte_IRead, 152
Rte_IWrite, 148
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runnable. See runnable entity
runnable entity, 20, 107
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entry point, 144
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trigger on mode-switch event, 137
runtime environment, 18, 20
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send to port, 110, 146
explicit communication, 110, 146
explicit communication + status, 146
implicit communication, 113, 148
Sender-Receiver
interface, 62
sender-receiver communication, 145
receive, 149
send, 146
sender-receiver interface
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create data element, 64
create mode group interface, 69
data element prototypes, 64
implementation, 65
mode communication, 135
mode group, 67
server
concurrent invocation, 121
software component, 18
~ types, 86—99
component type, 86
create, 26, 86
create calibration port, 96
create client port, 95
create NVData port, 98
create receiver port, 93
create sender port, 87
create server port, 90
event, 101
implement, 142—-64
insert in project, 26
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